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About This Book

Overview

This book, INTUITY™ CONVERSANT® Version 6.0 Application Development with 
Graphical Designer, Issue 2.0, 585-310-764, describes how to install the INTUITY 
CONVERSANT Graphical Designer and provides the basic procedures you need 
to design applications and run them on an INTUITY CONVERSANT system.

Online help is included with the product for detailed information about all of the 
features of Graphical Designer.

Purpose

The purpose of this book is to provide the information needed to create and 
maintain call flows used for network-based interactive services running on an 
INTUITY CONVERSANT system. 
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Release History

This is the second release of this book.

Intended Audiences

This book is for use in the United States and English-speaking Canada only on 
systems that support U.S. and compatible versions of Microsoft Windows. The 
intended audiences for this book are:

■ Application developers responsible for creating custom applications for 
use on an INTUITY CONVERSANT system in an end-user environment. This 
audience includes such individuals within Lucent Technologies as well as 
end-customer application developers.

■ Application distributors who distribute and implement applications for end 
users. This audience includes independent software vendors (ISV) and 
voice processing co-marketers (VPCs).

How This Book Is Organized

This book is divided into the following chapters:

■ Chapter 1, "Introduction and Hardware and Software Requirements", 
provides a high-level description of the INTUITY CONVERSANT Graphical 
Designer and lists the hardware and software requirements for its 
operation.

■ Chapter 2, "Installing the Graphical Designer Software", describes the 
INTUITY CONVERSANT Graphical Designer software packages and how to 
install them on your personal computer and on the INTUITY CONVERSANT 
system. 

■ Chapter 3, "Procedures", describes how to use the mouse and keyboard 
with the INTUITY CONVERSANT Graphical Designer. It also includes basic 
procedures for creating and working with designs, and information on 
defining the host interface, accessing remote database applications, and 
using the Support Access Program.

■ Chapter 4, "Building a Simple Design", provides step-by-step instructions 
for creating a simple call-flow design. It can serve as a tutorial to help you 
learn how the INTUITY CONVERSANT Graphical Designer operates.

■ Chapter 5, "Simulating a Design", describes the operation of the simulation 
tool. This feature of the INTUITY CONVERSANT Graphical Designer allows 
you to test your design on your personal computer without leaving the 
development environment.
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■ Chapter 6, "Preparing and Installing an Application", describes how to use 
the INTUITY CONVERSANT Graphical Designer code generator to prepare 
your application for transfer to the INTUITY CONVERSANT system, how to 
transfer it, and how to install the application files.

■ Appendix A, "Object Reference", describes the object set available with 
the INTUITY CONVERSANT Graphical Designer. The objects are listed in 
alphabetical order. Each entry includes a graphical representation of the 
object, a complete description of its behavior, and examples of how to use 
the object in a call flow.

■ Appendix B, "Screen Reference", describes the screens you will use when 
working with the INTUITY CONVERSANT Graphical Designer. The screens 
are listed in alphabetical order. Each entry includes a graphical 
representation of the screen, a description of its function, and information 
on fields, buttons, and toolbar components.

■ Appendix C, "File Organization", describes the directory structure and 
types of files used with the INTUITY CONVERSANT Graphical Designer. 

■ Appendix D, "Annotated Sample Call Flows", illustrates the call flows for 
each of the examples in the Sample Application software package that is 
included with the INTUITY CONVERSANT Graphical Designer software. 

■ Appendix E, "Troubleshooting", includes solutions for some of the 
problems you might encounter when working with the INTUITY 
CONVERSANT Graphical Designer. 

This book also includes a glossary of terms related to the INTUITY CONVERSANT 
Graphical Designer and an index.

Conventions Used in This Book

The following typographic conventions are used in this book: 

■ Terminal keys

— Terminal keys are shown in rounded boxes.  For example, an 
instruction to press the enter key is shown as 

Press .

— Function keys (also known as soft keys) are shown in rounded 
boxes followed by the function of that key in parentheses.  For 
example, an instruction to press function key 1 for help in the 
Graphical Designer is shown as 

Press  (HELP). 

— Two or three keys that you press at the same time (holding down 
the first key while pressing the second and/or third key) are shown 
as a series of rounded boxes.  For example, an instruction to press 
and hold  while typing the letter d is shown as 

Press  . 

ENTER

F1

ALT

ALT D
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■ Screen displays

— Information that is displayed on your INTUITY CONVERSANT system 
terminal screen — including screen displays, prompts, script code, 
and system messages — is shown in typewriter-style type; 
for example 

Installation is in progress -- do not remove 
the floppy disk. 

■ User input

— Information that you enter or type from your keyboard is shown in 
bold type; for example 

Enter y to save your application. 

— As used in this book, the word “enter” means to type a value and 
press . For example, an instruction to type y and press 

 is shown as 

Enter y to continue. 

— As used in this book, the word “type” means to press the key or 
sequence of keys specified. For example, an instruction to type y is 
shown as

Type y to continue.

Do not press  after you type the value specified.

— As used in this book, the word “select” is used to mean the 
following: move to the desired menu item using the arrow keys and 
press . For example, an instruction to select an item from a 
menu and press  is shown as 

Select Disconnect Node from the popup menu.

— Command and file names and their parameters are shown in bold 
type.  Optional parameters are shown in bold italic type when they 
are part of a user input and in regular italic type when they are not.  
All are illustrated in the following example: 

Use the gd_install command to install a Graphical Designer 
application onto the INTUITY CONVERSANT system. The 
command syntax is gd_install application_name, 
where application_name is the name of the application to be 
installed. 

ENTER

ENTER

ENTER

ENTER

ENTER
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Online Help

The INTUITY CONVERSANT Graphical Designer features two kinds of on-line help:

■ Help menu commands

■ Dynamic context-sensitive help

Help Menu Commands

The help menu is located in the menu bar on all of the screens in the INTUITY 
CONVERSANT Graphical Designer. When you select the help menu, you can 
choose from the following options:

■ Contents displays a list of topics for which on-line help is available.

■ Search for Help lets you search for a key word to obtain the available 
on-line help information for the particular item.

■ Menu Commands displays a list of the menu commands available on the 
Graphical Designer screens.

■ Screen Maps provides a brief description of each screen.

■ Keyboard Shortcuts provides a reference on using the keyboard when 
working with the Graphical Designer.

■ Learning Graphical Designer contains training information.

■ Technical Support provides contact information for technical and 
production support.

■ About Graphical Designer contains authorship and copyright information.

Dynamic Context-Sensitive Help

When you move the mouse over various items in a window, the Graphical 
Designer displays a brief description of that item.

To view dynamic context-sensitive help, position the mouse over the entity for 
which you need additional information. Read the help message displayed in the 
bottom left portion of the window.
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Using the Annotate Option

The online help allows you to add your own personal comments, additions, 
suggestions, tips, etc. to any help screen within the Graphical Designer online 
help — for your use or to share with other application developers. Simply select 
Annotate from the Edit menu within the online help and enter text. The system 
draws a representation of a paper clip next to each topic that you edit.

NOTE:
You cannot print annotated comments.

Systems Supported

The Graphical Designer generates application components that operate on 
INTUITY CONVERSANT system Versions 6.0, 5.0, 4.0, 4.0i, and Intro 3.1.1.

Customer Training

Customer training is available through the BCS Training Center. Contact your 
Lucent Technologies INTUITY CONVERSANT account executive or sales 
representative, or call 1-800-255-8988 for details about the courses available for 
the Graphical Designer.

Trademarks

Lucent Technologies has made every effort to supply trademark information 
about company names, products, and services mentioned in the INTUITY 
CONVERSANT documentation library. Trademarks indicated below were derived 
from various sources.

■ AUDIX, CONVERSANT, DEFINITY, 5ESS, and 4ESS are registered 
trademarks and INTUITY and FlexWord are trademarks of Lucent 
Technologies. 

■ ORACLE, ORACLE*Terminal, OBJECT*SQL, SQL*FORMS, SQL*Menu, 
SQL*Net, SQL*Plus, PRO*C, and SQL*Report Writer are trademarks of the 
Oracle Corporation.

■ Sound Blaster is a trademark of Creative Technology Ltd.

■ IBM and VTAM are registered trademarks of International Business 
Machines Corporation.

■ CLEO, DataTalker, and LINKix are trademarks of CLEO Communications.

■ Microsoft, MS, MS-DOS, Internet Explorer, and Excel are registered 
trademarks and Windows is a trademark of Microsoft Corporation.

■ UnixWare is a registered trademark of The Santa Cruz Operation, Inc.
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■ UNIX is a registered trademark of UNIX System Laboratories, Inc.

■ Novell is a registered trademark of Novell, Inc. 

■ Hayes and Smartmodem are trademarks of Hayes Microcomputer 
Products, Inc.

■ Ethernet is a trademark of Xerox Corporation.

How to Comment On This Book

We are interested in your suggestions for improving this book.  Please complete 
and return the reader comment card that is located behind the title page. 

If the reader comment card has been removed, send your comments to: 

Lucent Technologies 
Product Documentation  
Room 22-2H15 
11900 North Pecos Street 
Denver, Colorado 80234 

You may also fax your comments to the attention of the Lucent Technologies 
INTUITY CONVERSANT writing team at (303) 538-1741.

Please mention the name and order number of this book, INTUITY CONVERSANT 
System Graphical Designer Release 1.6.1 User Guide, 585-310-758, Issue 2.0. 
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1
Introduction and Hardware and
Software Requirements

Overview

This chapter provides a high-level description of the INTUITY™ CONVERSANT® 
Graphical Designer and lists the hardware and software requirements for its 
operation.

Purpose

The purpose of this chapter is to familiarize you with the function of the Graphical 
Designer and the hardware and software you need to operate it.
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Overview of the Graphical Designer

The Graphical Designer is a windows-based application development tool. This 
tool allows you to develop voice applications for INTUITY CONVERSANT systems 
by specifying the details of the interaction between the INTUITY CONVERSANT 
system and its callers. For example, the greeting heard by the caller when 
connecting with the service, the menu of options offered, the way callers are 
prompted for credit-card numbers and other pertinent information, how long to 
wait for caller responses, and the relevant databases that need to be accessed 
are all parts of an application that you can define and implement with the 
Graphical Designer. The types of applications you can develop with the 
Graphical Designer cover the full range of interactive voice response services 
including banking by telephone, processing insurance claims, paying bills, 
purchasing tickets, shopping by catalog, and registering for classes.

To create an application with the Graphical Designer, you work on a 
windows-based personal computer using a set of high-level objects. Each object 
represents the C-language code required to perform the function illustrated by its 
icon. By using a mouse to arrange these icons in the proper order on the 
Graphical Designer design pad screen, you specify the details of the call flow. 

The Graphical Designer also provides a simulation tool. This tool allows you to 
test your design before you transfer it to the INTUITY CONVERSANT system 
without leaving the development environment.

Once your design is tested and debugged, the Graphical Designer provides a 
code generator that prepares your application for transfer to the INTUITY 
CONVERSANT system. Transfer from your personal computer is accomplished 
using floppy disks or over a network.

The Graphical Designer also features a Support Access program. This program 
uses a modem to connect your personal computer to that of a Lucent 
Technologies support person, who can upload and download your files to assist 
with problem resolution.

Hardware and Software Requirements

This section details the hardware and software needed to run the Graphical 
Designer.

Hardware

This section describes the hardware required to use the Graphical Designer on 
your personal computer and optional equipment you will need for recording 
speech and transferring your applications over a network.
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Required Hardware

The Graphical Designer runs on a standard Intel-based computing platform 
equipped with the following:

■ A VGA monitor 

■ A Microsoft-compatible mouse 

■ A 486DX 66-MHz (or higher) processor

■ At least 16 Mbytes of RAM

■ A hard drive with at least 20 Mbytes of available space 

NOTE:
The amount of available disk space required depends on the 
number and complexity of the applications you plan to develop on 
your personal computer, and whether or not you plan to record 
speech. The entire Graphical Designer software package requires 
10 Mbytes of space on the hard drive. Plan for at least 10 Mbytes of 
additional free space available for the applications you develop.

■ A 3 1/2” floppy disk drive designed for reading 1.44-Mbyte diskettes

Optional Hardware

This section includes information about optional equipment needed for recording 
speech and for transferring applications over a network.

For Recording Speech

The Sound Manager option of the Graphical Designer allows you to record 
speech for your application and listen to speech during the Simulation mode.To 
use this option, you need the following equipment:

■ Sound Blaster-compatible sound card

The sound card allows you to listen to speech that you record with the 
Graphical Designer. You can use this speech during Simulation as well as 
on an INTUITY CONVERSANT system. You can run the Graphical Designer 
without a sound card; however, you will not be able to record speech or 
listen to speech during the Simulation mode.

For more information about Simulation mode, see Chapter 5, “Simulating a 
Design.”

NOTE:
The quality of the speech that you record may not be as high as that 
of the professionally recorded speech available from Lucent 
Technologies. To add professionally recorded speech once you 
have installed your application on an INTUITY CONVERSANT system, 
contact your Lucent Technologies representative.
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■ Microphone and Speaker

Although any microphone or speaker is sufficient for recording speech 
with the Graphical Designer, the quality of the equipment you choose 
affects the quality of the speech.

For Transferring Applications over a Network

The Graphical Designer provides a local area network (LAN) option that allows 
you to transfer your applications directly from your personal computer to an 
INTUITY CONVERSANT system. To use this option, you need a standard Ethernet 
card and a WinSock driver (winsock.dll) installed on your personal computer. For 
details on transferring your application, see Chapter 6, “Preparing and Installing 
an Application.”

Software 

To use the Graphical Designer, your personal computer must be equipped with 
the following software:

■ DOS Version 3.1 or higher

■ Microsoft Windows Version 3.1, Windows for WorkGroups 3.11, or 
Windows 95

■ A video driver that specifies no more than 256 colors (8-bit resolution) with 
the smallest font size available. 

NOTE:
Do not set your video display to 65,000 or 32,500 colors (16-bit 
resolution) because graphics within the Graphical Designer may not 
display properly. 

■ Graphical Designer Version 1.6.1
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2
Installing the Graphical Designer 
Software

Overview

This chapter describes the Graphical Designer software packages and how to 
install them on your personal computer and on the INTUITY™ CONVERSANT® 
system.

NOTE:
See Chapter 1, "Introduction and Hardware and Software Requirements", 
for specific information regarding requirements for your personal computer.

Purpose

This chapter provides the information you need to install the Graphical Designer 
software. 
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What the Graphical Designer 
Software Includes

The Graphical Designer software includes six packages, the following five of 
which you install on your personal computer:

■ The Application Design Software package, which includes the design 
capabilities of the Graphical Designer. It also includes online help and the 
Support Access and Uninstaller programs. The Support Access program 
gives Lucent Technologies support personnel access to your personal 
computer through a modem. The Uninstaller program assists you in 
removing the Graphical Designer files from your personal computer.

■ The Application Generation package, which contains a code generator 
that prepares the components of your application for transfer to the INTUITY 
CONVERSANT system. 

■ The Application Transfer package, which allows you to transfer the 
components of your application to the INTUITY CONVERSANT system. 

■ An optional Sample Application package, which contains several samples 
of applications that you can use as a starting point for your own design or 
as a reference for how to create such features as dynamic menus, 
subroutines, and timebranches.

■ An optional Getting Started demo package, which includes a tutorial.

You install the sixth Graphical Designer software package, the Integration 
Software package, on the INTUITY CONVERSANT system. This package makes it 
possible for you to run the Graphical Designer applications you create on your 
personal computer on the INTUITY CONVERSANT system.

Software Installation Procedures

This section provides procedures for installing the first five software packages 
listed above on your personal computer and the sixth package on the Intuity 
CONVERSANT system.

On Your Personal Computer

Complete the following procedure to install the five software packages listed 
above on your personal computer. For a complete installation, we suggest you 
install the packages in the order given in this procedure. However, note that you 
have the following options:

■ You must install the Application Design package first. You may then install 
the remaining packages in any order.

■ You can run the Graphical Designer with only the Application Design 
package installed on your personal computer.
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■ If you are upgrading from Version 1.4, you must load all the software 
packages.

Procedure

1.  To begin the installation, do one of the following:

■ If you are running Windows 3.1 or 3.1.1, select File from the 
program manager.

■ If you are running Windows 95, select START from the Windows 
taskbar. 

2. Select Run.

The system displays the Run dialog box.

3. Insert the Insert the disk labeled “INTUITY CONVERSANT V6.1 Graphical 
Designer 1.6, 1 of 3” into Drive A or Drive B.

4. Type x:setup at the command line, where x is the letter of the drive into 
which you inserted the disk, and click the OK button. 

■ If this is an original installation of Version 1.6.1, the system displays 
the Welcome screen (Figure 2-1). Continue with Step 5.

Figure 2-1. Welcome Screen
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■ If you are installing an upgrade from Version 1.4, the system 
displays the Graphical Designer Upgrade window (Figure 2-2). The 
window asks if you want to save the existing version of the 
Graphical Designer. Do one of the following:

Figure 2-2. Graphical Designer Upgrade Window

— If you do not want to save Version 1.4, complete the following Steps 
a and b:

a. Click the No button.

The system displays the Welcome screen (Figure 2-1). 

b. Continue with Step 5.

— If you want to save Version 1.4, complete the following Steps a, b, 
and c:

a. Click the Yes button.

The system displays the Choose Destination Location 
screen (Figure 2-3).
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Figure 2-3. Choose Destination Location Screen

b. Do one of the following:

— Click the Next button to install Version 4.1 in the 
default path C:\GD1.4. 

— Type in a new pathname and click the Next button. 

— Click the Browse... button and select from a list of 
choices the system displays in the Choose Directory 
window, then click the OK button. 

The system displays the Welcome screen (Figure 
2-1).

c. Continue with Step 5.

NOTE:
You cannot run both Version 1.4 and 1.6 at the same 
time. Only one instance of the Graphical Designer can 
be executed at any given time. 

5. Read the information shown on the Welcome screen and click the Next 
button.

The system displays the User Information screen (Figure 2-4).
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Figure 2-4. User Information Screen

6. Enter your name and company name and click the Next button.

The system displays the Setup Type screen (Figure 2-5).
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Figure 2-5. Setup Type Screen

7. Select the type of setup you prefer and then click the Browse... button.

The system displays the Choose Directory window (Figure 2-6) and asks 
you where to install the software.
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Figure 2-6. Choose Directory Window

8. Click the OK button to install the Graphical Designer in the default path 
C:\GRAPHD, or type an alternate path, then click the OK button. 

NOTE:
Click the Cancel button or press  (Exit) to cancel the installation.

The system displays the Select Program Folder screen (Figure 2-7).

F3
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Figure 2-7. Select Program Folder Screen

9. Type a folder name or select one from the list of existing folders and click 
the Next button.

The system displays the Start Copying Files screen (Figure 2-8). This 
screen displays the setup type, target directory, and program folder you 
have selected for the installation.
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Figure 2-8. Start Copying Files Screen

10. Follow the instructions on the screen to change any setting if necessary 
and then click the Next button.

The system begins copying files and displays status bars that show the 
status of the installation. The vertical status bars (Figure 2-9) on the left 
side of the screen indicate the percentage complete for each file installed 
from the source disk. The horizontal status bar (Figure 2-10) in the middle 
of the screen indicates the percentage complete of the entire installation.
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Figure 2-9. Vertical Status Bars Indicating Completeness of the Installation of 
Each File 

Figure 2-10. Horizontal Status Bar Indicating Completeness of the Entire
Installation

11. When the system displays the Setup Needs the Next Disk window (Figure 
2-11) asking for the second disk, insert the disk labeled “INTUITY 
CONVERSANT V6.1 Graphical Designer 1.6, 2 of 2” into the disk drive and 
click the OK button.

The system displays the status bars that show you the progress of the file 
transfer from the second disk. When installation is complete, it redisplays 
the Setup Needs the Next Disk window (Figure 2-11) asking for the third 
disk.
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Figure 2-11. Setup Needs the Next Disk Window

12. Insert the disk labeled “INTUITY CONVERSANT V6.1 Graphical Designer 
1.6, 3 of 3” into the disk drive and click the OK button.

The system displays the status bars that show you the progress of the file 
transfer from the third disk. When installation is complete, it displays the 
Setup Complete screen (Figure 2-12).
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Figure 2-12. First Setup Complete Screen

13. Click the Yes button to view the read-me file. When finished reading, exit 
the file.

The system redisplays the Setup Complete screen (Figure 2-12).

14. Click the Finish button.

The system displays the second Setup Complete screen (Figure 2-13). 
This screen asks if you want to restart your computer. You should restart 
your computer to install the fonts necessary for printing.
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Figure 2-13. Second Setup Complete Screen

15. Indicate if you want to restart your computer by clicking the Yes or No 
buttons. Remove any disks from the drive, and click the Finish button to 
complete the installation of the Application Design software package.

16. To install the Application Generation package, do the following Steps a 
through c:

a. Repeat Steps 1 through 6 above using the disk labeled “INTUITY 
CONVERSANT V6.1 Graphical Designer 1.6 Application Code 
Generation”.

The system displays the Start Copying Files screen (Figure 2-8).

b. Follow the instructions on the screen to change any setting if 
necessary and then click the Next button.

The system begins copying files. 

Two status bars appear that show you the status of the installation. 
The vertical status bars (Figure 2-9) on the left side of the screen 
indicate the percentage complete for each file installed from the 
source disk. The horizontal status bar (Figure 2-10) in the middle of 
the screen indicates the percentage complete of the entire 
installation.
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When the file transfer is complete, the system displays the Setup 
Complete screen (Figure 2-14).

Figure 2-14. Setup Complete Screen

c. Click the Finish button.

The system installs this software in the same location you specified 
in Step 8 when you installed the Application Design package. 

17. To install the Application Transfer package, repeat Steps 16a through 16c 
above using the disk labeled “INTUITY CONVERSANT V6.1 Graphical 
Designer 1.6 Application Transfer”.

The system installs this software in the same location you specified in Step 
8 when you installed the Application Design package. 

18. To install the Sample Application package, repeat Steps 16a through 16c 
above using the disk labeled “INTUITY CONVERSANT V6.1 Graphical 
Designer 1.6 Sample Application”. 

The system installs these sample applications in the apps subdirectory of 
the directory you specified in Step 8 when you installed the Application 
Design package.
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19. To install the Getting Started demo package, do the following Steps a and 
b:

a. Repeat Steps 1 through 10 above using the disk labeled “Intuity 
CONVERSANT V6.1 Graphical Designer 1.6 Getting Started”.

The system displays the Start Copying Files screen (Figure 2-8).

b. Repeat Steps 16b and 16c above.

The system installs these sample applications in the location you 
specified in Step 8.

On the INTUITY CONVERSANT System

You must install the Integration module on your INTUITY CONVERSANT system 
before you can transfer Graphical Designer applications from your personal 
computer. This procedure varies slightly depending on what version of the 
INTUITY CONVERSANT system you have.

For INTUITY CONVERSANT Intro 3.1.1 and 
INTUITY CONVERSANT 4.0 and 5.0 Systems

To install the Integration package on the INTUITY CONVERSANT systems listed 
above, perform the following procedure after logging in to the system:

1. Insert the Integration Software disk into the floppy disk drive.

2. Enter installpkg

The system displays the following message:

Please indicate the installation medium you intend to 
use.
Strike C to install from CARTRIDGE TAPE.
Strike F to install from FLOPPY DISKETTE.

Strike ESC to stop.

3. Enter F to install from floppy disk.

The system displays the following message:

If the program installation requires more than one 
floppy disk, be sure to insert the disks in the proper 
order, starting with disk number 1.
After the first floppy disk, instructions will be 
provided for inserting the remaining floppy disks.

Strike ENTER when ready

or ESC to stop.
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4. Press .

The system displays the following message:

Installing Intuity CONVERSANT VIS Graphical Designer 
Integration Software 1.0

The installation of the Intuity CONVERSANT VIS 
Graphical Designer Integration Software 1.0 is now 
complete.

For INTUITY CONVERSANT 6.0 Systems

To install the Integration package on an INTUITY CONVERSANT 6.0 system, 
perform the following procedure after logging in to the system:

1. Enter pkgadd -d diskette1

The system displays the following message:

Insert diskette into Floppy Drive 1.
Type [go] when ready,
or [q] to quit: (default: go) .

2. Insert the Integration Software disk into the floppy disk drive.

3. Enter go

The system displays the following message:

The following packages are available:

1 gui Intuity Graphical Designer Integration
Package (i486).

Select package(s) you wish to process (or ‘all’ to 
process all packages).
(default: all) [?, ??, q]

4. Enter 1 

The system displays the following message:

Installation of Intuity CONVERSANT Graphical Designer 
Integration Package (gui) was successful.

ENTER
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3
Procedures

Overview

This chapter contains information on and procedures for the following:

■ Using the mouse and keyboard

■ Basic procedures for creating and working with designs

■ Defining the host interface

■ Accessing remote database applications

■ Using the Support Access Program

Purpose

The purpose of this chapter is to provide the procedures you will need to work 
with the Graphical Designer. Online help provides additional information.
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Using the Mouse and Keyboard

This section provides basic information about navigating through the Graphical 
Designer.

Basic Mouse Techniques

Table 3-1 describes some of the terms used throughout this book to describe 
how to use a mouse when working with the Graphical Designer.

NOTE:
A mouse typically has more than one button. Instructions in this book refer 
to using the left mouse button, which is the default, of a right-handed 
mouse. You can change the default through the Windows control panel.

Basic Keyboard Techniques

Most of the procedures in this book specify using the mouse to complete the 
task. However, you may also use the keyboard to complete many of the tasks 
when working with the Graphical Designer. A keyboard alternative is available for 
a menu option if any of the following conditions exist:

■ The abbreviation for the control key  followed by a letter is listed next 
to the menu option. 

For example, one of the menu options available in the Go Menu is Edit 
Buckets. Next to the menu option is  . You can either select the Edit 
Buckets option from the menu, or press  and the  together to 
perform the menu option task.

■ One of the letters in the menu option name is underlined.

For example, one of the menu options in the Edit Menu is Paste. The “P” in 
the word “Paste” is underlined. You can either select the menu option of 
Paste or press  to perform the menu option task listed.

Table 3-1. Mouse Techniques

Term Meaning

Click To quickly press and release the mouse button

Double-click To click the mouse button twice in rapid succession

Drag To press and hold down the mouse button while you move the 
mouse

Point To move the mouse until the mouse pointer on the screen 
points to the item of choice

Ctrl

Ctrl B

Ctrl B

P
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■ Some of the menu options in the Graphical Designer can be initiated by 
pressing  and a letter or pressing the underlined letter in the menu 
option name. The menu option will be listed in the menu with both shortcut 
key options.

Table 3-2 through Table 3-27 list the keyboard shortcuts available in the various 
menus of the Graphical Designer.

Working with the External Function
Definition Editor

Table 3-2. Functions Menu

To Press

Create a new function  or   from External 
Function Definition Editor

Save the current function  or   from External 
Function Definition Editor

Save the current function under a different 
name

 

Delete the currently selected function

Exit to the previous screen

Table 3-3. Arguments Menu

To Press

Change an argument

Add an argument  or   from External Function 
Definition Editor

Insert an argument  or   from External Function 
Definition Editor

Delete an argument

Move an argument up

Move an argument down

Ctrl

N Ctrl N

S Ctrl S

A

D

X

C

A Ctrl A

I Ctrl I

D

U

D
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Working with the Bucket Editor

Table 3-4. Edit Menu

Table 3-5. Formats Menu

Table 3-6. Tools Menu

To Press

New bucket  or   from Bucket 
Editor

Delete bucket  or   from Bucket 
Editor

Delete unreferenced bucket

To Press

Use TTS only

Use recorded speech only

To Press

Table Editor  or  

N Ctrl N

D Ctrl D

D

T

R

T Ctrl T
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Editing

Table 3-7. Edit Menu

Making Entries

To Press

Paste

Create a new node   or 

Connect a new node to the call flow   or 

Disconnect a node from the call flow   or 

Edit a node  

Delete a node

Jump to a node  

Insert a bucket   or 

Start simulation at the currently selected node 
(GO)

 

Stop simulation mode  

Table 3-8. Entries Menu

To Press

Change the value of the currently selected 
entry

Add an entry at the end of the list   or 

Insert an entry above the currently selected 
entry

  or 

Delete the currently selected entry

Move an entry up one row from the currently 
selected position

Move an entry down one row from the 
currently selected position

P

Ctrl N N

Ctrl O O

Ctrl D D

Ctrl E

DELETE

Ctrl J

Ctrl B B

Ctrl G

Ctrl S

C

Ctrl A N

Ctrl I I

E

U

D
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Using the Event Format Menu

Working with Event Records

Working with Database Fields

Using the File Menu

You can make selections from the File menu from the introductory Graphical 
Designer menu (Table 3-12), the main Design Pad (Table 3-13), Simulation Mode 
(Table 3-14), and the FlexWord® Editor (Table 3-15). Each keyboard shortcut is 
available from within the File menu; in some instances a command is also 
available from outside the File menu.

Table 3-9. Event Format Menu

To Press

Add a field to the end of the event record

Insert a field above the currently selected row

Delete the currently selected field

Move the field down one row from the current 
position

Move the field up one row from the current 
position

Table 3-10. Events Menu

To Press

Clear an event record

Save an event record

Table 3-11. Fields Menu

To Press

Add a field   or 

Insert a field   or 

Delete a field

A

I

D

L

R

C

S

Ctrl A A

Ctrl I I

D
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l

Table 3-12. File Menu from the Introductory Graphical Designer Screen

To Press

Select the File menu from the introductory 
Graphical Designer screen

 

New design  or   from the Graphical 
Designer screen

Open design  or   from the Graphical 
Designer screen

Delete the current design

Exit the Graphical Designer

Table 3-13. File Menu from the Main Design Pad

To Press

Select the File menu from the Design Pad  

Save the current design  or   from the Design 
Pad

Save design As a different name

Close the current design

Delete the current design

Print the current design  or   from the Design 
Pad

Generate the application

Application Version

Table 3-14. File Menu from Simulation Mode

To Press

Save the current design  or   from the 
Simulation screen

Close the current design

Delete the current design

ALT F

N Ctrl N

O Ctrl O

D

X

ALT F

S Ctrl S

A

C

D

P Ctrl P

G

V

S Ctrl S

C

D



Procedures

3-8 Issue  2.0   August 1997 

Using the Go Menu

Using the Help Menu

Table 3-15. File Menu from the FlexWord Editor

To Press

New wordlist  or   from the 
FlexWord Editor

Save a wordlist  or   from the 
FlexWord Editor

Clear a wordlist

Delete a wordlist

Save a wordlist as 

Exit the wordlist editor

Table 3-16. Go Menu

To Press

Go to the Bucket Editor screen   or 

Go to the Table Editor screen   or 

Go to the Sound Manager screen

Go to the Phrase Manager screen

Go to the Prompt Manager screen

Go to the Voice Response Parameters screen  

Table 3-17. Help Menu

To Press

Go to the Graphical Designer Help Table of 
Contents

N Ctrl N

S Ctrl S

C

D

A

X

Ctrl B B

Ctrl T T

S

P

R

Ctrl P

F1
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Working with Hosts

Working with Speech Phrases

Table 3-18. Host Menu

To Press

Create a new Host   or 

Save the current Host   or 

Save the current Host under a different name

Delete the current Host

Exit the Host Definition Editor

Table 3-19. Phrase Table Menu

To Press

Create a new Phrase Table   or 

Open an existing Phrase Table   or 

Save the currently selected Phrase Table   or 

Save the Phrase Table under a different name

Change the name of the currently selected 
Phrase Table

Delete the currently selected Phrase Table

Table 3-20. Phrases Menu

To Press

Add a phrase to the end of the Phrase Table  

Insert a phrase in the row above the currently 
selected phrase

 

Delete the currently selected phrase 

Ctrl N N

Ctrl S S

A

D

X

Ctrl N N

Ctrl O O

Ctrl S S

A

R

D

Ctrl A

Ctrl I

I

D
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Working with a Playlist

Working with Prompts

Working with Database Records

Table 3-21. Playlist Menu

To Press

Remove the currently selected line from the 
Playlist

 

Insert a phrase to the Playlist directly above 
the selected line

 

Insert a bucket at the current cursor position  

Table 3-22. Prompt Menu

To Press

Rename the currently selected prompt

Delete the currently selected prompt

Table 3-23. Records Menu

To Press

Add a record to the end of the database table   or 

Insert a record in the position above the 
currently selected record

  or   

Copy the record to another place in the 
schema

Paste the record to be copied in the table 
schema

Delete the currently selected record

Ctrl D

Ctrl P

Ctrl B

R

D

Ctrl A A

Ctrl I R I

C

P

D
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Using the Screens Menu

Creating/Editing Tables

Table 3-24. Screens Menu

To Press

Create a new screen   or 

Save a screen   or 

Save a screen under a different name

Delete the currently selected screen

Exit the Host Definition Editor screen

Table 3-25. Tables Menu

To Press

Create a new table   or 

Open an existing table   or 

Save the current table   or 

Save the table under a different name

Change the name of the currently selected 
table

Delete the currently selected table

Save the table to a file

Exit the Table Editor screen

Ctrl N N

Ctrl N S

A

D

X

Ctrl N N

Ctrl O O

Ctrl S S

A

R

D

F

X
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Using Tools

Viewing

Table 3-26. Tools Menu

To Press

Go to the Defaults Editor screen

Go to the Events Editor screen

Go to the Global Events Editor screen

Go to the External Function Definition Editor   
screen

Go to the FlexWord Grammar Editor screen

Reveal a list of Host Editor screens

Go to the Host Definition Editor screen

Go to the Host Flow Editor screen

Allow Graphical Designer to automatically 
name each node

Change the Backup Interval

Table 3-27. View Menu

To Press

Zoom in    

Zoom out

Refresh the screen

Remove or replace the object palette

Expand or contract the call flow   or 

D

E

G

X

F

H

D

F

A

B

I

O

R

P

Ctrl X X
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Starting and Exiting the Graphical 
Designer

This section provides procedures for:

■ Starting the Graphical Designer in Windows 3.1

■ Starting the Graphical Designer in Windows 95

■ Exiting the Graphical Designer

Starting the Graphical Designer

In Windows 3.1

Perform the following procedure to begin a Graphical Designer session:

1. Verify that no Graphical Designer sessions are running. 

2. Locate the Graphical Designer program group in the Windows program 
manager (Figure 3-1).

Figure 3-1. Graphical Designer Program Group in the Windows Program 
Manager
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3. Double-click the Graphical Designer icon.

The system displays the Product screen (Figure 3-2). 

! CAUTION:
Do not move the mouse while waiting for the Graphical Designer to 
display the Product screen.

Figure 3-2. Product Screen

In Windows 95

Perform the following procedure to begin a Graphical Designer session in 
Windows 95:

1. Verify that no Graphical Designer sessions are running. 

2. Click the START button on the Taskbar.

The system displays a popup menu.

3. Select PROGRAMS.

The system displays a submenu.
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4. Select Lucent Technologies Graphical Designer

The system displays a submenu.

5. Select the Graphical Designer icon.

The system displays the Product screen (Figure 3-2).

Exiting the Graphical Designer

Perform the following procedure to exit the Graphical Designer:

1. Select File on the menu bar of the Design Pad screen (Figure 3-3).

2. Select Close Design. 

The system displays a dialog box asking if you want to save the design. 

3. Select one of the options. 

The system displays the Product screen (Figure 3-2).

4. Select Quit from the File Manager.

Windows displays the Program Manager (Figure 3-1).

Basic Procedures for Creating and
Working with Designs

The following sections describe how to:

■ Open and close a design

■ Open and close the object palette

■ Place objects on the design pad

■ Save a design

■ Delete a design

■ Print a design

Opening a Design

The following sections describe how to:

■ Open a new design

■ Open an existing design

NOTE:
You must begin these procedures from the Product screen (Figure 3-2).
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Opening a New Design

Typing the Name

1. Enter the name of the design in the Design Name field of the Product 
screen (Figure 3-2).

NOTE:
The name of a design cannot be longer than eight characters.

Using the File Menu

1. Select New Design from the File menu located in the menu bar.

The system displays a dialog box.

2. Type the new design name.

3. Click the OK button.

Opening an Existing Design

To open an existing design, choose one of the following procedures: 

NOTE:
You must begin these procedures from the Product screen (Figure 3-2).

Typing the Name

1. Enter the name of the design you want to open in the Design name field 
of the Product screen.

The system displays the Design Pad screen (Figure 3-3).
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Figure 3-3. Design Pad Screen

Using the Design Name Field

1. Click the down arrow next to the Design name field to reveal a list of 
existing designs.

2. Select the name of the design you want to open.

The system displays the Design Pad screen (Figure 3-3).

Using the File Menu

1. Select Open Design from the File menu located in the menu bar.

The system displays a list box showing all the existing designs.

2. Select a design name.

The system displays the Design Pad screen (Figure 3-3).

Closing a Design

To close a design, choose one of the following procedures:

NOTE:
You must begin these procedures from either the Design Pad screen 
(Figure 3-3) or the Design Simulation screen (Figure 3-4).
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Figure 3-4. Design Simulation Screen

Using a Menu Command

1. Select Close Design from the File menu located in the menu bar. 

The system displays a dialog box asking you if you want to save the 
changes you made to your design.

2. Do one of the following:

■ If you want to save the changes you made, click the Yes button.

■ If you do not want to save the changes you made, click the No 
button. 

The system displays the Product screen (Figure 3-2).

Using the Keyboard

1. Select the File menu located in the menu bar and type C

The system displays a dialog box asking you if you want to save the 
changes you made to your design.
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2. Do one of the following:

■ If you want to save the changes you made, click the Yes button.

■ If you don’t want to save the changes you made, click the No 
button. 

The system displays the Product screen (Figure 3-2).

Opening and Closing the Object Palette

The following sections describe how to open and close the Object Palette (Figure 
3-5).

Figure 3-5. Object Palette

Opening the Object Palette

To open the Object Palette, choose one of the following procedures:

■ Using a Menu Command, select Palette from the View menu located in the 
menu bar.

■ Using the Keyboard, open the View menu located in the menu bar and 
type P

■ Using a Toolbar Button, click on the palette button located on the Toolbar.

Closing the Object Palette

To close the Object Palette, choose one of the following procedures:

■ Using a Menu Command, select Palette from the View menu located in the 
menu bar.

■ Using the Keyboard, open the View menu located in the menu bar and 
type P

■ Using a Toolbar Button, click on the palette button located on the Toolbar.
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Placing Objects on the Design Pad

The following sections describe how to place objects on the Design Pad.

Dragging an Object from the Object Palette

1. Select an object from the Object Palette by placing your cursor on the 
object and holding down the button on your mouse. If the object you 
selected contains a subpalette, the subpalette will be revealed.

2. While holding down the button on your mouse, drag the selected object 
onto the Design Area.

3. Position the object where you want to put it in the call flow.

4. Release the button on your mouse to create the node. 

5. Perform one of the naming options in "Using Nodes" below. 

NOTE:
The dialog box does not appear if you have selected the Autoname 
option from the Tools Menu on the Design Pad screen (Figure 3-3).

Using a Menu Command

NOTE:
If the object you want to place on the Design Pad will be the first node in 
your call flow, skip Step 1 and go directly to Step 2. 

1. Highlight a branch of the call flow by clicking on the branch or using the 
arrow keys to move up and down the call flow. Select the New Node menu 
command from the Edit menu located in the menu bar.

The system displays a dialog box containing a list of the available objects. 

2. Use your mouse or the arrow keys to scroll through the list of objects.

3. Select an object.

4. Click the OK button or press .

5. Perform one of the naming options in "Using Nodes" below.

ENTER
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Using the Keyboard

NOTE:
If the object you want to place on the Design Pad will be the first node in 
your call flow, skip Step 1 and go directly to Step 2. 

1. Highlight a branch of the call flow by clicking on the branch or using the 
Arrow keys to move up and down the call flow. 

2. Do one of the following:

■ Press  .

The system displays a dialog box containing a list of the available 
objects.

■ Select the Edit menu located in the menu bar and type N

The system displays a dialog box containing a list of the available 
objects. 

3. Select an object.

4. Click the OK button or press .

5. Perform one of the naming options in "Using Nodes" below.

Saving a Design

The following sections describe how to save a design:

■ Under an existing name

■ Under a different name

NOTE:
You must begin these procedures from either the Design Pad screen 
(Figure 3-3) or the Design Simulation screen (Figure 3-4).

Under an Existing Name

Using a Menu Command

1. Select Save Design from the File menu located in the menu bar.

Using the Keyboard

1. Do one of the following:

■ Press  .

■ Select the File menu located in the menu bar and type S

Ctrl N

ENTER

Ctrl S
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Under a Different Name

To save a design under a different name:

Using a Menu Command

1. Select Save Design As from the File menu located in the menu bar. 

The system displays a dialog box (Figure 3-6) where you can enter the 
new design name.

Figure 3-6. Save Design As Dialog Box

2. Type the new design name.

3. Click the OK button.

Using the Keyboard

1. Select the File Menu located in the menu bar and type A

The system displays a dialog box (Figure 3-6) where you can enter the 
new design name.

2. Type the new design name.

3. Click the OK button.
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Deleting a Design

To delete a design:

Using a Menu Command

1. Select Delete Design from the File Menu located in the menu bar. 

The system displays a dialog box (Figure 3-7) asking you if you really want 
to delete the design.

Figure 3-7. Delete Design Dialog Box

2. Click the Yes button.

Using the Keyboard

1. Select File Menu located in the menu bar type D

The system displays a dialog box (Figure 3-7) asking you if you really want 
to delete the design.

2. Click the Yes button.

Printing a Design

The following sections describe how to print a design.

Using a Menu Command

1. Select the Print menu command from the File menu located in the menu 
bar.

The system displays the Print Reports Dialog Box.

2. Select the parts of your design that you want to print.

3. Click the OK button.

The system sends the design components to the printer or to a Word RTF 
file.
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Using the Keyboard

1. Do one of the following:

■ Press  .

■ Select the File menu located in the menu bar and type P

The system displays the Print Reports Dialog Box.

2. Select the parts of your design that you want to print.

3. Click the OK button.

The system sends the design components to the printer or to a Word RTF 
file.

Using a Toolbar Button

1. Select the Printer button located in the Toolbar.

The system displays the Print Reports Dialog Box.

2. Select the parts of your design that you want to print.

3. Click the OK button.

The system sends the design components to the printer or to a Word RTF 
file.

Working with Branches

The following sections describe how to:

■ Insert a branch

■ Delete a branch

Inserting a Branch

The following types of objects must be treated separately when inserting a 
branch:

■ Interactive Voice Response (IVR) objects using the touch-tone keypad

■ IVR objects with Automatic Speech Recognition (ASR) enabled

■ An encapsulated node object

■ A Host Send/Receive object

■ A Set Object

Choose the appropriate procedure below to insert a branch.

Ctrl P
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Inserting a Branch into an IVR Object

The following sections describe how to insert a branch into an IVR object:

■ Using the touch-tone keypad

■ With ASR enabled

Using the Touch-Tone Keypad

Branches are inserted into IVR objects (with the exception of Announcement and 
Voice Capture objects) using the Touchtones Dialog Box (Figure 3-8).

1. Select a branch extending from an IVR object.

The new branch is inserted directly above the branch that is highlighted.

The system displays a popup menu.

2. Choose the Insert Branch menu command from the popup menu. 

The system displays the Touchtones Dialog Box.

3. Select the items that you want to define as the touchtone sequence for the 
new branch.

4. Click the OK button.

The system displays the branch directly above the branch you highlighted 
in Step 1.

With ASR Enabled

1. Select a branch extending from an IVR object.

The new branch is inserted directly above the branch that is highlighted.

The system displays a popup menu.

2. Choose the Insert Branch menu command from the popup menu. 

The system displays the Touchtones Dialog Box (Figure 3-8). If you have 
specified ASR as the input mode, the Speech... button is enabled.
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Figure 3-8. Touchtone Dialog Box

3. Select the Speech... button.

The system displays the Select Branch List Box (Figure 3-9).

Figure 3-9. Select Branch List Box
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4. Select one of the grammars defined as the ASR Input Mode.

5. Click the OK button.

The system displays the branch directly above the branch you highlighted 
in Step 1.

Inserting a Branch into an Encapsulated Node

You can insert branches in an encapsulated node to define new exit conditions 
for the subtree. When a branch is added to an encapsulated node, the system 
displays it as a Halt node in the subtree.

1. Select a branch extending from an encapsulated node.

The new branch is inserted directly above the branch that is highlighted.

The system displays a popup menu.

2. Choose the Insert Branch menu command from the popup menu.

The system displays a dialog box (Figure 3-10) asking you to name the 
new exit condition.

Figure 3-10. Name New Exit Condition Dialog Box

3. Type the name of the new branch.

4. Click the OK button.

The system displays the branch directly above the branch you highlighted 
in Step 1.
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Inserting a Branch into a Host 
Send/Receive Object

A branch must be defined for each Receive screen to be sent to the host.

1. Select a branch extending from a Host Send/Receive object.

The new branch is inserted directly above the branch that is highlighted.

The system displays a popup menu.

2. Select Insert Branch from the popup menu.

The system displays the Choose a Screen Dialog Box (Figure 3-11).

Figure 3-11. Choose a Screen Dialog Box

3. Select a Receive screen name.

4. Click the Select button.

The system displays the branch directly above the branch you highlighted 
in Step 1.
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Inserting a Branch into a Set Object

1. Select a branch extending from a Set object.

The new branch is inserted directly above the branch that is highlighted.

The system displays a popup menu.

2. Select Insert Branch from the popup menu.

The system displays a dialog box (Figure 3-12) asking you to name the 
new branch condition.

Figure 3-12. Name New Branch Condition Dialog Box

3. Type the name of the new branch.

4. Click the OK button.

The system displays the branch directly above the branch you highlighted 
in Step 1. The name of the new branch condition appears in the Data 
Comparisons portion of the Set screen.

Deleting a Branch

1. Select the branch you want to delete.

The system displays a popup menu.

2. Choose Delete Branch from the popup menu.

The system displays a dialog box (Figure 3-13) asking you if you really 
want to delete this branch.
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Figure 3-13. Delete Branch Dialog Box

3. Click the Yes button.

The system deletes the branch.

Using Nodes

The following sections describe how to:

■ Name a node

■ Edit a node

■ Delete a node

■ Connect a node

■ Disconnect a node

■ Rename a node

■ Jump to a node

■ Copy or reuse an encapsulated node

■ Find a node

Naming a Node

To name a node, do one of the following procedures:

■ Type in the name of the node in the dialog box and press  or click 
the OK button.

■ Select Autoname from the Edit menu. 

The system automatically names each new node for you.

ENTER
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Editing a Node

When you edit a node, the screens that appear vary depending on the type of 
node you edit. To create or edit an announcement node, for example, perform 
the following procedure:

1. Click on the Announcement node you want to edit.

The system displays a popup menu.

! CAUTION:
If, when trying to edit a node, you double-click on a particular 
branch, rather than just clicking once with your mouse, you will 
contract the view of the particular branch you highlighted. However, 
you can double-click a second time to expand the view.

2. Select Edit Node from the popup menu.

The system displays the Announcement window (Figure 3-14).

NOTE:
You can also edit a node by holding down  and selecting the 
node in the call flow with the mouse. 

Ctrl
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Figure 3-14. Announcement Window

3. Enter the name of the prompt in the Initial Prompt field or click on the 
arrow next to the Initial Prompt field to select a prompt from the list of 
existing prompts.

NOTE:
Unless otherwise specified, the prompt will have the same name as 
the node you are editing.

4. Click anywhere in the box below the Initial Prompt field.

The system displays the Announcement Editor window.

5. Click anywhere in the Announcement Text area.

6. Enter the text for your announcement.

NOTE:
To include a bucket value in an announcement, press the  (left 
bracket) to obtain a list of buckets from the Choose a Bucket 
window. You can also select Insert Bucket from the Edit menu to 
access the Choose a Bucket window.

[
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7. Click the Hand button to return to the Announcement window.

8. Click the Hand button to save your announcement and return to the 
Design Pad. 

Deleting a Node

To delete a node, choose one of the following three procedures.

Using a Popup Menu

1. Highlight the node you want to delete.

The system displays a popup menu.

2. Select Delete Node from the popup menu.

The system displays a dialog box (Figure 3-15) asking you if you are sure 
you want to delete the selected node and all the nodes under it.

Figure 3-15. Delete Node Confirmation Dialog Box

3. Click the Yes button.

The system deletes the node and all the nodes under it.

Using a Menu Command

1. Highlight the node you want to delete.

The system displays a Popup menu.

2. Select the Delete Node menu command from the Edit menu.

The system displays a dialog box (Figure 3-15) asking you if you are sure 
you want to delete the selected node and all the nodes under it.

3. Click the Yes button.

The system deletes the node and all the nodes under it.
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Using the Keyboard

1. Highlight the node you want to delete by clicking on the node or using the 
arrow keys to move up and down within the call flow.

The system displays a popup menu.

2. Do one of the following:

■ Select Delete Node from the popup menu.

■ Select the Edit menu located in the menu bar and type D

The system displays a dialog box (Figure 3-15) asking you if you 
are sure you want to delete the selected node and all the nodes 
under it.

3. Click the Yes button.

The system deletes the node and all the nodes under it.

Connecting a Node

To connect a node, choose one of the following procedures.

NOTE:
Before connecting a node to the call flow, you must first create an orphan 
node.

Using a Popup Menu

1. Highlight the branch to which you want to connect a node.

The system displays a popup menu.

2. Select Connect Node from the popup menu.

The system displays the Available Nodes List Box (Figure 3-16) containing 
a list of all of the orphan nodes in your call flow.
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Figure 3-16. Available Nodes List Box

3. Select the node to which you want to connect.

4. Click the OK button.

The system connects the selected node and all the nodes under it to the 
branch you selected in Step 1.

Using a Menu Command

1. Highlight the branch to which you want to connect a node.

2. Select Connect Node from the Edit menu located in the menu bar. 

The system displays the Available Nodes List Box (Figure 3-16) containing 
a list of all of the orphan nodes in your call flow.

3. Select the node you to which you want to connect.

4. Click the OK button.

The system connects the selected node and all the nodes under it to the 
branch you selected in Step 1.
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Using the Keyboard

1. Highlight the branch to which you want to connect a node.

The system displays a popup menu.

2. Select the Edit menu located in the menu bar and type C

The system displays the Available Nodes List Box (Figure 3-16) containing 
a list of all of the orphan nodes in your call flow.

3. Select the node to which you want to connect.

4. Click the OK button.

The system connects the selected node and all the nodes under it to the 
branch you selected in Step 1.

Disconnecting a Node

To disconnect a node, choose one of the following procedures.

Using a Popup Menu

1. Highlight the node you want to disconnect.

The system displays a popup menu.

2. Select Disconnect Node from the popup menu.

The system disconnects the selected node and all of the nodes under it 
and displays the disconnected node at the bottom of the design.

Using a Menu Command

1. Highlight the node you want to disconnect.

2. Select Disconnect Node from the Edit menu.

The system disconnects the selected node and all of the nodes under it 
and displays the disconnected node at the bottom of the design.

Using the Keyboard

1. Highlight the node you want to disconnect.

2. Select the Edit menu located in the menu bar and type S

The system disconnects the selected node and all of the nodes under it 
and displays the disconnected node at the bottom of the design.
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Renaming a Node

To rename a node, use the following procedure:

1. Highlight the node you want to rename.

The system displays a popup menu.

2. Select Rename Node from the popup menu.

The system displays a dialog box (Figure 3-17).

Figure 3-17. New Node Name Dialog Box

3. Type the new name of the node in the dialog box.

4. Click the OK button.

The system renames the selected node.

Jumping to a Node

To jump to a node, choose one of the following procedures.

NOTE:
Before jumping to a node, you must first create a call flow containing at 
least two nodes.

Using a Popup Menu

1. Highlight the branch from which you want to jump.

The system displays a popup menu.

2. Select Jump to Node from the popup menu.

The system displays the Nodes List Box (Figure 3-18) containing a list of 
all the nodes in your call flow.
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Figure 3-18. Nodes List Box

3. Select the node to which you want to jump.

4. Click the OK button.

The system creates a Jump To node at the currently selected node.

Using a Menu Command

1. Highlight the branch from which you want to jump.

2. Select Jump to Node from the Edit menu.

The system displays the Nodes List Box (Figure 3-18) containing a list of 
all the nodes in your call flow.

3. Select the node to which you want to jump.

4. Click the OK button.

The system creates a Jump To node at the currently selected node.

Using the Keyboard

1. Highlight the branch from which you want to jump.

2. Select Jump to Node from the Edit menu and type J

The system displays the Nodes List Box (Figure 3-18) containing a list of 
all the nodes in your call flow.
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3. Select the node to which you want to jump.

4. Click the OK button.

The system creates a jump to node at the currently selected node.

Copying or Reusing an Encapsulated Node

You cannot copy or reuse a node unless it has been encapsulated. See 
"Encapsulation Object" in Appendix A, "Object Reference", for more information.

Your decision about when to reuse or copy an encapsulated node must consider 
the following differences between them:

■ Reused nodes are linked 

If you make changes to one reused node, it is reflected in all the other 
nodes wherever they are used (reused) in the design. Because the nodes 
are linked, they have the same name and are distinguished only by a 
number. For example, if you encapsulate a portion of a callflow and name 
it GetBal, the Graphical Designer displays it in the Design Pad screen as 
GetBal(1). If you then reuse GetBal, the Graphical Designer displays 
GetBal(2) along with GetBal(1) in the Design Pad screen. The next reuse 
would be GetBal(3), and so on.

You would reuse an encapsulated node when you wanted several 
identical versions of the same callflow fragment.

■ Copied nodes are not linked

If you make changes to a copied node, the changes only affect the node 
you are editing. For this reason, copied nodes have different names. 
Copying an encapsulated node is like using the “Save As” command.

Use the Copy command when you want several similar but not identical 
versions of the same callflow fragment.

Finding a Node

To find a node, choose one of the following two procedures.

Using a Menu Command

1. Select Find from the Edit menu.

The system displays the Nodes List Box (Figure 3-18) containing a list of 
all the nodes in your call flow sorted alphabetically by class.

2. Select the node you want to find.

3. Click the OK button.

The system displays the node highlighted in the call flow.
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Using the Keyboard

1. Do one of the following:

■ Press  .

The system displays the Nodes List Box (Figure 3-18) containing a 
list of all the nodes in your call flow sorted alphabetically by Class.

■ Select the Edit menu and type F

The system displays the Nodes List Box (Figure 3-18) containing a 
list of all the nodes in your call flow sorted alphabetically by Class.

2. Select the node you want to find.

3. Click the OK button.

The system displays the node highlighted in the call flow.

Defining the Host Interface

The Graphical Designer includes a series of editors to help you define the host 
interface. This section lists those editors and their functions and provides a 
procedure for using them.

Host Definition Editor

Use the Host Definition Editor to perform the following procedures:

■ Name the host.

■ Define the performance characteristics.

■ Define the login ID and password.

■ Define each screen.

Screen Identification Editor

Use the Screen Identification Editor to perform the following procedures:

■ Name each screen.

■ Create screen identifier(s) for each screen.

Screens can be similar in appearance. Some information on each screen 
remains constant (text, prompts, etc.), while other information varies (data, 
error messages, etc.). The Graphical Designer must be shown the part or 
parts of the screen that enable it to uniquely identify the screen from all the 
other screens when they arrive from the host.

Ctrl F
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Field Definition Editor

Use the Field Definition Editor to identify fields for each screen. Fields are used to 
exchange information with the host. Fields are an optional part of the host screen 
definition.

Host Flow Editor

Use the Host Flow Editor to perform the following procedures:

■ Define the sequence of screens needed to log in to the host.

■ Define the sequence of screens needed to log out of the host.

■ Define the recovery sequence for all screens.

Procedure

To define a host interface to use with a Graphical Designer application, complete 
the following procedure:

1. Select the Host Definition Editor from the Go menu.

The system displays the Host Definition Editor (Figure 3-19).

Figure 3-19. Host Definition Editor
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2. Type the name of the host in the Name field. The name is limited to 8 
characters.

3. Type the number of seconds to wait for a recognizable screen in the 
Unrecognized Screen Timeout field.

4. Type the number of seconds to wait for a response from the host in the 
Host Timeout field.

5. Type the number of seconds to wait for a Logical Unit to become available 
in the Logical Unit Timeout field.

6. Type the Login ID in the Login field.

7. Type the password in the Password field. 

8. Click the Screen Identification Editor icon (Figure 3-20).

Figure 3-20. Screen Identification Editor Icon

The system displays the Screen Identification Editor (Figure 3-21).
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Figure 3-21. Screen Identification Editor

9. Complete the following Steps a through d for each screen:

a. Type the name of each screen in the Screen Name field.

b. Select Login, Transaction, or None in the Base Type field. A Login 
type screen is the first screen we expect to see from the host. A 
Transaction type screen is the screen we want to be on when a call 
comes in. All other screens are of type None.

c. If this is a blank screen, click on the box next to the Blank Screen.

d. For each identifier,

1. Enter the starting row in the Row field.

2. Enter the starting column in the Column field.

3. Select either Text Present, Text Absent, or Cursor in the 
Type field.

Text Present identifies text that is always present on the 
screen. The Text box contains the text that is present.

Text Absent identifies text that is absent from the screen. The 
Text box contains the text that is absent from the screen.

Cursor identifies where the cursor is on the screen. The Text 
box is a comment area for the cursor identifier. Note that 
there can only be a Cursor identifier for each screen. 
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10. Click the Field Definition Editor icon (Figure 3-22).

Figure 3-22. Field Definition Editor Icon

The system displays the Field Definition Editor (Figure 3-23).

 

Figure 3-23. Field Definition Editor

11. Complete the following Steps a through f for each screen that needs to 
send or get data from the host:

a. Enter the name of each field in the Name field. The ID field 
automatically increments for duplicate field names.

b. Enter the starting row in the Row field.

c. Indicate the starting column in the Col field.

d. Indicate the field length in the Length field.



Accessing Remote Database Tables from Graphical 
Designer Applications

Issue  2.0   August 1997 3-45

e. Select either To Host, From Host, or Both in the Direction field.

f. Select either Character or Number in the Class field.

Figure 3-24. Host Send Screen

See "Host Send Data Object" in Appendix A, "Object Reference", for a detailed 
description of this object.

Accessing Remote Database Tables
from Graphical Designer Applications

The Graphical Designer does not support remote database table access. Use 
the following procedure to modify the Graphical Designer environment so that 
Graphical Designer applications can access remote databases.

1. Configure the Remote Database ID(s) on the INTUITY™ CONVERSANT® 
computer. The additional database DIP names to configure are:

dbdip2 (for DB2_Remote)

dbdip3 (for DB3_Remote)

dbdip4 (for DB4_Remote)

dbdip5 (for DB5_Remote)
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See “Adding a Remote Database Access ID” in Chapter 6, “Database 
Administration,” in INTUITY CONVERSANT System Version 6.0 
Administration, 585-310-591, for more information.

2. Install the Graphical Designer application on the INTUITY CONVERSANT 
computer. See "Software Installation Procedures" in Chapter 2, "Installing 
the Graphical Designer Software", for more information.

3. Enter the following command:

cd /att/trans/graphd/appl

where appl is the Graphical Designer application name.

4. Modify the /att/trans/graphd/appl.t file and change the dbase() call from 
DBDIP to im.“dbdip2” for the remote table access.

For example, if the remote table name is MYTABLE, the dbase() statement 
is:

dbase(DBDIP, SELECT, ch.F_NAME, FS_MYTABLE, ...)

Change it to:

dbase(im.“dbdip2”, SELECT, ch.F_NAME, FS_MYTABLE, ...)

NOTE:
Dbdip2 is just an example. The database dip you choose depends 
on which database ID you choose to access the table (dbdip2 for ID 
DB2_Remote).

5. Repeat Step 4 for all the dbase() statements that access remote database 
tables.

6. Enter the following command:

tas -o /vs/trans/appl.T appl.t

where appl is the application name.

7. Enter newscript

NOTE:
You must repeat Steps 3 through 7 each time the Graphical 
Designer application is reinstalled on the INTUITY CONVERSANT 
system.
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Using the Support Access Program

The Support Access program, which is part of the Application Design Software 
Package, allows Lucent Technologies support personnel access to your 
personal computer through a modem and the ability to transfer files from your 
personal computer to that of a support person for evaluation.

When you access the Support Access program, you are asked to assign a login 
and password to be used by the support person to gain access to your personal 
computer. The login and password can consist of up to 31 alphanumeric 
characters including special characters. You can also make both fields null by 
pressing . The default login is Graphical and the default password is 
Designer. 

NOTE:
The login and password are case-sensitive.

When you double-click on the Support Access icon for the first time, you are 
prompted for information necessary to configure the Support Access program. 
The Support Access Terminal Settings window (Figure 3-25) allows you to 
customize the way the Support Access window appears on your personal 
computer.

Figure 3-25. Support Access Terminal Settings Window

The Support Access Setup window (Figure 3-26) allows you to define how the 
modem communicates with your personal computer. These settings must agree 
with how the modem is configured on your computer.

CANCEL
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Figure 3-26. Support Access Modem Setup Window

The Support Access Modem Settings window (Figure 3-27), asks you for the 
make and model of the modem used by the support person. Select the make of 
the modem first followed by the model type.

NOTE:
The Support Access program consists of 442 different makes and models 
of modems. If the exact make and model of the modem you need to access 
is not on the list, you can add the modem by selecting Add Modem from 
the Utilities menu.

Figure 3-27. Support Access Modem Settings Window



Using the Support Access Program

Issue  2.0   August 1997 3-49

Once you click the OK button, the Support Access program attempts to 
communicate with the modem. If the Support Access program has trouble 
communicating with the modem, a message appears telling you that you may 
have selected the wrong modem.
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4
Building a Simple Design

Overview

This chapter provides step-by-step instructions for creating a simple-call-flow 
design. This design incorporates the sequence of events that occur when a 
caller reaches an inquiry line for an automotive parts and service store.

Purpose

The purpose of this chapter is to demonstrate basic call flow design and help you 
to learn how the INTUITY™ CONVERSANT® Graphical Designer operates.
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Starting the Graphical Designer

See "Starting and Exiting the Graphical Designer" in Chapter 3, "Procedures", for 
the information you need to begin a Graphical Designer session.

Creating the Design

The following sections contain the procedures you need to create a design that 
does the following for a fictitious automotive parts and service store:

■ Answers incoming calls

■ Gives a standard greeting to the caller

■ Determines an action for the call

— If the caller is calling outside of normal business hours, plays a 
message telling the caller to call back during normal business 
hours

— If the caller is calling within the designated business hours, 
determines whether the caller is using a touchtone or rotary 
telephone

— If the caller is calling from a rotary telephone, transfers the caller to 
an operator

— If the operator does not answer or the line is busy, plays an 
announcement instructing the caller to call back at a later time

— If the caller is calling from a touchtone telephone, plays a menu of 
three options from which the caller can choose: 

■ Transfer to the parts department

■ Transfer to the service department

■ Transfer to an operator

— If the call cannot be transferred, plays an announcement instructing 
the caller to call back at a later time

■ Ends the call
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Creating the Call Flow

Answer the Telephone

The Call Answer object answers an incoming call. It is almost always the first 
object in a design. Perform the following procedure to add a Call Answer object:

1. Click the Telephony object in the Object Palette. 

The system displays a subpalette.

2. Select and drag the Call Answer object (Figure 4-1) to the Design area. 

Figure 4-1. Call Answer Object

3. Release the mouse button. 

The system places the object in the top left corner of the Design Area and 
displays the New Node dialog box (Figure 4-2).

Figure 4-2. New Node Dialog Box

4. Type Answer Call in the New Node dialog box.

5. Do one of the following: 

■ Press .

■ Click the OK button. 

The system displays the Design Pad screen (Figure 4-3).

ENTER
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Figure 4-3. Design Pad Screen

6. Do one of the following:

■ Select Save from the File Menu located on the Menu Bar.

■ Press  .

Greet the Caller

This branch is executed after the call has been answered. We will create an 
announcement to greet and tell the caller who we are. Perform the following 
procedure to create an Announcement object and add it to the call flow:

1. Click the IVR object in the Object Palette. 

The system displays a subpalette.

2. Select and drag the Announcement object (Figure 4-4) until it is directly 
over the empty branch under the Answer Call node.

CTRL S
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Figure 4-4. Announcement Object

3. Release the mouse button.

The system displays the New Node dialog box (Figure 4-2).

4. Type Greeting in the New Node dialog box.

5. Do one of the following:

■ Press .

■ Click the OK button. 

The system displays the Design Pad screen (Figure 4-5).

Figure 4-5. Design Pad Screen

ENTER



Building a Simple Design

4-6 Issue  2.0   August 1997 

6. Select the Greeting node in the Design Area. 

The system displays a popup menu. 

7. Click the Edit Node. 

The system displays the Announcement screen (Figure 4-6).

Figure 4-6. Announcement Screen

8. Press . 

The system displays the Announcement Editor screen (Figure 4-7).

ENTER
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Figure 4-7. Announcement Editor Screen

9. Type Thank you for calling the ABC Automotive Parts & Service Store.

10. Click the Hand button. 

The system displays the Announcement screen (Figure 4-6).

11. Click the More... button.

The system displays the Voice Response Parameters screen (Figure 4-8).
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Figure 4-8. Voice Response Parameters Screen

12. Select the Allow Caller to Interrupt Announcement box if it is not already 
selected.

13. Click the Hand button. 

The system displays the Announcement screen (Figure 4-6).

14. Click the Hand button.

The system displays the Design Pad screen (Figure 4-5).

15. Do one of the following:

■ Select Save from the File Menu located on the Menu Bar.

■ Press  .CTRL S
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Add a Day of the Week Check to the Greeting
Node

Because operators and salespeople are typically available only Monday through 
Saturday, we want to check the day of the week before attempting to transfer a 
call to them. Later, we will check for the time of the call. Perform the following 
procedure to add a Day of the Week timebranch object:

1. Select and drag the Timebranch object (Figure 4-9) from the Object 
Palette until it is directly over the empty branch under the Greeting node.

Figure 4-9. Timebranch Object

2. Release the mouse button. 

The system displays the New Node dialog box (Figure 4-2).

3. Type Check Day in the New Node dialog box.

4. Do one of the following:

■ Press .

■ Click the OK button. 

The system displays the Design Pad screen (Figure 4-10).

ENTER
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Figure 4-10. Design Pad Screen

5. Select the branch labeled Other. 

The system displays a popup menu.

6. Select Insert Branch.

The system displays the Timebranch dialog box (Figure 4-11).

Figure 4-11. Timebranch Dialog Box
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7. Select Day. 

ABC Automotive is open Monday through Saturday. Since the default Start 
Day is Monday, no action is needed to change the Start Day.

8. Click the up arrow next to the End Day field until Sat appears.

9. Click the OK button.

The system displays the Design Pad screen (Figure 4-12).

Figure 4-12. Design Pad Screen

10. Do one of the following:

■ Select Save from the File Menu located on the Menu Bar.

■ Press  .

Add a Time of Day Check to the Mon-Sat Branch

We need an additional Timebranch object to specify the times when calls can be 
transferred to an operator or a department. Perform the following procedure to 
add a Time of Day timebranch:

1. Select and drag the Timebranch object (Figure 4-9) from the Object 
Palette until it is directly over the branch labeled Mon-Sat.

2. Release the mouse button.

CTRL S
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The system displays the New Node dialog box (Figure 4-2).

3. Type Check Time in the New Node dialog box.

4. Do one of the following:

■ Press .

■ Click the OK button.

The system displays the Design Pad screen (Figure 4-13).

Figure 4-13. Design Pad Screen

5. Select the rightmost branch labeled Other.

The system displays a popup menu.

6. Select Insert Branch.

The system displays the Timebranch dialog box (Figure 4-11).

7. Select Time.

8. Click the up arrow next to the hour portion of the Start Time field until 09 
appears. Only the hour portion of the time needs to be changed.

9. Click the up arrow located next to the hour portion of the End Time field 
until 21 appears. Only the hour portion of the time needs to be changed.

ENTER
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10. Click the OK button.

The system displays the Design Pad screen (Figure 4-14).

Figure 4-14. Design Pad Screen

11. Do one of the following:

■ Select Save from the File Menu located on the Menu Bar.

■ Press  .

Planning the Next Step

The design we have created works as follows:

1. A call comes into the ABC Automotive Parts & Service Inquiry Line and is 
answered.

2. The caller is greeted.

3. A Day of Week Timebranch condition is set for Monday – Saturday.

4. A Time of Day Timebranch is set for the hours 09:00 – 21:00 (9:00 a.m. – 
9:00 p.m.). 

CTRL S
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We now have to decide how to handle calls under each of the following 
conditions:

■ A call comes in on Sunday when the store is not open.

■ A call comes in before or after normal business hours.

■ A call comes in during normal business hours, that is, Monday through 
Saturday between the hours of 9:00 a.m. (09:00) and 9:00 p.m. (21:00).

The first two conditions affect the two branches labeled Other. If a call reaches 
the Inquiry Line outside of normal business hours or on Sunday, we play an 
announcement informing the caller that he or she must call back during normal 
business hours. Then we terminate the call. 

The third condition affects the branch labeled 09:00 – 21:00. If the call comes in 
during normal business hours, we play a menu to determine whether the caller 
has a rotary or touch-tone telephone, then we do further call processing.

Add an Announcement to the First Branch
Labeled Other

This branch is executed when a caller reaches the Inquiry line at a time when the 
store is not open. However, we will compose the announcement so that it can 
handle both wrong time and wrong day conditions. Perform the following 
procedure to add an announcement object:

1. Click the IVR object on the Object Palette.

The system displays a subpalette.

2. Select and drag the Announcement object (Figure 4-4) until the cursor is 
directly over the first (leftmost) branch labeled Other. 

3. Release the mouse button.

The system displays the New Node dialog box (Figure 4-2).

4. Type Closed in the New Node dialog box.

5. Do one of the following:

■ Press  

■ Click the OK button.

The system displays the Design Pad screen (Figure 4-15).

ENTER
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Figure 4-15. Design Pad Screen

6. Select the node labeled Closed.

The system displays a popup menu.

7. Select Edit Node.

The system displays the Announcement screen (Figure 4-6).

8. Press .

The system displays the Announcement Editor screen (Figure 4-7).

9. Type We’re sorry, but ABC Automotive Parts & Service Store is 
closed. Please call back during our normal business hours of Monday 
through Saturday, 9 a.m. to 9 p.m. Thank you for calling our Inquiry 
Line.

10. Click the Hand button.

The system displays the Announcement screen (Figure 4-6).

11. Click the Hand button.

The system displays the Design Pad screen (Figure 4-16). 

ENTER
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Figure 4-16. Design Pad Screen

12. Do one of the following:

■ Select Save from the File Menu located on the Menu Bar.

■ Press  .

Add a Halt Object to the First Branch Labeled
Other

This branch is executed when a caller reaches the Inquiry Line on a day when 
the store is not open. The Closed announcement has been played to the caller. 
We want to terminate the call flow. Perform the following procedure to add a Halt 
object:

1. Select and drag the Halt object (Figure 4-17) from the Object Palette until 
it is directly over the branch under the node labeled Closed.

Figure 4-17. Halt Object

CTRL S
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2. Release the mouse button.

The system displays the New Node dialog box (Figure 4-2).

3. Type Stop in the New Node dialog box.

4. Do one of the following:

■ Press .

■ Click the OK button.

The system displays the Design Pad screen (Figure 4-18).

Figure 4-18. Design Pad Screen

5. Do one of the following:

■ Select Save from the File Menu located on the Menu Bar.

■ Press  .

ENTER

CTRL S
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Add a Halt Object to the Second Branch
Labeled Other

This branch is executed when a caller reaches the Inquiry Line at a time when 
the store is not open. Since a Halt object has already been defined, we will 
create a Jump To Node instead of creating another Halt object. Perform the 
following procedure to create a Jump To Node:

1. Select the second (rightmost) branch labeled Other.

The system displays a popup menu. 

2. Select Jump To Node.

The system displays the Nodes list box (Figure 4-19).

Figure 4-19. Nodes List Box

3. Select the Closed node.

4. Click the OK button.

The system displays the Design Pad screen (Figure 4-20). 
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Figure 4-20. Design Pad Screen

5. Do one of the following:

■ Select Save from the File Menu located on the Menu Bar.

■ Press  .

Check for Telephone Type

This branch is executed for a call during normal business hours. The caller is 
asked to enter 1 if calling from a touchtone telephone. If there is no response, it is 
assumed that the caller is using a rotary telephone. Perform the following 
procedure to create a Menu object:

1. Click the IVR object on the Object Palette.

The system displays a subpalette.

2. Select and drag the Menu object (Figure 4-21) until it is directly over the 
branch labeled 09:00 – 21:00.

CTRL S
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Figure 4-21. Menu Object

3. Release the mouse button.

The system displays the New Node dialog box (Figure 4-2).

4. Type Touchtone Or Rotary in the New Node dialog box.

5. Do one of the following:

■ Press .

■ Click the OK button. 

The system displays the Design Pad screen (Figure 4-22).

Figure 4-22. Design Pad Screen

ENTER
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6. Click the TouchtoneOrRotary node in the Design Pad screen.

The system displays a popup menu.

7. Select Edit Node.

The system displays the Menu screen (Figure 4-23).

Figure 4-23. Menu Screen

8. Press .

The system displays the Announcement Editor screen (Figure 4-7).

9. Type If you are calling from a touchtone phone, please press 1 now. 
Otherwise, stay on the line and the next available operator will be with 
you shortly.

10. Click the Hand button. 

The system displays the Menu screen.

11. Click the More... button.

The system displays the Voice Response Parameters screen (Figure 
4-24).

ENTER
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Figure 4-24. Voice Response Parameters Screen

12. Type 1 in the Number of Tries Available field. It should require only 
one try for the caller to indicate whether or not he or she has a touchtone 
telephone.

13. Click the Hand button.

The system displays the Menu screen (Figure 4-23).

14. Click the Hand button.

The system displays the Errors/Warnings window (Figure 4-25) because 
we deliberately left the Bad Input, Timeout, and Too Few fields 
empty. Disregard the warning.
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Figure 4-25. Errors/Warnings Window

15. Click the OK button.

The system displays the Design Pad screen (Figure 4-26).
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Figure 4-26. Design Pad Screen

16. Do one of the following:

■ Select Save from the File Menu located on the Menu Bar.

■ Press  .

Delete Branches 2 and 3

We do not need branches 2 and 3 under TouchtoneOrRotary since the caller is 
only using branch 1 to indicate touchtone or rotary telephone. Perform the 
following procedure to delete the unnecessary menu branches:

1. Select the branch labeled 2.

The system displays a popup menu.

2. Select Delete Branch.

The system displays a dialog box (Figure 4-27).

CTRL S
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Figure 4-27. Delete Branch dialog Box

3. Click the Yes button.

The system displays the Design Pad screen (Figure 4-28).

4. Select the branch labeled 3.

The system displays a popup menu.

5. Repeat Steps 2 and 3.

Figure 4-28. Design Pad Screen
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6. Do one of the following:

■ Select Save from the File Menu located on the Menu Bar.

■ Press  .

Add a Menu at Branch 1 for Touchtone 
Telephone Users

We will now create a Menu at branch 1 that gives the caller with a touchtone 
telephone the option to transfer to the parts department, to the service 
department, or to an operator. Perform the following procedure to add a Menu 
object:

1. Click the IVR object in the Object Palette.

The system displays a subpalette.

2. Select and drag the Menu object (Figure 4-21) until it is positioned over 
the branch labeled 1.

3. Release the mouse button.

The system displays the New Node dialog box (Figure 4-2).

4. Type Choices in the New Node dialog box.

5. Do one of the following:

■ Press .

■ Click the OK button.

The system displays the Design Pad screen (Figure 4-29).

CTRL S

ENTER



Creating the Design

Issue  2.0   August 1997 4-27

Figure 4-29. Design Pad Screen

6. Click the Choices node in the Design Pad screen.

The system displays a popup menu.

7. Select Edit Node.

The system displays the Menu screen (Figure 4-23).

8. Press .

The system displays the Announcement Editor screen (Figure 4-7).

9. Type Please select one of the following options: For the Parts 
Department, press 1. For the Service Department, press 2. To speak 
to an operator, press 3.

10. Click the Hand button.

The system displays the Menu screen (Figure 4-23).

11. Type Bad Input in the Bad Input field.

12. Press .

The system displays the Announcement Editor screen (Figure 4-7).

13. Type We’re sorry, but we could not understand your response. Please 
try again.

ENTER

ENTER
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14. Click the Hand button.

The system displays the Menu screen (Figure 4-23).

15. Click the down arrow located next to the Timeout field.

16. Select Bad Input.

17. Click the More... button.

The system displays the Voice Response Parameters screen 
(Figure 4-24). 

18. Click the Hand button.

The system displays the Menu screen (Figure 4-23).

19. Click the Hand button.

The system displays the Errors/Warnings window (Figure 4-25) because 
we deliberately left the Too Few Digits field empty. Disregard the 
warning.

20. Click the OK button.

The system displays the Design Pad screen (Figure 4-30).
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Figure 4-30. Design Pad Screen

21. Do one of the following:

■ Select Save from the File Menu located on the Menu Bar.

■ Press  .

Add a Transfer Call Object to Choices: Branch 1

This branch is executed when the caller enters 1 after hearing the Choices 
announcement to indicate he or she wants to be transferred to the Parts 
Department. Perform the following procedure to add a Transfer Call object:

1. Click the Telephony object on the object palette.

The system displays a subpalette.

2. Select and drag the Transfer Call object (Figure 4-31) until it is directly 
over the branch labeled 1.

CTRL S
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Figure 4-31. Transfer Call Object

3. Release the mouse button.

The system displays the New Node dialog box (Figure 4-2).

4. Type Transfer To Parts Dept in the New Node dialog box.

5. Do one of the following:

■ Press .

■ Click the OK button.

The system displays the Design Pad screen (Figure 4-32).

Figure 4-32. Design Pad Screen

6. Select the TransferToPartsDept node.

The system displays a popup menu.

ENTER
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7. Select Edit Node.

The system displays the Transfer Call screen (Figure 4-33). 

Figure 4-33. Transfer Call Screen

8. Type 9085555603 in the Phone Number field.

9. Accept the default values for the following three fields, that is, do nothing.

■ The default for Message to Caller: is (none), meaning no 
message is played to the caller during the transfer attempt. 

■ The default for Transfer Type: is Blind, meaning the caller is 
transferred to the Parts Department without giving the Parts 
Department any information about the caller.

■ The default for Transfer Status: is (none), meaning the status 
result of the transfer attempt is not saved in a bucket for later use by 
the call flow.

10. Click the Hand button.

The system displays the Errors/Warning window (Figure 4-25). Disregard 
the warning.

11. Click the OK button.

The system displays the Design Pad screen (Figure 4-34).
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Figure 4-34. Design Pad Screen

12. Do one of the following:

■ Select Save from the File Menu located on the Menu Bar.

■ Press  .

Add a Halt Object to the Success Branch
under Choices: Branch 1

This branch is executed after a call has been successfully transferred to the 
parts department. We want to terminate the call flow with a Halt object. Since a 
Halt object has already been defined, we will connect to it with a Jump To Node. 
Perform the following procedure to add a Jump To Node: 

1. Select the Success branch under the TransferToPartsDept node. 

The system displays a popup menu.

2. Click Jump To Node.

The system displays the Nodes list box (Figure 4-19).

3. Select the Stop node.

4. Click the OK button.

The system displays the Design Pad screen (Figure 4-35).

CTRL S
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Figure 4-35. Design Pad Screen

5. Do one of the following:

■ Select Save from the File Menu located on the Menu Bar.

■ Press  .

Add an Announcement to the Fail Branch 
under Choices: Branch 1

This branch is executed after an unsuccessful transfer to the parts department. 
Perform the following procedure to add an Announcement object: 

1. Click the IVR object in the Object Palette.

The system displays a subpalette.

2. Select and drag the Announcement object (Figure 4-4) until it is directly 
over the Fail branch.

3. Release the mouse button.

The system displays the New Node dialog box (Figure 4-2).

4. Type Can’t Transfer in the New Node dialog box.

CTRL S
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5. Do one of the following:

■ Press .

■ Click the OK button.

The system displays the Design Pad screen (Figure 4-36).

Figure 4-36. Design Pad Screen

6. Click the CantTransfer node in the Design Pad screen.

The system displays a popup menu.

7. Select Edit Node.

The system displays the Announcement screen (Figure 4-6). 

8. Press .

The system displays the Announcement Editor screen (Figure 4-7).

9. Type We’re sorry, but we cannot transfer you to the department 
requested. Please try again at a later time.

10. Click the OK button.

The system displays the Announcement screen (Figure 4-6). 

ENTER

ENTER
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11. Click the Hand button.

The system displays the Design Pad screen (Figure 4-36).

12. Do one of the following:

■ Select Save from the File Menu located on the Menu Bar.

■ Press  .

Add a Halt Object to the Success Branch 
under CantTransfer

This branch executes after the caller hears the CantTransfer announcement. We 
want to terminate the call flow. However, since a Halt object has already been 
defined, we will connect to it with a Jump To Node. Perform the following 
procedure to add a Jump To Node: 

1. Select the Success branch under the CantTransfer node.

The system displays a popup menu.

2. Click Jump To Node.

The system displays the Nodes list box (Figure 4-19).

3. Select the Stop node.

4. Click the OK button.

The system displays the Design Pad screen (Figure 4-37).

CTRL S
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Figure 4-37. Design Pad Screen

5. Do one of the following:

■ Select Save from the File Menu located on the Menu Bar.

■ Press  .

Add a Transfer Call Object to Choices: Branch 2

This branch is executed when the caller enters 2 to indicate he or she wants to 
be transferred to the Service Department. Perform the following procedure to 
add a Transfer Call object:

1. Scroll through the Design Pad screen until the branch labeled 2 is visible.

2. Click the Telephony object on the Object Palette.

The system displays a subpalette.

3. Select and drag the Transfer Call object (Figure 4-31) until it is directly 
over the branch labeled 2.

4. Release the mouse button.

The system displays the New Node dialog box (Figure 4-2).

5. Type Transfer To Service Dept in the New Node dialog box.

CTRL S
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6. Do one of the following:

■ Press .

■ Click the OK button.

The system displays the Design Pad screen (Figure 4-38).

Figure 4-38. Design Pad Screen

7. Click the TransferToServiceDept node in the Design Pad screen.

The system displays a popup menu.

8. Select Edit Node.

The system displays the Transfer Call screen (Figure 4-33).

9. Type 9085555604 in the Phone Number field. 

10. Accept the default values for the following three fields, that is, do nothing:

■ The default for Message to Caller: is (none), meaning no 
message is played to the caller during the transfer attempt. 

■ The default for Transfer Type: is Blind, meaning the caller is 
transferred to the Service Department without giving the Service 
Department any information about the caller.

ENTER
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■ The default for Transfer Status: is (none), meaning the status 
result of the transfer attempt is not saved in a bucket for later use by 
the call flow.

11. Click the Hand button.

The system displays the Errors/Warnings window (Figure 4-25) because 
we left the Transfer Status and Message To Caller fields empty. 
Disregard the warning.

12. Click the OK button.

The system displays the Design Pad screen (Figure 4-38).

13. Do one of the following:

■ Select Save from the File Menu located on the Menu Bar.

■ Press  .

Add a Halt Object to the Success Branch
under Choices: Branch 2

This branch is executed after a successful transfer to the service department. We 
want to terminate the call flow with a Halt object. However, since a Halt object 
has already been defined, we will connect to it with a Jump To Node. Perform the 
following procedure to add a Jump To Node: 

1. Click the Success branch under the TransferToServiceDept node.

The system displays a popup menu.

2. Select Jump To Node.

The system displays the Nodes list box (Figure 4-19).

3. Select the Stop node.

4. Click the OK button.

The system displays the Design Pad screen (Figure 4-38).

5. Do one of the following:

■ Select Save from the File Menu located on the Menu Bar.

■ Press  .

Add an Announcement to the Fail Branch 
under Choices: Branch 2

This branch is executed after an unsuccessful transfer to the service department. 
We want to inform the caller that he or she cannot be transferred with an 
Announcement object. However, since an Announcement object has already 
been defined for this condition, we will connect to it with a Jump To Node. 

CTRL S
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Perform the following procedure to add a Jump To Node: 

1. Click the Fail branch under the TransferToServiceDept node in the Design 
Pad screen.

The system displays a popup menu.

2. Select Jump To Node.

The system displays the Nodes list box (Figure 4-19).

3. Select the CantTransfer node.

4. Click the OK button.

The system displays the Design Pad screen (Figure 4-39).

Figure 4-39. Design Pad Screen

5. Do one of the following:

■ Select Save from the File Menu located on the Menu Bar.

■ Press  .CTRL S
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Add a Transfer Call object to Choices: Branch 3

This branch is executed when the caller enters 3 in response to the Choices 
announcement to indicate he or she wants to be transferred to an operator. 
Perform the following procedure to add a Transfer Call object:

1. Click the Telephony object on the Object Palette.

The system displays a subpalette.

2. Select and drag the Transfer Call object (Figure 4-31) until it is directly 
over the branch labeled 3.

3. Release the mouse button.

The system displays the New Node dialog box (Figure 4-2).

4. Type Transfer To Operator in the New Node dialog box.

5. Do one of the following:

■ Press .

■ Click the OK button.

6. Select the TransferToOperator node in the Design Pad screen.

The system displays a popup menu.

7. Select Edit Node.

The system displays the Transfer Call screen (Figure 4-33).

8. Type 9085555605 in the Phone Number field. 

9. Accept the default values for the following three fields, that is, do nothing.

■ The default for Message to Caller: is (none), meaning no 
message is played to the caller during the transfer attempt.

■ The default for Transfer Type: is Blind, meaning the caller is 
transferred to the operator without any information about the caller.

■ The default for Transfer Status: is (none), meaning the status 
result of the transfer attempt is not saved in a bucket for later use by 
the call flow.

10. Click the Return button.

The system displays the Errors/Warnings window (Figure 4-25) because 
we left the Transfer Status and Message To Caller fields empty. 
Disregard the warning.

11. Click the OK button.

The system displays the Design Pad screen (Figure 4-40).

ENTER



Creating the Design

Issue  2.0   August 1997 4-41

Figure 4-40. Design Pad Screen

12. Do one of the following:

■ Select Save from the File Menu located on the Menu Bar.

■ Press  .

Add a Halt Object to the Success Branch 
under Choices: Branch 3

This branch is executed after the caller has been successfully transferred to an 
operator. We want to terminate the call flow with a Halt object. However, since a 
Halt object has already been defined, we will connect to it with a Jump To Node. 
Perform the following procedure to add a Jump To Node: 

1. Select the Success branch under the TransferToServiceDept node. 

The system displays a popup menu.

2. Click Jump To Node.

The system displays the Nodes list box (Figure 4-19).

3. Select the Stop node.

CTRL S
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4. Click the OK button.

The system displays the Design Pad screen (Figure 4-40).

5. Do one of the following:

■ Select Save from the File Menu located on the Menu Bar.

■ Press  .

Add an Announcement to the Fail Branch 
under Choices: Branch 3

This branch is executed after a failed transfer attempt. We need to create an 
announcement that informs the caller that he or she cannot be transferred and 
must call back at another time. However, since an Announcement object has 
already been defined for this condition, we will connect to it with a Jump To 
Node. Perform the following procedure to add a Jump To Node:

1. Select the Fail branch under the TransferToServiceDept node in the 
Design Pad screen.

The system displays a popup menu.

2. Click Jump To Node.

The system displays the Nodes list box (Figure 4-19).

3. Select the CantTransfer node.

4. Click the OK button.

The system displays the Design Pad screen (Figure 4-41).

CTRL S
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Figure 4-41. Design Pad Screen

5. Do one of the following:

■ Select Save from the File Menu located on the Menu Bar.

■ Press  .

Add a Halt Object to the Fail Branch 
under Choices

This branch is executed if the caller does not respond or enters a touchtone 
response other than 1, 2, or 3. The caller has three chances to enter a valid 
response. Since a Halt object has already been defined, we will use a Jump To 
Node to connect to it. Perform the following procedure to add a Jump To Node:

1. Select the Fail branch under the Choices node.

The system displays a popup menu.

2. Click Jump To Node.

The system displays the Nodes list box (Figure 4-19).

3. Select the Stop node.

CTRL S
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4. Click the OK button.

The system displays the Design Pad screen (Figure 4-42). 

Figure 4-42. Design Pad Screen

5. Do one of the following:

■ Select Save from the File Menu located on the Menu Bar.

■ Press  .CTRL S
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Add a Transfer Call Object to the Fail Branch
under TouchtoneOrRotary

This branch is executed when the caller does not respond to the Choices 
announcement indicating he or she has a rotary telephone, or simply wants to be 
transferred to an Operator. Since we have already defined a node called 
TransferToOperator, we will use a Jump To Node to connect to it. Perform the 
following procedure to add a Jump To Node:

1. Select the Fail branch under the TouchtoneOrRotary node.

The system displays a popup menu.

2. Click Jump To Node.

The system displays the Nodes list box (Figure 4-19).

3. Select the TransferToOperator node.

4. Click the OK button.

The system displays the Design Pad screen (Figure 4-43). The design for 
ABC Auto is now complete. 

5. Do one of the following:

■ Select Save from the File Menu located on the Menu Bar.

■ Press  .CTRL S
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Figure 4-43. Design Pad Screen
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Viewing More Nodes in the Design
Pad

Perform the following procedure to see more of your design:

1. Scroll to the top of the Design Pad screen.

2. Select Zoom Out from the View menu located on the Menu Bar.

The system displays a more compressed call flow for ABC Auto 
(Figure 4-44).

Figure 4-44. Design Pad Screen in Zoom Mode

3. Do one of the following:

■ Select Save from the File Menu located on the Menu Bar.

■ Press  .CTRL S
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5
Simulating a Design

Overview

The INTUITY™ CONVERSANT® Graphical Designer provides a simulation tool 
that lets you test your design on your personal computer without leaving the 
development environment. You can test the entire call flow or just the nodes you 
choose. 

Purpose

The purpose of this chapter is to show you how to use the INTUITY CONVERSANT 
Graphical Designer Simulation tool.



Simulating a Design

5-2 Issue  2.0   August 1997 

Showing the Tested Indicator

The Tested Indicator is a check mark that the INTUITY CONVERSANT Graphical 
Designer places on each node executed in simulation mode. To turn on the 
Tested Indicator:

1. Select Defaults Editor on the Go menu of the Design Pad screen.

The system displays the Defaults Editor screen (Figure 5-1).

Figure 5-1. Defaults Editor Screen

2. If it is not already checked, select the Show Tested Indicator box.

3. Click the OK button.

The system displays the Design Pad screen (Figure 5-2). 
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Figure 5-2. Design Pad Screen

4. Continue with the next section, "Running a Simulation".

Running a Simulation

To begin a simulation:

1. Do one of the following:

■ Select the Running Man button located on the upper left of the 
Toolbar on the Design Pad screen 

■ Select the Simulation Mode menu command located on the Go 
menu of the Design Pad screen.

The system displays the Simulation Design Pad screen (Figure 5-3).
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Figure 5-3. Simulation Design Pad Screen

2. Highlight the Answer Call node.

3. Click the Stop Light button on the Toolbar. 

The system displays a prompter window (Figure 5-4) containing the text of 
the Greeting Announcement.
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Figure 5-4. Prompter Window: Greeting Announcement

The system then simulates playing the announcement to a caller and 
displays another prompter window (Figure 5-5) containing the text of the 
TouchtoneOrRotary Announcement.
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Figure 5-5. Prompter Window: TouchtoneOrRotary Announcement

NOTE:
Do not enter a value of 1 on the touchtone pad. By not entering a 
touchtone, you simulate a call from a rotary telephone. Since no 
response was entered, the Transfer To Operator branch is executed. 

The system displays a dialog box (Figure 5-6) asking you what the result 
of the transfer to the operator should be.

Figure 5-6. Busy/No Answer/Error Dialog Box

4. Click the Busy button.

Because a transfer is attempted three times when the line is busy, this 
dialog box will appear two more times.
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5. Click the Busy button two more times.

The Fail branch of the TransferToOperator node is executed because the 
transfer cannot go through. The system displays a prompter window with 
the text of the CantTransfer Announcement (Figure 5-7).

The system then simulates playing the CantTransfer Announcement to 
caller and takes the Success branch under CantTransfer. This terminates 
the call and the application.

Figure 5-7. Prompter Window: CantTransfer Announcement

The call flow simulation is over. The system displays the Simulation Design 
Pad screen (Figure 5-8) with check marks showing which nodes 
executed.
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Figure 5-8. Simulation Design Pad screen: Tested Indicators On

To run the simulation again, complete "Running the Simulation Again" below. To 
test other parts of the call flow, highlight a node and select the Stop Light button 
on the Toolbar.
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Turning Off the Tested Indicator

To turn off the Tested Indicator:

1. Select Reset Nodes to Untested on the Edit menu of the Simulation 
screen. 

The Graphical Designer removes all the check marks in the call flow.

Running the Simulation Again

To test a different call scenario within your call flow:

1. Go to the top of the design.

2. Highlight the Answer Call node.

3. Select the Stop Light button on the Toolbar to begin simulating the design.

The system displays a prompter window (Figure 5-9) that contains the text 
of the Greeting Announcement.

Figure 5-9. Prompter Window: Greeting Announcement

The system then simulates playing the announcement to a caller and 
displays another prompter window containing the text of the 
TouchtoneOrRotary Announcement (Figure 5-10).
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Figure 5-10. Prompter Window: TouchtoneOrRotary Announcement

4. Enter 1

The system displays the Touchtone Pad (Figure 5-11).

Figure 5-11. Touchtone Pad

5. Enter 4. Use your mouse to select the 4 key of the Touchtone Pad. This is 
an invalid response. Only the touch-tone responses of 1, 2, or 3 are valid. 
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The system displays another prompter window (Figure 5-12) with the 
combined text of the BadInput Announcement and the Choices 
Announcement.

Figure 5-12. Prompter Window: BadInput and Choices Announcement

6. Enter 3. Use your mouse to click the 3 key of the touch-tone pad. 

The system displays a dialog box (Figure 5-13) where you can choose the 
result of the transfer.

Figure 5-13. Success/Failure Dialog Box

7. Click the Success button to simulate the successful completion of a 
transfer to the Operator.

The system displays the Simulation Design Pad screen (Figure 5-14). 
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Figure 5-14. Simulation Design Pad Screen
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6
Preparing and Installing 
an Application

Overview

The procedures in this chapter describe how to:

■ Generate an application for transfer to an INTUITY™ CONVERSANT® 
system

■ Transfer an application to the INTUITY CONVERSANT system

■ Install the application files onto an INTUITY CONVERSANT system

Purpose

This chapter provides the procedures you need to transfer Graphical Designer 
applications to an INTUITY CONVERSANT system.
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Generating an Application

The application generation package includes a code generator that prepares 
application components for transfer to an INTUITY CONVERSANT system.

To generate the application, perform the following procedure:

1. Do one of the following:

■ Select Generate Code from the File menu.

■ Click the Generate Code button on the Toolbar.

If you have not saved your design recently, a dialog box appears 
prompting you to save your design before the code can be generated.  

2. Click the Continue button.

The system saves your design and displays the Code Generation window 
(Figure 6-1). The check marks indicate which application files will be 
generated. 

NOTE:
Figure 6-1 is an example and may not always appear as shown.

Figure 6-1. Code Generation Window



Preparing and Installing an Application

Issue 2.0   August 1997 6-3

3. Select the INTUITY CONVERSANT files that you want to generate by 
selecting the corresponding buttons. A checkmark appears next to those 
files that you select. To unspecify a file, select the corresponding button 
again until the checkmark is removed.

NOTE:
If you select Phrase list file (*.pl), you are prompted to select a talkfile 
number. A talkfile number represents a specific talkfile, which is an 
ASCII file that contains the speech phrase tags and phrase tag 
numbers for all of the phrases of a specific application. The speech 
phrases are organized and stored in groups called talkfiles.

4. Click the Generate Code button at the bottom of the window.

As the code generator works, a message appears at the bottom of the 
window indicating the status of the code generation process. When 
finished, the system displays the following message:

Code generation is complete.

5. Exit from the Code Generation window by clicking the Hand button.

Transferring an Application

Transferring an application involves transferring all generated application 
components from your personal computer to an INTUITY CONVERSANT system. 

You can transfer an application using floppy disks or over a network.

Prior to transferring an application, you must first generate the application. See 
Chapter 6, "Generating an Application" above for more information.

NOTE:
If you plan to use the network transfer method, see "Optional Hardware" in 
Chapter 1, "Introduction and Hardware and Software Requirements", for 
information about optional equipment you need.

Transferring an Application with Floppy Disks

To transfer an application with floppy disks, perform the following procedure:

1. Double-click on the Lucent Technologies Application Transfer icon to 
activate the Application Transfer program. 

The Lucent Technologies Application Transfer icon appears in the Lucent 
Technologies Graphical Designer program group and the system displays 
the window shown in Figure 6-2.
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Figure 6-2. Floppy Disk Method for Application Transfer

2. Select Floppy as the Transfer Method.

NOTE:
The default transfer method is by floppy disk.

3. Select the application files that you want to transfer by clicking in the 
appropriate box. For example, Call Flow, Database, and/or Speech.

4. Select the application to be transferred from the Application field.

NOTE:
All application names appear in the Application field, regardless 
of whether or not all of the applications have been generated. If you 
try to transfer an application that has not been generated, the 
system displays the message shown in Figure 6-3.

Figure 6-3. Code Generation Not Performed Message
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5. Specify the appropriate destination directory in the Destination field.  
The Application Transfer program suggests the same directory name as 
the name of the application.

6. Specify the appropriate disk drive in the Drive field.

7. Select Prompt for Overwrite from the Options menu if you want the system   
to prompt you if files already exist. Select Prompt when Complete from the 
Options menu if you want the system to prompt you when the Application 
Transfer is complete.

8. Click the Application Transfer button in the upper right corner of the 
window or select Transfer from the File menu.

The application is transferred to the floppy disk on the specified drive. You 
can now use this floppy disk to install the application on an INTUITY 
CONVERSANT system as discussed below in "Installing an Application on 
an INTUITY CONVERSANT System".

NOTE:
Upon exiting the Application Transfer package, your last selections 
are saved and appear the next time you activate the Application 
Transfer package.

Transferring an Application over a Network

To transfer an application over a network, perform the following procedure:

1. Double-click on the Lucent Technologies Application Transfer icon to 
activate the Application Transfer program. 

The system displays a dialogue box (Figure 6-4).

Figure 6-4. Network Method for Application Transfer
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2. Select Network as the Transfer Method.

NOTE:
The default transfer method is by floppy disk.

3. Select the application files that you want to transfer by clicking in the 
appropriate box. For example, Call Flow, Database, and/or Speech.

4. Select the application to be transferred from the Application field. 

NOTE:
All application names appear in the Application field, regardless 
of whether or not all of the applications have been generated. If you 
try to transfer an application that has not been generated, the 
system displays the message shown in Figure 6-3.

5. Specify a destination.

The default directory for the destination of the application is 
/att/trans/graphd/<application name>, where <application name> is the 
same name as the application you specified in Step 4.

6. Enter the name of the host machine in the Host field.

7. Enter your INTUITY CONVERSANT system user name in the User field.

8. Enter your INTUITY CONVERSANT system password in the Password field.

9. Select Prompt for Overwrite from the Options menu if you want Graphical 
Designer to prompt you if files already exist.  Select Prompt when 
Complete from the Options menu if you want Graphical Designer to 
prompt you when the Application Transfer is complete.

10. Click the Application Transfer button in the upper right corner of the 
window or select Transfer from the File menu. The application is 
transferred to the specified destination.

If the application does not already exist on the INTUITY CONVERSANT 
system in the default path, or the alternate path you specified in Step 5, 
the Graphical Designer asks for permission to create the directory (Figure 
6-5).

Figure 6-5. Create Remote Directory Prompt during Application Transfer



Preparing and Installing an Application

Issue 2.0   August 1997 6-7

If the application exists on the INTUITY CONVERSANT system in the default 
path, or the alternate path you specified in Step 5, Graphical Designer 
asks for permission to overwrite the application (Figure 6-6).

Figure 6-6. Overwrite Prompt during Application Transfer

11. Click the Yes button if you want to continue the application transfer. Click 
the No button if you want to cancel the procedure and return to the 
Application Transfer window.

Upon exiting the Application Transfer package, your last selections are 
saved and automatically appear the next time you activate the Application 
Transfer package.
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Installing an Application on an
INTUITY CONVERSANT System

To install a Graphical Designer application file, perform the following procedure. 

NOTE:
If the application includes FlexWord® wordlists or professionally recorded 
speech, there will be some additional prompts. These prompts are 
explained in “Installing an Application with FlexWord Wordlists” and 
“Installing an Application with Professionally Recorded Speech” following 
this procedure.

Installing All Application Files

NOTE:
All applications are installed in the following default path: 
\att\trans\graphd\<application name>

1. Enter gd_install [-f] [-n] [-s] [-o <t|s|f|a|d|h>] [-l <language name>] [-dp] 
<application name> 

NOTE:
Application names are case sensitive.

The optional arguments are as follows:

-f Instructs the system that your files are on a floppy disk and 
prompts you to insert your floppy disk(s) so that the system can 
read the application files into the 
/att/trans/graphd/<application name> directory.

-l Instructs the system that you want to convert the specified 
application to a new language. The dates, times, money values 
and digits will be converted so they can be spoken in the new 
language formats, provided that standard speech in the 
language desired is loaded and selected as the standard 
speech for the application. This instruction also converts speech 
recognition input to the appropriate speech recognition 
grammar for the new language. For example, If US 1 to 3 was 
chosen in Graphical Designer and Japanese is selected during 
the gd_install process, the system converts US 1 to 3 to JN 1 to 
3.
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a. If database files exist, the system prompts you with the following 
question:

Update the Oracle database? [Y/N]

b. If you enter , the system asks you whether you want to overwrite 
tables that already exist in the ORACLE database:

Table ACCTINFO already exists.
Overwrite? [Y/N]

c. After all tables have been processed, the system asks you to restart 
the database dip. You must do this if the tables have changed.

The database dip needs to be restarted. THIS WILL 
AFFECT CALLS IN PROGRESS. If the database dip is 
not restarted then the changes will not be 
present. Restart the database dip? [Y/N]

-n Instructs the system to overwrite all existing application files that 
are used by the specified application. For example, if the 
database table acctinfo already exists in the ORACLE database 
and your specified application also uses a database table 
named acctinfo, the system replaces the table in the ORACLE 
database with the table used by your application.

-s Instructs the system that you want to use professionally 
recorded speech in the specified application. The system then 
ignores any .WAV files that you may have transferred. When 
using this option, you are prompted to insert the floppy disk(s) 
so that the system can read the speech files into the talkfile 
directory. The default talkfile directory for INTUITY CONVERSANT 
V6.0 systems upgraded from V5.0 without a reload of the 
operating system is /home2/vfs/talkfiles and 
/voice1/vfs/talkfiles for all other upgrades.

-dp Modifies all prompts that listen for speech recognition input, 
touch tones, or WholeWord to also listen for Dial Pulse 
Recognition.

-ot Instructs the system to overwrite all database tables with the 
same name.

-os Instructs the system to overwrite all speech files that have the 
same phrase tag number. 

-of Instructs the system to overwrite all FlexWord wordlists that have 
the same wordlist name. 

-oa Instructs the system to overwrite the entire 
/att/trans/graphd/<application name> directory. 

-od Instructs the system to overwrite the .d file which indicates a list 
of Call Data Events.

-oh Instructs the system to overwrite the .hs file.

Y
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d. The system then looks for any recorded speech that you 
transferred, unless you specify the -s argument. If you specify the 
-s argument, the system prompts you with the following message:

Place the speech floppy into the drive and press 
enter.

NOTE:
If your speech will be professionally recorded by Lucent 
Technologies, be sure to print out a phrase listing of your 
application and give it to the Lucent Technologies account 
executive. To do this from the Graphical Designer, select 
Print from the File menu and select the Phrase Listing 
option. If your speech is being recorded by someone other 
than Lucent Technologies, make sure that when you are 
creating the phrase listing on the INTUITY CONVERSANT 
system, you use the actual phrase numbers for the phrase tag 
names of each phrase you want recorded.

If you do not specify the -s argument and a particular talkfile 
number is already in use, the system prompts you with the following 
message:

Talkfile already exists.
Overwrite? [Y/N]

2. Press  if you want to overwrite the existing talkfile number with the 
talkfile number you specified with the Graphical Designer. If you press , 
you may need to go back to the Graphical Designer and assign a different 
talkfile number to the recorded phrases for the specified application.

! CAUTION:
The Graphical Designer does not automatically assign talkfile 
numbers to a particular phrase. Therefore you need to specify the 
talkfile numbers and be aware of those already in use as you could 
overwrite a talkfile that is being used by another application.

The system prompts you with the following message:

Do you want to use standard speech in addition to the 
application speech? (y/n)

3. Press  if you want to use standard speech.

The system shows you the current list of available speech pools and then 
prompts you with the following message:

Please enter the name of the standard phrase list.

Y

N

Y
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4. Enter a name of one of the available speech pool names. Make sure to 
enter the full name with the .pl extension.

The system prompts you with the following message:

Please enter the name of the custom phrase list.

5. Enter a name of one of the available speech pool names. Make sure to 
enter the full name with the .pl extension.

If your application uses a host interface and you have installed the 
application once before, the system prompts you with the following 
message:

.HS file already exists.
Overwrite? [Y/N]

If your application does not use a host interface or if you are installing your 
application for the first time, the system does not display this prompt.

6. Press  if you want to overwrite the .HS file. The .HS file includes host 
screen information.

The system prompts you with the following message:

.D file already exists.
Overwrite? [Y/N]

7. Press  if you want to overwrite the .D file. The .D file indicates a list of 
Call Data Events.

The system tells you that TAS is executing and eventually displays the 
following message:

TAS: Script application name.t compiled successfully.
Output file: /vs/trans/application name.T

Y

Y



Preparing and Installing an Application

6-12 Issue 2.0   August 1997  

Installing an Application with
FlexWord Wordlists

If you are using any FlexWord wordlists in your application, the system prompts 
you with additional questions during the installation process.

If a wordlist already exists, the system prompts you with the following:

The wordlist <wordlist name> already exists.
Overwrite? [Y/N]

If a wordlist does not already exist, the system prompts you with the following:

Is <wordlist name> a new wordlist? [Y/N]
Overwrite? [Y/N]

! CAUTION:
The Graphical Designer only allows you to include up to eight characters 
for the name of a wordlist. If you want to use a wordlist that already exists on 
the system with a longer name, you must respond to the above questions 
so that you can choose from the list that is displayed.

If you press , the new wordlist is added to the system. If you press , the 
system displays a list of active wordlists and prompts you to enter an active 
wordlist.

Installing an Application with
Professionally Recorded Speech

If you are using professionally recorded speech in your application, the system 
prompts you with additional questions during the installation process.

If professional speech for your application already exists on the system, the 
system prompts you with the following:

You already have professionally recorded speech.
Overwrite? [Y/N]

If you press , the system prompts you to insert the professional speech floppy 
disk into the disk drive and press . It then prompts you for each floppy disk 
until it reads all of them.

Y N

Y

ENTER
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A
Object Reference

Overview

This appendix describes the object set available in INTUITY™ CONVERSANT® 
Graphical Designer. The following is provided for each object reference:

■ A graphic representation of the object

■ A brief description

■ An explanation of the branches associated with an object when the object 
is added to a call flow

■ A detailed description of the behavior of the object when it is executed 
within a call flow

■ An example of how to use the objects in a call flow

Purpose

The purpose of this appendix is to provide reference information on the INTUITY 
COVERSANT Graphical Designer object set.
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Add Record Object

Function

Use Add Record object (Figure A-1) to add a record to a database table during 
design execution.

Figure A-1. Add Record Object

Behavior

■ One record is added to the database table named on the Add Record 
screen.

■ The database table fields are populated with the values of the buckets or 
literal values specified on the Add Record screen.

■ If a record is added to the database table, the Success branch is taken.

■ If a record cannot be added because the database table resource is not 
available, the Fail branch is taken.

Example

A customer places an order with ABC Automotive. Once the order information 
has been obtained from the caller, the corresponding order information can be 
added to a local database table by using an Add Record Object.
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Announcement Object

Function

Use the Announcement object (Figure A-2) to play a simple announcement.

Figure A-2. Announcement Object

Behavior

■ A simple announcement is played to the caller. No data is collected from 
the caller.

■ The Initial Prompt specified on the Announcement screen is played.

■ If you want to allow the caller to interrupt the Initial Prompt, select the Allow 
Caller to Interrupt Announcement box.

■ Select the Use Caller’s Previously Entered Touchtones box to process any 
touchtones that the caller has already entered.

Example

ABC Automotive has an inquiry line. All of the callers who reach the inquiry line 
will be greeted with the following announcement prompt:

“Thank You for calling the ABC Automotive inquiry line. “
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Asynchronous Events Object

Function

Use the Asychronous Events object (Figure A-3) to define the subroutine to be 
executed if an inbound call termination is detected.

Figure A-3. Asynchronous Events Object

Behavior

■ Specifies the subroutine that is executed when an Asynchronous Event is 
detected. 

NOTE:
The only Asynchronous Event currently supported is Inbound Call 
Termination.

■ The name of the subroutine to be executed is displayed in the Inbound 
Call Terminated field of the Asynchronous Events screen.

Asynchronous Event Handling

When the system detects an inbound call termination, the following sequence 
occurs:

1. Drops the call

2. Jumps to the defined subroutine

3. Executes the subroutine

4. Terminates application processing
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Code Cleanup Example

Code cleanup can be performed with an Asynchronous Event Object by:

1. Creating an External Function

2. Encapsulating the External Function

3. Selecting the subroutine to be executed in the event of an inbound call 
termination
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Automatic Menu Object

Function

Use the automatic Menu object (Figure A-4) to dynamically create a menu of 
choices derived from a list of previously retrieved database records.

Figure A-4. Automatic Menu Object

Behavior

■ The Initial Prompt specified on the Automatic Menu screen is played.

■ If you want to allow the caller to interrupt the Initial Prompt, select the Allow 
Caller to Interrupt Announcement box.

■ Select the Use Caller’s Previously Entered Touchtones box to process any 
touchtones that have already been entered by the caller.

■ The Initial Prompt specified on the Automatic Menu screen is composed of 
the following components: the Introduction, Body, More, and 
Conclusion fields.

■ The Introduction, Body and Conclusion fields are enabled by 
selecting the Use All Selected Records In The Prompt box on the 
Announcement Editor screen.

■ An Introduction prompt is played prior to the options generated for the 
automatic menu. 

■ Define a bucket to contain the Record Counter used for the iteration of the 
selected records.

■ A maximum of nine records can be presented to the caller at a time.

■ If the Max Records to Present field contains a value greater than nine 
or no value (all records), the More Records prompt will be played. You can 
specify the touchtone to enter to retrieve the next set of records.
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■ The Body prompt is played n times, where n is the number of records 
selected in the most recent table query. Each time the prompt is played, 
information from the next record is presented and the Record Counter is 
incremented. 

■ The Body prompt contains the options generated for the Automatic Menu.

■ When the value in the Record Counter bucket is equal to n and all of the 
options have been presented to the caller, the Conclusion prompt is 
played.

Invalid Responses

■ If the caller does not enter a valid response, the Bad Input prompt is 
played.

■ The Initial Prompt announcement is replayed if the Replay Initial 
Announcement on Retry option was selected. 

■ If the caller enters an invalid response and the number of available tries 
defined in the Number of Tries Available field has been exceeded, the Fail 
branch is executed.

■ If the caller does not respond on the last try, the Timeout branch will be 
taken if one has been defined. Otherwise, the Fail branch will be taken by 
default.

■ If the caller does not enter any digits within the time allotted in the First 
Digit Timeout field, the Timeout prompt is played. If multiple digits are 
being collected from the caller and the caller does not enter a subsequent 
digit within the time specified in the Inter-Digit Timeout field, the 
Timeout prompt is played.

■ The Initial Prompt announcement is replayed if the Replay Initial 
Announcement on Retry option was selected. 

■ If the length of the caller’s response is less than the value specified in the 
Minimum Length field, the Too Few Digits prompt is played. 

■ The Initial Prompt announcement is replayed if the Replay Initial 
Announcement on Retry option was selected. 

Saving the Caller’s Response

The caller’s valid response is saved in the bucket specified in the Save 
Response in field that is defined on the Voice Response Parameters dialog 
box.
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Inserting Branches

You can insert a branch before the previously selected branch in an Automatic 
Menu Object using the Touchtones dialog box.

To go to the Touchtones dialog box:

1. Select a branch to reveal a Popup menu.

2. Select the Insert Branch menu command.

Example

The caller can request to hear a list of this week’s sale items. Since the items that 
are on sale change weekly, the information can be stored in a database table. 
Items in the database table can be marked as sale items and the sale price of the 
item can be updated. Only the data in the database table needs to be updated. 
The call flow information will not have to change. 

“The following items are on sale during the week of December 12, 1997. For 
information regarding 

Super Charger Batteries, press 1
Grason Spark Plugs, press 2
Generex Oil, press 3
APEX Windshield Wiper Fluid, press 4

Please make your selection now.”
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Call Answer Object

Function

Use the Call Answer object (Figure A-5) to answer an incoming call. 

This object should be one of the first objects added to an application. The design 
will work in simulation mode without a Call Answer Object. However, when the 
application is downloaded to a host in the network, no incoming calls will be 
answered without the code that is generated from the Call Answer Object.

Figure A-5. Call Answer Object

Behavior

■ The incoming call is answered and the next node in the call flow is 
executed.
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Call Disconnect Object

Function

Use the Call Disconnect object (Figure A-6) to disconnect the inbound call and 
execute the next node in the call flow.

Figure A-6. Call Disconnect Object

Behavior

■ The call is disconnected and the next node in the call flow is executed.

NOTE:
Once the application has run, it is important to disconnect the call 
quickly to cut down on the cost of the call.

■ This object allows the call flow to be terminated at specific user-defined 
points.

■ An application is not required to have a Call Disconnect Object to 
successfully terminate the dialog with the caller.
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Delete Record Object

Function

Use the Delete Record object (Figure A-7) to delete record(s) from a database 
table during application execution.

Figure A-7. Delete Record Object

Behavior

■ Records are selected from the database table based upon the selection 
criteria. 

■ Both the database table and the selection criteria are specified on the 
Delete Record screen.

■ If no selection criteria are specified, all records in the database table are 
selected.

■ If one or more records are deleted from the database table, the Success 
branch is taken. If multiple records were found and the Delete Multiple 
Records If Found option was not checked, the object is still exited on the 
Success branch.

■ If the database table was not accessible, the Delete Record Object is 
exited on the Fail branch.

Deleting One Record

■ Delete the first record that matches the selection criteria.

■ If one record is selected during design execution, that particular record is 
deleted from the database table.



Object Reference

A-12 Issue  2.0   August 1997 

Deleting Multiple Records

■ Delete all records that match the selection criteria.

■ If more than one record is found and the Delete Multiple Records If Found 
option was selected on the Delete Record Object editor screen, all the 
records that meet the criteria will be deleted.

■ If the Delete Multiple Records If Found option was not selected, and 
multiple records were found, no records will be deleted.

Example

A customer wants to cancel an existing order. Once the order information has 
been obtained from the caller, the corresponding order information will be used 
as selection criteria. If a match is found, the order can be deleted from the local 
database table.
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Encapsulation Object

Function

Use the Encapsulation object (Figure A-8) to remove the appearance of a portion 
of a call flow by collapsing the node.

You can then reuse or copy the encapsulated node anywhere in the design. This 
object is useful when you want to perform the same operation in more than one 
place in the application.

You can also encapsulate a large call flow within a design. By encapsulating a 
node, several nodes can be collapsed into one node until you want to expand it.

Collapsing nodes also improves the readability of large designs.

Branches can be inserted to control the execution path taken when returning 
from the subroutine.

Figure A-8. Encapsulation Object

Behavior

■ The call flow contained in the encapsulated node is executed. 

■ All branches from nodes contained in the encapsulated node return to the 
Default branch unless additional branches are inserted. If a branch is 
added to the encapsulated node, it will appear as a Halt node in the 
subtree.

For example, the subtree for the encapsulated node Get Account Balance 
will contain two Halt nodes labeled Main Menu and End of Call.

■ Any branch of the subtree that does not return to a specified branch within 
its parent call flow will return to the Default branch.
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■ Insert named branches before the Default branch to provide a conditional 
return branch. This generates the corresponding named exits in the 
editable subtree.

■ Select the encapsulated node to edit the subtree. Select the Edit Node 
option from the Popup menu to reveal the subtree contained in the 
encapsulated node.

See "Copying or Reusing an Encapsulated Node" in Chapter 3, "Procedures", for 
more information.
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External Function Object

Function

Use the External Function object (Figure A-9) to call an external function to obtain 
information or perform a function outside the INTUITY CONVERSANT Graphical 
Designer.

Figure A-9. External Function Object

Behavior

■ You can create a new External Function or choose one of the existing 
system External Functions.

■ If you want to use a new External Function in your application, the External 
Function needs to be defined on the External Function Definition Editor 
screen before using this object in a call flow.

■ The External Function is called using the values specified on the External 
Function screen. 

■ The return code and any values that are returned by the function are 
placed in the specified buckets.

■ The success or failure of the External Function call is determined by 
interrogating the value found in the bucket specified in the Put Return 
Code In field on the External Function screen.

Example

A branch library has an inquiry line where a caller can find out if the books on the 
top ten best sellers list are available. If the book has been checked out, the caller 
has the option of trying the main library to see if the book is available at that 
location. An External Function Object can be used to send the requested 
information and to receive confirmation if the book is available.
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Halt Object

Function

Use the Halt object (Figure A-10) to halt the execution of a call flow.

Figure A-10. Halt Object

Behavior

■ Execution of the call flow is stopped. No other branches will be executed.

■ If a custom event record was defined using the Events Editor screen, the 
record will be written when this node is executed.
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Host Connectivity Object 

Function

Use the Host Connectivity object (Figure A-11) to obtain the status of the 
connection between a host machine in the network and an application.

Figure A-11. Host Connectivity Object

Behavior

■ The connection between a host machine and an application is verified. 
This object is typically one of the first objects in a design using host. This 
object should be placed before the Call Answer Object because Host 
connectivity should be checked before accepting incoming calls. 
Otherwise, the caller can be subjected to a period of silence (up to 5 
seconds) while the connection is being checked. 

■ The connection must be established within the time allotted in the 
Connection Timeout field on the Host Connect screen.

■ If the connection has been established, the Success branch is executed. 
If the connection cannot be established within the specified time frame, 
the Fail branch is executed.

■ The Host must be defined on the Host Definition Editor screen before 
using this object in a call flow.

■ When a connection with the host has been established, a Logical Unit is 
assigned to the application. The Logical Unit remains assigned to the 
application until it is released or the call is terminated. 

■ If the Host Connectivity Object is not part of a call flow, the first time any of 
the other host objects are encountered in the application, a Logical Unit 
will be assigned, if available.

■ If a Logical Unit is not available, the Fail branch will be executed.
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Editing

Edit the Host Connectivity Object to specify:

■ Which host to connect to

■ How much time to wait for a host connection

NOTE:
Hosts are not available until they are named using the Host Definition 
Editor.

Example

Your application downloads order information to a host. Before you send order 
information to the host, you need to verify that the host is connected. If the host is 
not connected, it may take several seconds to establish a connection. 
Meanwhile, the caller is on the line waiting to find out the status of his or her 
order. Therefore, the host connection is verified before the Call Answer Object is 
added to the call flow.
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Host Send Data Object

Function

Use the Host Send Data object (Figure A-12) to identify the data to be sent to a 
host machine in the network.

Figure A-12. Host Send Data Object

Behavior

■ The Host must be defined on the Host Definition Editor screen before 
using this object in a call flow.

■ The screen names for the data that is sent to a host machine are identified 
on the Host Send screen. 

■ The transmission of data to the host is considered a blind send because 
the application does not know whether or not the host received the data. 
The host machine does not confirm the transmission.

■ Once the screen data is transmitted to the host, the Send Data Object is 
exited on the Default branch.

Editing

Edit the Host Connectivity Object to specify:

■ Which host to connect to

■ Whether to release the logical unit

■ Which send screens to use

NOTE:
Send screens are not available until they are named using the Screen 
Identification Editor.
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Example

Your application downloads customer account information to a host. Before you 
send account information to the host, a login sequence must be established for 
security purposes. The Host Send Data Object can be used to send the 
necessary login and password information.
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Host Send/Receive Data Object

Function

Use the Host Send/Receive Data object (Figure A-13) to identify the data to be 
sent to and received from a host machine in the network.

Figure A-13. Host Send/Receive Data Object

Behavior

■ The Host must be defined on the Host Definition Editor screen before 
using this object in a call flow.

■ The screens for a particular host are defined on the Screen Identification 
Editor screen.

■ The contents of each screen will be defined on the Field Definition Editor 
screen.

■ The Host Send/Receive Data Object is exited on the Timeout branch if the 
receive screen data from the host machine is not received in the specified 
amount of time. 

■ The Host Send/Receive Data Object is exited on the Fail branch if

— The Receive screen data sent from the host does not have the 
correct screen name, or 

— The Receive screen data, sent from the host, does not match the 
format defined on the Host Send/Receive screen; and the correct 
format was not sent within the time allotted in the Unrecognized 
Screen Timeout field on the Host Definition Editor screen.

A branch must be defined for each Receive screen to be received 
from this host.
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Inserting Branches

1. Exit the Host Send/Receive screen by clicking on the Return button.

2. Select the Host/Send Receive node in the call flow. 

The system displays the popup menu.

3. Select the Insert Branch menu command from the popup menu.

The system displays the Choose a Screen dialog box. All of the Receive 
screens defined for the host will be listed there.

4. Select a Receive screen name. 

The system displays the Design Pad screen.

5. Select the Host Send/Receive node. 

The system displays a popup menu.

6. Select the Edit Node menu command. 

The system displays the Host Send Receive screen. 

The Receive screens for which you have inserted branches will now 
appear in the Receive Screen Names field.

Editing

Edit the Host Send/Receive Object to specify:

■ Which host to connect to

■ Which aid key to use

■ Which send screens to use

■ Which receive screens to use

NOTE:
Send and receive screens are not available until they are named using the 
Screen Identification Editor.

Example

Your application downloads customer account information to a host to obtain the 
caller’s current account balance. This object is used to send the caller’s account 
information to the host and to obtain the account balance from the host.
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Menu Object

Function

Use the Menu object (Figure A-14) to present a list of options from which the 
caller can choose.

Figure A-14. Menu Object

Behavior

■ The Initial Prompt announcement specified on the Menu screen is played. 

■ If you want to allow the caller to interrupt the Initial Prompt before it is 
played in its entirety, select the Allow Caller to Interrupt Announcement 
box.

■ Select the Use Caller’s Previously Entered Touchtones box to process any 
touchtones that have already been entered by the caller.
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Valid Responses 

■ Any response whose length is within the range of minimum and maximum 
lengths specified on the Voice Response Parameters dialog box

■ Any response that matches a defined event, including:

— Any combination of a digit, the star (*), or pound key (#).

— Any spoken response matching the grammars/wordlists defined for 
the Initial Prompt response if Automatic Speech Recognition (ASR) 
is selected. 

The maximum length for the response, specified in the Maximum Length 
field on the Voice Response Parameters dialog box, should not include 
the length of the terminate digit(s).

If terminate digits are specified on the Voice Response Parameters dialog 
box, the last touchtone(s) of the response must also match the terminate 
digit(s).

Invalid Responses

■ If a caller fails to enter a valid response, the Bad Input prompt is played.

■ If the Replay Initial Announcement on Retry option was selected, the Initial 
Prompt announcement is replayed.

■ If the caller does not enter a valid response and has exceeded the 
number of tries defined in the Number of Tries Available field, the 
Fail branch is executed.

■ If the caller does not respond on the last try, the Timeout branch will be 
taken if one has been defined. Otherwise, the Fail branch will be taken by 
default.

■ If the caller does not enter any digits within the time allotted in the First 
Digit Timeout field, the Timeout prompt is played. If multiple digits are 
being collected from the caller and the caller does not enter a subsequent 
digit within the time specified in the Inter-Digit Timeout field, the Timeout 
prompt is played.

■ If the Replay Initial Announcement on Retry option was selected, the Initial 
Prompt announcement is replayed.

■ If the length of the caller’s response is less than the value specified in the 
Minimum Length field, the Too Few Digits prompt is played. 

■ If the Replay Initial Announcement on Retry option was selected, the Initial 
Prompt announcement is replayed.

Saving the Caller’s Response

The caller’s valid response is saved in the bucket specified in the Save 
Response in field that is defined on the Voice Response Parameters dialog 
box.
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Inserting Branches

You can insert a branch before the previously selected branch in a Menu Object 
using the Touchtones dialog box.

To go to the Touchtones dialog box:

1. Select a branch to reveal a Popup menu.

2. Select the Insert Branch menu command.

Example

The ABC Automotive Inquiry Line gives the caller a menu of options to choose 
from.

“For the Service Department, press 1.
For the Parts Department, press 2.
To find out the status of an order, press 3.
To be added to our mailing list, press 4.”

Valid responses from the caller are a touchtone of 1, 2, 3 or 4.
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Prompt and Collect Object

Function

Use Prompt and Collect object (Figure A-15) to prompt the caller for data and 
then save the data for later use.

Figure A-15. Prompt and Collect Object

Behavior

■ The Initial Prompt announcement specified on the Prompt and Collect 
screen is played. The caller’s response is collected for future use and can 
be validated against a bucket, set, or table value.

■ To allow the caller to interrupt the Initial Prompt, select the Allow Caller to 
Interrupt Announcement box.

■ To process input already entered by the caller, select the Use Caller’s 
Previously Entered Touchtones box.

Valid Responses 

■ Any response with a length that is within the range of minimum and 
maximum lengths specified on the Voice Response Parameters dialog 
box.

■ Any response that can be validated against a specified bucket, set, or 
table value if Response Validation is chosen.

■ Any spoken response matching the grammars defined for the Initial 
Prompt response if ASR is selected.

The maximum length for the response, specified in the Maximum Length 
field on the Voice Response Parameters dialog box, should not include 
the length of the terminate touchtone(s).

If terminate digits are specified on the Voice Response Parameters dialog 
box, the last touchtone(s) of the response must also match the terminate 
digit(s).
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Invalid Responses

■ If the caller does not enter a valid response, the Bad Input prompt is 
played.

■ If the Replay Initial Announcement on Retry option was selected, the Initial 
Prompt announcement is replayed.

■ If the caller does not enter a valid response and has exceeded the 
number of tries defined in the Number of Tries Available field, the 
Fail branch is executed.

■ If the caller does not respond on the last try, the Timeout branch is taken if 
one is defined. Otherwise, the Fail branch is taken by default.

■ If the caller does not enter any digits within the time allotted in the First 
Digit Timeout field, the Timeout prompt is played. If multiple digits are 
being collected from the caller and the caller does not enter a subsequent 
digit within the time specified in the Inter-Digit Timeout field, the 
Timeout prompt is played.

■ If the Replay Initial Announcement on Retry option was selected, the Initial 
Prompt announcement is replayed.

■ If the length of the caller’s response is less than the value specified in the 
Minimum Length field, the Too Few Digits prompt is played. 

■ If the Replay Initial Announcement on Retry option was selected, the Initial 
Prompt announcement is replayed.

Saving the Caller’s Response

The caller’s valid response is saved in the bucket specified in the Save 
Response in field that is defined on the Voice Response Parameters dialog 
box.

■ If the digits entered by the caller cannot be formatted to the class of the 
bucket specified in the Save formatted response in field, the 
bucket is populated with the null value.

■ If you select the Use Caller's Input to Select an Active Record box, the 
caller's input will be used as the selection criteria for the next database 
table query.

Confirming the Caller’s Response

■ If the Confirm Input options are selected, once the caller enters a valid 
response, the Confirm prompt is played. 

■ If ASR (Automatic Speech Recognition) has been selected, the caller can 
confirm his or her response by entering a touchtone or by speaking a 
response.

■ If the caller confirms his or her response and the Validate Response 
Options are not selected, the object is exited on the Success branch.
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■ If the caller indicates that his or her response is incorrect and the value in 
the Number of Tries Available field is greater than zero, the caller 
will be given another chance to respond.

■ If the Replay Initial Announcement on Retry box is selected, the Initial 
Prompt announcement is played.

■ If the caller does not respond with the valid Yes Digit, the caller will be 
given another chance if they have not exceeded the maximum number of 
tries.

■ If the Replay Initial Announcement on Retry box is selected, the Initial 
Prompt announcement is played.

Validating the Caller’s Response

The caller’s response can be validated against one of the following entities:

■ Bucket: the response is valid if it meets the relation specified in the Bucket 
section of the Response Validation dialog box.

■ Set: the response is valid if it is included in the list of values (which can 
include a range of values) specified in the Set section of the Response 
Validation dialog box.

■ Table: the response is valid if it matches the value of a specific field in the 
database table specified in the Table section of the Response Validation 
dialog box.

If the caller’s response cannot be validated, the Bad Input prompt is played as 
long as the caller has not exceeded the maximum number of tries. Otherwise, the 
Fail branch will be executed.

Inserting Branches

You can insert a branch before the previously selected branch in an Automatic 
Menu Object using the Touchtones dialog box.

To go to the Touchtones dialog box:

1. Select a branch to reveal a Popup menu.

2. Select the Insert Branch menu command.
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Example

A caller who wants to check the status of an order, will need to enter an 8-digit 
order number. The caller is prompted for the order number and is told where to 
locate the order number on the order form. The caller will then enter the order 
number via touchtones.

The order number collected from the caller will later be used to check on the 
status of the order.

“Please enter your eight-digit order number. 

The order number is located in the upper left hand side of the order form 
underneath your name and address.”
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Query Table Object

Function

Use the Query Table object (Figure A-16) to retrieve records from a database 
table based upon specific selection criteria.

Figure A-16. Query Table Object

Behavior

■ Records are selected from the database table based upon the defined 
selection criteria. 

■ The database table and the selection criteria are specified on the Query 
Table screen. 

■ When selection criteria are not specified, all the records in the database 
table are retrieved.

■ The field values from the first record found that matches the selection 
criteria are placed in defined buckets. These buckets must be specified in 
the Field to Bucket Assignments field on the Query Table screen. 
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■ The branches of the Query Table Object will be executed if the following 
conditions are true:

1. Zero (0) Branch: executed if no records matching the selection 
criteria are found.

2. One (1) Branch: executed if only one record matching the selection 
criteria is found.

3. n Branch: executed if multiple records matching the selection 
criteria are found.

4. Fail Branch: executed if the specified database table could not be 
accessed.

■ If multiple records matching the selection criteria are found, the values 
from the first record found will be returned, unless the Randomize Query 
Results box is checked. If this box is checked, a record will be randomly 
selected from the records found. 

■ The remaining records can be accessed by using the Next Record 
function of the Set Object, or by using the Automatic Menu Object to 
speak all the selected records back to the caller.

Example

A customer wants to find out the status of an order. The order information is 
obtained from the customer and used as selection criteria to retrieve the order 
status from a local database table.
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Set Object

Function

Use the Set object (Figure A-17) to set buckets to expressions and to branch 
based on specific values.

Figure A-17. Set Object

Behavior

■ Data Assignments and Comparisons are defined on the Set screen.

■ Each expression defined in the Data Assignment field is evaluated and 
the result is placed into the specified bucket.

■ Each logical expression defined in the Data Comparisons field is 
evaluated, and the branch corresponding to the first true logical 
expression is executed.

■ If no logical expression turns out to be true, the Default branch is 
executed.

■ Additional branches can be inserted where you can define events to 
specify conditional branches.

Example

A small regional magazine wants to perform a readership survey. The survey 
consists of six questions. The magazine wants to track how many participants 
were involved in the survey. The caller must respond to at least four questions to 
be considered a participant. 

The Set Object can be used to set the value of a bucket to the number 4. Each 
time the caller responds to a question, the bucket can be decremented. At the 
end of the survey, if the bucket value is 0, -1 or -2, the caller can be added to the 
number of participants of the survey. 
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Timebranch Object

Function

Use the Timebranch object (Figure A-18) to branch based on time of day, day of 
the week, or a specific date.

Figure A-18. Timebranch Object

Behavior

■ The branch that matches the actual time of day, day of the week, or 
specified date is taken.

■ If there are multiple branches that match the defined events, the first 
matching branch is taken.

■ Select the branch labeled Other to create branches with these event 
types. Choose the Insert Branch command from the Popup menu. The 
Timebranch Events dialog box, where you can define the type of 
timebranch needed in the call flow, will appear.

Example

You want to transfer callers to an agent during normal business hours only. If the 
caller calls at any time outside of these hours, an announcement will be played 
asking the caller to call back during normal business hours.

■ Day of Week Timebranch - determines if the caller is calling on a day when 
the business is open.

■ Time of Day Timebranch - determines if the caller is calling at a time when 
the business is open.

■ Time of Day Timebranch - determines if the caller is calling at a time when 
the business is open
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Transfer Call Object

Function

Use the Transfer Call object (Figure A-19) to transfer a call to an agent.

Figure A-19. Transfer Call Object

Behavior

■ The Phone Number field is the telephone number of the agent to whom 
the call is transferred. There is no default value for this field.

■ The Message To Caller field indicates whether an announcement will 
be played to the caller while they are on hold, waiting for transfer. The 
default value is none, meaning no message is played to caller.

■ The Transfer Status field indicates whether the status result is 
returned to the application and which bucket, if any, is used to store the 
result. The default is none, meaning no status result is returned to the 
application.

■ The Transfer Type field indicates whether the transfer protocol is Blind, 
Intelligent, or Full CCA. The default is Blind, meaning no information about 
the caller is provided to the agent. The remaining fields on the Transfer 
Call screen pertain to Intelligent and Full CCA transfers (Table A-1).
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Table A-1. Intelligent and Full CCA Transfer Options 

Field Description Default Value

Maximum 
Rings

Indicates how many rings to wait 
for before treating the transfer 
attempt as a failure and doing 
failure processing. 

The default is 7, which 
means to wait for 7 
rings before doing 
failure processing.

On Answer, 
Play Message 

Indicates whether a message is 
played to the agent. If the On 
Answer, Play Message field 
is checked, the Answer 
Message field indicates which 
message is played. 

On Answer, Play 
Message field is not 
checked, which 
means no message is 
played to the agent 
during transfer.

Allow Answer 
Message 
Interrupt

Indicates whether the agent can 
interrupt the Answer Message 
when they answer the call. The 
Answer Connection field tells 
the application whether to 
consider the transfer complete 
when the agent answers or 
whether the call is still on hold. 

Allow Answer 
Message Interrupt 
field is checked and 
Answer Connection 
field is Complete, 
which means to 
interrupt the Answer 
Message when the 
agent answers and 
consider the transfer 
complete. 

On Failure, 
Play Message

Indicates whether to play a 
message to the caller when a 
transfer attempt fails. 

This field is not 
checked, which 
means do not play a 
message to the caller.

Busy 
Connection

Indicates whether to reconnect 
the caller to another agent or put 
the caller on hold when a busy 
signal is detected during a 
transfer attempt.

Reconnect

No Answer 
Connection

Indicates whether to reconnect 
the caller to another agent or put 
the caller on Hold when the first 
agent does not answer.

Reconnect

Error 
Connection

Indicates whether to reconnect 
the caller to another agent or put 
the caller on hold when an error 
is detected during a transfer 
attempt. 

Reconnect

Continued on next page
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Transfer Call Node Execution

■ If the transfer is completed successfully, the Success branch of the 
Transfer Call node will be taken.

■ If the transfer is not completed within the time specified in the Outdial 
Timeout field, the Fail branch of the Transfer Call node will be taken.

Example

The ABC Automotive inquiry line has a menu giving the caller the option to 
transfer to the parts department or the service department. A Transfer Call 
Object is needed for each transfer.
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Update Table Object

Function

Use the Update Table object (Figure A-20) to change data within a specified 
database table.

Figure A-20. Update Table Object

Behavior

■ Records are selected from the database table based upon the selection 
criteria. 

■ Both the database table and the selection criteria are specified on the 
Update Table screen. 

■ If no selection criteria are specified, all records will be selected from the 
specified database table.

■ If one or more records in the database table are updated, the Success 
branch is taken. 

■ If the database table is not available, the Fail branch is executed. 

Updating One Record

■ If you want to update one record in the table, do not select the Update 
Multiple Records if Found box.

■ If one record matching the selection criteria is found, the record will be 
updated.
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Updating Multiple Records 

■ If more than one record matching the selection criteria is found and the 
Update Multiple Records If Found option was selected on the Update 
Table screen, all the selected records will be updated accordingly.

■ If the Update Multiple Records If Found option was not selected and 
multiple records were found, no records will be updated.

Example

A customer wants to change the quantity of a particular item he or she ordered. 
The order information is obtained from the caller and used as selection criteria to 
locate the order information. If a match is found, the quantity field can be 
updated in the local database table.
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Voice Capture Object

Function

Use the Voice Capture object (Figure A-21) to record a caller’s spoken response. 
Specifically, use this object to obtain data from callers with rotary telephones and 
to gather information that cannot be entered with touchtones.

Figure A-21. Voice Capture Object

Behavior

■ The Initial Prompt announcement specified on the Voice Capture screen is 
played to the caller.

■ If the Play Beep Before Recording option is selected, a beep will be 
played after the Initial Prompt to signal the caller to begin recording his or 
her response.

■ You can specify the maximum length for the recording in the Recording 
Options Max. Length field. 

■ You can specify the rate at which the caller’s response will be recorded in 
the Rate field.

■ You can specify the number of times that the caller can attempt to record 
a response in the Number of Tries Available field.

■ Each time a caller tries to record a response, the value of the bucket 
specified in the Number of Tries Taken field is incremented by one.

■ If the caller does not speak a response within the time allotted in the 
Initial Timeout field, and the Recording Options Tries field is 
populated with a value greater than one, the Initial Prompt is replayed.

■ If the caller does not speak a response and has exceeded the number of 
tries, the Fail branch is executed.
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Defining the Recording Parameters

■ The caller is expected to respond before the time indicated in the 
Initial field.

■ You can specify how the end of a recording is to be detected by selecting 
a value in the Terminate On field.

— Maximum Duration: Use the time specified in the Max Duration 
field to detect a no response condition. 

If the caller does not respond within the time (in seconds) allotted 
for the maximum recording length, it is assumed that the caller is 
not going to respond.

— Silence Detection: Use the time specified in the Silence field to 
indicate that the caller has completed his or her recording.

Enter the amount of silence (in seconds) to signal the end of a 
recording. This field is enabled when the Silence option is selected 
in the Terminate On field.

— Touchtone Detection: Any touchtone entered by the caller can be 
used to signal the end of his or her response.

Confirming the Caller’s Response

■ The caller can be asked to confirm his or her spoken response. The 
Confirm Recording prompt is played and the user confirms his or her 
recorded response by entering a touchtone or speaking a response that 
matches a specified grammar.

■ If the caller responds with the specified yes digit, the caller’s response is 
saved in the bucket specified in the Save In Bucket field.

■ If the caller responds with the specified no digit and the caller has not 
exceeded the number of tries allotted in the Tries field, the Initial Prompt 
is replayed and the caller can try again.

■ If the caller responds with a touchtone other than the specified yes or no 
digit, the Confirm Error prompt is played. The Initial Prompt is replayed if 
the user has not exceeded the maximum number of tries. 

■ If, on the last try the caller does not enter a valid yes or no digit or has 
exceeded the number of tries, the Fail branch is executed.

Saving the Caller’s Response

■ The caller’s response is saved in the bucket specified in the Save In 
Bucket field.

■ To save the caller’s response even if he or she hangs up, select the Save 
On Hangup box.

■ To append a text description to the recording, specify the value or bucket 
in the Attach Tag field.
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■ Specify the service to be used to transcribe the recorded responses in the 
Service Name field.

■ You can concatenate several recorded responses into one Transcription 
Phrase List (TPL) for the transcription service.

For example, the caller can record his or her name and telephone number 
in one Voice Capture node.

The caller can record his or her address in the second Voice Capture 
node.

■ These two recordings can be concatenated into one TPL by deselecting 
the End Current TPL With This Phrase box in the first Voice Capture node 
and selecting the box in the second Voice Capture node.

Example

A caller’s name and address cannot be obtained using touchtones. In this 
example, the caller speaks his or her name and address. This information is 
saved and the caller is added to the company’s customer mailing list.

“If you would like to be on our mailing list, please speak your name, street 
address, city, state, and zip code.

Begin recording at the sound of the tone.”
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B
Screen Reference

Overview

This appendix describes all the screens that are used in the INTUITY™ 
CONVERSANT® Graphical Designer. The following is provided for each screen: 

■ A brief description of the function

■ A screen layout

■ Descriptions of the toolbar components

■ Descriptions of the buttons

■ Detailed descriptions of each field on the screen

Purpose

The purpose of this appendix is to provide reference information on the INTUITY 
CONVERSANT Graphical Designer screens.
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Add Record Screen

Use this screen to add a record to a database table during application 
execution. 

Layout

The Graphical Designer displays this screen (Figure B-1) when you edit an Add 
Record node in a call flow.

Figure B-1. Add Record Screen

Toolbar

Return 

Returns to the previous screen.

Bucket Editor

Displays the Bucket Editor screen.
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Table Editor 
Displays the Table Editor screen.

Fields

Table to Add Record

This field contains the name of the table to which a record will be added during 
application execution.

1. Click the down arrow to choose from a list of existing tables.

2. Click on a table name to select it. 

The Graphical Designer displays the table name you selected in the 
Table to Add Record field.

The table name does not appear in the combo box if you have not yet defined the 
schema within the application. To add a record to a table that is not among the 
tables in the combo box, click on the Table Editor Toolbar button to define a new 
table to this application. 

Assignments to New Record

This field lists the fields in the table and the buckets or literals to be assigned to 
each table field.

1. Click on a line in the Record field list to select a table field. 

The Graphical Designer displays the name of the selected field as 
shaded.

2. Define a bucket to assign a value to the field or type in a literal value.

You can select an existing bucket or create a new bucket.

Select a bucket from the combo box:

1. Click on the down arrow to choose from a list of existing buckets that have 
been defined as the same class as the Table field. 

2. Click on a bucket name to select it.



Screen Reference

B-4 Issue  2.0   August 1997 

Create a new bucket: 

1. Enter the name of a new bucket in the Bucket field. 

NOTE:
You must type a left bracket ([) before the bucket name to indicate 
that this is a new bucket. 

The Graphical Designer defines a bucket with the same characteristics as 
the associated table field.
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Announcement Screen

Use this screen to define an announcement to be played to the caller. 

Layout

The Graphical Designer displays this screen (Figure B-2) when you edit an 
Announcement node in a call flow.

Figure B-2. Announcement Screen

Toolbar

Return 

Returns to the previous screen.

Bucket Editor 

Displays the Bucket Editor screen.
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Table Editor 
Displays the Table Editor screen.

Buttons

ASR

This button is disabled for announcements. No user input is required.

More

Click this button to display the Voice Response Parameters dialog box where you 
can enter more detail about the node’s behavior.

Fields

Data input fields appear in bold lettering. The data input fields for the 
Announcement object are displayed in the box labeled “Announcement”. The 
rest of the data input fields on the Announcement screen appear within a shaded 
area. A shaded area indicates that the field is disabled and therefore does not 
require user input.

Announcement Initial Prompt

This field contains the name of the prompt to be played when the Announcement 
node is executed. The default prompt name is the name of the Announcement 
node being edited.  You can define the Initial prompt by selecting an existing 
prompt or creating a new prompt.

Use an existing prompt:

1. Click the down arrow. 

The Graphical Designer displays a list of existing prompts.

2. Click a prompt name. 

The Graphical Designer displays text of the prompt name in box below the 
Initial Prompt field.
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Create a new prompt:

The Graphical Designer displays the name of the node in the Initial Prompt 
field. You can use this name or type in another name.

1. Do one of the following:

■ Type in the name of a new prompt in the Initial Prompt field 
and press . 

■ Edit the prompt text and press  or click in the box located 
underneath the Initial Prompt field. 

The Graphical Designer displays The Announcement Editor screen 
(Figure B-3), where you can enter the text for a new prompt or edit the text 
of an existing prompt. 

ENTER

ENTER
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Announcement Editor Screen

Use this screen to enter the text associated with a prompt. 

Formats for this screen 

■ Normal Mode (Figure B-3)

■ Dynamically Create Menu Options- Present Less Than Nine Options to the 
Caller (Figure B-4)

■ Dynamically Create Menu Options- Present More Than Nine Options to the 
Caller (Figure B-5)

Layout

Normal Mode

Use this screen (Figure B-3) to enter or edit the text for prompts that will not be 
created dynamically at execution time. 

Figure B-3. Announcement Editor Screen: Normal Mode
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 Dynamically Create Menu Options (<9)

The Graphical Designer displays this screen (Figure B-4) when you select the 
Use All Selected Records In The Prompt box and the number in the Max. 
Records To Present field is less than 9.

Since the total number of records to be presented to the caller is less than nine, 
the More Records: prompt and More Records Touchtone field are not 
required.

This format is most frequently used with the Automatic Menu object.

Figure B-4. Announcement Editor Screen: Dynamic <9 Mode

 Dynamically Create Menu Options (>9)

The system displays this screen format (Figure B-5) when you select the Use 
All Selected Records In The Prompt box and the number in the Max. 
Records To Present field is greater than 9.

Since the total number of records to present to the caller is greater than nine, the 
More Records prompt and More Records Touchtone field are enabled.

This format is generally associated with the Automatic Menu object.
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Figure B-5. Announcement Editor Screen: Dynamic >9 Mode

Buttons

Use All Selected Records In The Prompt

If this button is checked, the system displays the Announcement Editor screen in 
the “Use All Selected Records In The Prompt” mode. Otherwise, the system 
displays the screen in Normal Mode.

Use the Use All Selected Records In The Prompt mode is used to build the 
prompt text dynamically during application execution using the results of a 
previous query (the records selected from a database table). This type of menu 
creation can be performed for the Automatic Menu and the Prompt and Collects 
objects.

Return

Saves the entered text and returns to the previous screen.

Bucket Editor

Displays the Bucket Editor screen.
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Cancel

Returns to the previous screen without saving any changes.

Fields

There are three possible screen formats: a format for normal processing and two 
formats for dynamically creating menu options. The mode associated with each 
field is listed beside the field name.

Use the Edit menu to cut, copy, and paste text, and insert buckets, phrases, and 
phrase breaks into all the text fields on the Announcement Editor screen.

Announcement Text (Normal mode)

Type the text of the prompt to be played to the caller.

Introduction (Dynamically Create
Menu Options <9 and >9)

Type the text of the Introduction prompt, which is played before the list of 
options. The list of options is defined in the Body field.

Body (Dynamically Create Menu 
Options <9 and >9)

Type the text for the prompt played after the Introduction prompt. This prompt will 
be played once for each active record found in the previous query, creating a list 
of options. The maximum number of options to be played for the caller is defined 
in the Max. Records to Present field.

■ The [RecordCounter] bucket should be included in the Body prompt to 
identify the number of each option. 

■ The bucket that was populated during the query should also be included 
in the prompt to ensure that each option in the list is unique.

For example, a previous query was used to select all the stores in the vicinity of a 
certain zip code. The query assigned the location of the store to a bucket called 
[location]. The Body text might look like this:

For [location], press [RecordCounter].

Where [location] is the bucket containing the result of the previous query and 
[RecordCounter] is the number of the menu option.
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The caller might hear:

■ "For Red Bank" (location 1), "press 1" (Record Counter).

■ "For Long Branch" (location 2), "press 2" (Record Counter).

■ "For Belmar" (location 3), press 3" (Record Counter).

A maximum of nine options can be presented at a time in the Body prompt. 

To present more than nine options to the caller, the More Records Touchtone 
and More Records fields must be populated so the caller can obtain the 
additional options.

The value of the Max Records to Present field must also be greater than 
nine or left blank to indicate that all records found will be presented.

If the Max Records to Present field is left blank and less than nine records 
that match the selection criteria are found, only those options will be presented to 
the caller. 

For more than nine options to present, the sample body text might look like this:

For [location], press [RecordCounter].

The caller might hear:

■ "For Red Bank" (location 1), "press 1" (Record Counter).

■ "For Long Branch" (location 2), "press 2" (Record Counter).

■ "For Belmar" (location 3), "press 3" (Record Counter).

■ "For Asbury Park" (location 4), "press 4" (Record Counter).

■ "For Monmouth Beach" (location 5), "press 5" (Record Counter).

■ "For Bradley Beach" (location 6), "press 6" (Record Counter).

■ "For Ocean Grove" (location 7), "press 7" (Record Counter).

■ "For Seaside" (location 8), "press 8" (Record Counter).

■ "For Ortley Beach" (location 9), "press 9" (Record Counter).

■ The More Records prompt will be played after the ninth option if there are 
more options to present.

■ “To hear more options, press  (More Records Touchtone) now.”

If the caller presses , he or she will hear the next set of options.

Conclusion (Dynamically Create 
Menu Options <9 and >9)

Type the text of the prompt played after the Body prompt has completed.

#

#
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Record Counter (Dynamically Create 
Menu Options <9 and >9)

After the caller selects an option from the list, the Graphical Designer saves the 
number of the selection in the bucket specified in this field. For example, if the 
caller presses 2, the value of the selected bucket will be 2. 

Unless otherwise specified, the caller’s selection is stored in bucket 
[RecordCounter].

To put the caller’s selection in a bucket other than [RecordCounter] you can 
select an existing bucket or create a new bucket:

1. Do one of the following:

■ Select a bucket from the combo box by clicking the down arrow 
and choosing from a list of existing buckets (of Class Number only).

■ Create a new bucket by typing the name of a new bucket in the 
Bucket field. 

NOTE:
You must type a left bracket ([) before the name to identify this 
as a bucket name.

The system displays the Bucket Editor screen, where you can enter the 
characteristics of the new bucket.

NOTE:
The new bucket must be defined as Class Number.

Max Records to Present (Dynamically 
Create Menu Options <9 and >9)

■ Holds the maximum number of options that will be presented to the caller. 

■ If the number of records selected by the previous query is greater than the 
number in the Max. Records to Present field, the remaining records 
are not used. 

■ To present the caller with all the records retrieved by the query, leave this 
field blank.

■ Up to nine options can be presented at a time.

More Records Touchtone (Dynamically 
Create Menu Options >9)

Contains the touchtone the caller must enter to hear the next set of menu options. 

This field is enabled when the Max. Records to Present field is populated 
with a value greater than nine or left blank to indicate that all records found must 
be presented to the caller. 
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More Records (Dynamically Create 
Menu Options >9)

Type the text of the prompt to be played after the first set of nine options if the 
caller requests more options by entering the More Records Touchtone. 

This field is enabled when the Max. Records to Present field is populated 
with a value greater than nine or left blank to indicate that all records found must 
be presented to the caller.  

The More Records prompt should include the touchtone specified in the More 
Records Touchtone field to identify the touchtone the caller can use to retrieve 
the next set of menu options.
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ASR Parameters Dialog Box

Use this screen to specify the grammars or wordlists used for Automatic Speech 
Recognition (ASR).

Layout

This screen (Figure B-6) is displayed when you click on the ASR button located 
on the Menu, Prompt and Collect, Automatic Menu, and Voice Capture screens.

Figure B-6. ASR Parameters Screen

Toolbar

Return

Returns to the previous screen.

Checkboxes

Reserve ASR Resource Before Playing Prompt

Click this box to ensure that the ASR resource is available before obtaining caller 
input. Note that if this box is selected, other applications will not be able to 
access the ASR Resource until it has been released by this application.

If the Input Mode is Touchtone, this box is disabled.
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Free Reserved Resource After Caller Response

Click this box to free the ASR resource as soon as the node is executed and 
input is retrieved from the caller so that other applications can access it.

If the Input Mode is Touchtone, this box is disabled.

Fields

Input Mode

Click the down arrow to see a list of available grammars and wordlists that can 
be used for automatic speech recognition. A dialog box containing all of the 
grammars and wordlists that are available for the chosen conversant platform will 
appear. Click a grammar or wordlist to select it. 

FlexWord® wordlists appear in the combo box with the words “FlexWord List” 
before the wordlist name. All of the other options are grammars supported by the 
INTUITY CONVERSANT platform chosen for the application.

If ASR is not needed for this application, click the down arrow and select the 
“Touchtone” option.

Mode Chosen

Contains the name of the bucket that holds the input mode used by the caller. 
The bucket must be defined as Class Number.

The selected bucket can contain the following values:

■ If the caller enters a touchtone response, the bucket will contain a 
negative value.

■ If the caller speaks a response, the bucket will contain a non-negative 
value.

You can select an existing bucket or create a new bucket:

■ Select a bucket from the combo box: Click the down arrow to choose from 
a list of existing buckets. Click a bucket name to select it.

Or

■ Create a new bucket: Type in the name of a new bucket in the Bucket 
field. You must type a left bracket ([) before the bucket name.

This field is disabled if the Touchtone option is selected in the Input Mode field.
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Asynchronous Events

Use this screen to specify the action to be taken if a defined Asynchronous event 
occurs during call processing. 

When a caller terminates a call, a jump to the subroutine defined in the Inbound 
Call Terminated field will be effected.

Processing is terminated once the subroutine is executed.

NOTE:
Currently, the only asynchronous event supported is Inbound Call 
Termination.

Layout

The Graphical Designer displays this screen (Figure B-7) when you edit an 
asynchronous event object in the Design Pad.

Figure B-7. Asynchronous Events Screen
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Toolbar

Return

Returns to the previous screen.

Fields

Inbound Call Terminated

■ Specifies the subroutine to go to if an Asynchronous event occurs during 
call processing. 

NOTE:
Currently, the only Asynchronous event supported is inbound call 
termination.

■ The Asynchronous object should appear before the Call Answer object in 
the call flow.

■ Displays a list of all subroutines defined in the call flow. Select the 
subroutine to be executed when an Inbound Call Termination is detected.

Cleaning up Code

An External Function can be defined to clean up code as described below. See 
"External Function Definition Editor Screen" below for more information.

1. Create an External Function to clean up code.

2. Encapsulate the External Function object so it can be used as a 
subroutine.

3. Select the encapsulated node from the Inbound Call Terminated 
field.

4. The code clean-up routine is executed and application processing is 
terminated.
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Automatic Menu Screen

The menu will be dynamically created during application execution using a list of 
records previously retrieved from a database table.

Layout

The Graphical Designer displays this screen (Figure B-8) when you edit an 
Automatic Menu node in a call flow.

Figure B-8. Automatic Menu Screen

Data input fields appear in bold lettering. The data input areas for the Automatic 
Menu node appear in the boxes labeled “Announcement” and “Error Instruction”. 
The rest of the data input areas on the Automatic Menu screen appear shaded. 
The shaded fields are disabled and do not require user input. 

When there is a down arrow located next to a field name, you can choose an 
existing prompt name from the combo box. Click the down arrow and select a 
prompt name. The name of the prompt that you select appears in the data field.
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Toolbar

Return

Returns to the previous screen.

Bucket Editor

Displays the Bucket Editor screen.

Table Editor

Displays the Table Editor screen.

Buttons

ASR

Click this button to display the ASR Parameters dialog box, where you can 
specify the grammar or FlexWord wordlist to be used for Automatic Speech 
Recognition.

More

Click this button to display the Voice Response Parameters dialog box, where 
you can enter more details about the Automatic Menu node’s behavior.

Fields

Announcement Initial Prompt

This field contains the name of the prompt played when the Automatic Menu 
node is executed.  The default prompt name displayed is the name of the 
Automatic Menu node that is being edited.  Define the prompt that will contain 
the text for the Initial prompt. You can select an existing prompt or create a new 
prompt.

Use an existing prompt:

1. Click the down arrow to choose from a list of existing prompts.

2. Click a prompt name to select it. 

The text of the prompt you have selected appears in the box underneath 
the Initial Prompt field.                                                                                                                                                                                 
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Create a new prompt:

1. The name of the node appears in the Initial Prompt field. You can 
use this name or type in another name for the new prompt.

2. To manually name a prompt, type in the name of a new prompt in the 
Initial Prompt field and press .

3. To enter or edit the prompt text, press  or click in the box located 
underneath the Initial Prompt field.

The Announcement Editor screen, where you can enter the text for a new 
prompt or edit the text of an existing prompt, is displayed.

Error Prompts - Bad Input

This field holds the name of the prompt played when the caller enters an invalid 
response.

To enter a prompt name, select an existing prompt or create a new prompt:

Select a prompt name from the combo box:

1. Do one of the following:

■ Click the down arrow and choose from a list of existing prompts. 

■ To enter the prompt text, press . 

The system displays the Announcement Editor, where you can enter the 
text for the prompt.

Create a new prompt:

1. Enter the name of a new prompt in the Bad Input field

The system displays the Announcement Editor screen, where you can 
enter the text for the prompt.

Error Prompts - Timeout

This field holds the name of the prompt played when the caller fails to enter a 
response within the required amount of time. 

To enter a prompt name, select an existing prompt or create a new prompt.

Select a prompt name from the combo box:

1. Do one of the following:

■ Click the down arrow to choose from a list of existing prompts. 

■ To enter the prompt text, press . 

The system displays the Announcement Editor, where you can enter the 
text for the prompt.

ENTER

ENTER

ENTER

ENTER
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Create a new prompt:

1. Type in the name of a new prompt in the Timeout field and press . 

The system displays the Announcement Editor screen, where you can 
enter the text for the prompt. 

Error Prompts - Too Few Digits

This field holds the name of the prompt played when the caller fails to enter 
enough digits in his or her response.

To enter a prompt name, select an existing prompt or create a new prompt.

Select a prompt name from the combo box:

1. Do one of the following:

■ Click the down arrow and choose from a list of existing prompts. 

■ To enter the prompt text, press . 

The system displays the Announcement Editor, where you can enter the 
text for the prompt.

Create a new prompt:

1. Type the name of a new prompt in the Too Few Digits field and press 
. 

The system displays the Announcement Editor screen, where you can 
enter the text for the prompt.

ENTER

ENTER

ENTER
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Bucket Editor Screen

Use this screen to create new buckets, and change or delete existing buckets.

Layout

The Graphical Designer displays this screen (Figure B-9) when you select the 
bucket icon on the Design Pad toolbar.

Figure B-9. Bucket Editor Screen

Buttons

New

Creates a new bucket. The system displays a dialog box where you can type in 
the name of the new bucket.

Delete

Deletes the currently selected bucket, as long as it is not a system bucket. If you 
are attempting to delete a system bucket, the system displays a dialog box 
indicating that you cannot delete the bucket.
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Return 

Returns to the previous screen.

System Buckets

The following buckets come with the Graphical Designer and are visible when 
you click the down arrow next to the Name field. 

NOTE:
System buckets cannot be modified or deleted.  

ANI

Contains the ANI of the caller.

Attempts

Contains the number of times the caller has tried to respond.

Channel

Contains the channel number on which the call is currently being run.

Collected Digits

Contains the touchtones entered by the caller.

Date

Contains the current system date.

Default

Bucket that you can use to hold values for testing.

DNIS

Contains the number the caller dialed to reach this application.

Errno

This bucket will be populated with an error code. The error code identifies the 
reason why a step in the application could not be performed. For example, the 
Errno bucket will be populated with a numeric value if a database table lookup 
could not be performed. 
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No Digit

Contains the value used to determine if the caller has confirmed or rejected a 
previously entered response. If the caller responds with the No Digit, the caller is 
declining his or her response.

Record Counter

This bucket can be used to step through a series of records that match the 
selection criteria of a database table query. Each time a record is processed, the 
record counter can be incremented.

Records Found

Contains the number of records found that match the selection criteria of a 
database table query.

Time

Contains the UNIX system time.

Yes Digit

Contains the value used to determine if the caller has confirmed or rejected a 
previously entered response. If the caller responds with the yes digit, the caller is 
confirming his or her response.

Fields

Name

Type in the name of the bucket in the Name field or click the down arrow next to 
the field for a list of existing buckets.

To view the characteristics of an 
existing bucket:

1. Click the down arrow to choose from a list of existing buckets.

The system displays the attributes of the selected bucket so that you can 
view or edit them.
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To create a new bucket:

1. Click the New button. 

The system displays a dialog box where you can type in the name of the 
new bucket.

NOTE:
The attributes for a bucket of Class Character appear as a default. 
These attributes can be changed for the new bucket.

Class

The type of data to go into the bucket. The Class field is disabled for system 
buckets.

.

Class Description
Default 
Size

Default 
Value

Character Can contain any value from the 
ASCII character set, that is, letters, 
numbers and any punctuation or 
special keys.

24 None

Currency Includes symbols for dollars and 
cents used to denote monetary 
values.

15 $0.00

Date Use this format to customize the 
representation of calendar dates.

8 01/01/97

Number Can contain any integer value. 10 0

Real Represents a decimal value. Can 
hold up to four decimal places.

10 0.0000

Time Use this format to customize the
representation of the time of day.

6 1200AM
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SpokeMn Format

Click on the down arrow to select a Spoken Format to specify the way in which 
the bucket data is spoken to the caller.

 

Class
Spoken 
Format Description

Character Char Characters are spoken in succession. A 
null character field is played as a pause 
(silence). 

Digits The data is spoken like a number. For 
example, “12345” is spoken as “twelve 
thousand three hundred forty-five”.

Phrase The phrase associated to the phrase 
number contained in the bucket is spoken 
to the caller.

Currency Dollars/cents Both the dollars and cents portion of a 
monetary amount is spoken.

Dollars Only the dollars portion of a monetary 
amount is spoken. For example, “$12.45” 
is spoken as “twelve dollars”.

Date M d,y The month along with the day and year is 
spoken. For example, “081097” is spoken 
as “August tenth nineteen ninety seven”.

mmddyy The month is spoken as digits. For 
example, 081097 is spoken to the caller 
as “eight ten nineteen ninety seven”.

Number Number The bucket value is spoken as a number. 
If a value is negative, the word “minus” is 
spoken before the number.

Real #.# The bucket value is spoken as a number 
with four decimal places. For example, 
“6.54” is spoken as “six point five four zero 
zero”.

# The bucket value is spoken as a whole 
number, truncating the decimal positions. 
For example, “6.54” is spoken as “six”.

Time hhmm[AP]M The time is spoken back to the caller 
appending an “AM” for the time range 
00:01 to 11:59 and “PM” for the time range 
12:00 to 23:59.
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Speak Using

Click on the down arrow to specify whether the contents of the bucket will be 
spoken to the caller using Text-To-Speech (TTS) or recorded speech.

Speak Using Format Description

recorded Use recorded phrases to speak back bucket contents.

tts Use Text-To-Speech to speak back bucket contents.

tts address Speak back bucket contents and expand any address 
abbreviations encountered. For example, “10 W. Front 
St.” is spoken back to the caller as “10 West Front 
Street”.

tts phone number Use to speak back vanity numbers like “1 800 
LUCENT1”.

tts fraction Use to speak back fractions correctly. For example, 
“3/4” is spoken back to the caller as “three fourths”.

tts proper name Use Text-to-Speech to speak back bucket contents 
and expand any formal name abbreviations. For 
example, “Mr. Edward Weatherspoon, Esq.” is spoken 
back to the caller as “Mister Edward Weatherspoon, 
Esquire”.
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Input Format

Click on the down arrow to specify the format the caller must use when giving a 
response to be contained in the bucket.

Phrase Table

Click the down arrow to specify which phrase table will contain this bucket.

Length

Enter the maximum length of the bucket.

Default

Select a value to be placed into the bucket at run time if the bucket is not 
populated during design execution.

Current Value

Displays the current value of the bucket. This information is useful when testing 
the design in simulation mode. You can stop the design execution at any time 
and check the bucket value for accuracy

Class Input Format Description

Character Char Interprets the input value as characters.

Currency #*00 Interprets the input value as a monetary 
value. For example, “12*45” is 
interpreted as $12.45.

Date mmddyy Can be entered as month, day, and 
year.

yyyymmdd Can be entered as year, month, and 
day.

Number # Interprets the input value as integers.

Real #*# Interprets the asterisk in the input 
stream as the decimal point. For 
example, the value “12*34” is 
interpreted as “12.3400.”

Time hhmm[AP]M Can be entered with “AM” to indicate 
morning or “PM” to indicate evening.

hhmm Can be entered as hours and minutes.

hh24mm Can be entered in the 24-hour military- 
time format.
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Choose a Bucket Dialog Box

This dialog box selects the bucket to insert at the current cursor position in the 
Announcement Text field.

Layout

The Graphical Designer displays this screen (Figure B-10) when you select Insert 
Bucket on the Edit Menu or when you type in a left bracket ([) in the 
Announcement Text field.

Figure B-10. Choose a Bucket Screen

Buttons

Select

Click this button to insert the selected bucket at the current cursor position.

Cancel

Click this button to return to the previous screen without selecting a bucket.

New

Click this button to create a new bucket. The system displays a dialog box where 
you can type in the name of the new bucket.
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OK button

Click this button to continue to define the new bucket. The system displays the 
Bucket Editor screen, where you can assign attributes to the new bucket. Click 
the Return button on the Bucket Editor screen to insert the new bucket at the 
current cursor position.

Cancel button

Click this button to return to the previous screen without defining a new bucket.
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Code Generation Screen 

Use this dialog box to generate code for the target platform where the 
application will actually run. 

Layout

The Graphical Designer displays this screen (Figure B-11) when you select the 
Code Generation menu command from the File Menu of the Design Pad screen

Figure B-11. Code Generation Screen

Buttons

Events Editor 

Click this button to go to the Events Editor screen where you can format the Event 
Record created for the target system each time the application is executed. You 
can also define the format of each Event Record created.

 Return

Click this button to return to the Design Pad screen.

Generate Code

Click this button to generate the code for the selected file types for the target 
system. 



Code Generation Screen

Issue  2.0   August 1997 B-33

Fields

Conversant Files to Generate 

Choose the application components for which you want to generate code for the 
INTUITY CONVERSANT system. The file extension is listed along with the file type 
so you can identify each file generated. 

1. Click the box located next to the file type to select it. 

NOTE:
You must select all file types that correspond to the components 
present in your design. A complete set of files is required to run the 
application correctly on the INTUITY CONVERSANT system.

The available file types generated when you click on the selection box are:

■ Script files (*.h, *.t and *.D)

■ Oracle database file (*.sql and symbols)

The files created by the code generation appear in the Targets directory 
for the application.

■ All: generates code for all of the database tables defined in the 
application.

■ Select: displays the Database Tables dialog box where you can 
select the tables for which code will be generated.

■ Host definition file (*.hs)

■ Phrase list file (*.pl)

■ Phrase sound file (*.vis)

The files created during code generation will appear in the directory for the 
application.

NOTE:
The application directory has the same name as the design and is located 
under the Apps directory of the main Lucent Technologies Graphical 
Designer file structure.
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Data Editor Screen

Use this screen to populate local database table records with data. 

Layout

The Graphical Designer displays this screen (Figure B-12) when you click the 
Data Editor Toolbar button located on the Table Editor screen.

Figure B-12. Data Editor Screen

Toolbar

Return

Returns to the previous screen. 

Insert Record 

Inserts a record directly above the currently selected record.
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Add Record 

Inserts a record at the end of the table.

Delete Record 
Deletes the currently selected record.

Buttons

Plus and Minus Buttons

Allows you to navigate through database table records. Click the Plus button to 
move ahead to the next record. Click the Minus button to move back to the 
previous record.

Fields

Record 

Enter the number of the record you want to view or click the + or - buttons 
located next to the Record field to move to a specific record.

To move from record to record, press  or click the + or - buttons.

Field

Contains the list of field names defined in the database table schema.

To move from field to field, press .

Value

Contains the list of values associated with the fields in the database table. You 
can modify the value of a field by selecting it and clicking in the Value field, 
where you can make the necessary changes. 

To update data in a record:

1. Click a field name to select it.

The system displays the selected field information in the change area 
above the list. 

2. Enter the updated values.

TAB

ENTER
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Defaults Editor Screen

Use this screen to choose the overall design defaults to be used as system, code 
generation, and printing defaults. 

Layout

The Graphical Designer displays this screen (Figure B-13) when you select 
Defaults Editor on the Go Menu.

Figure B-13. Defaults Editor Screen

Buttons

OK

Put any changes made to the defaults into effect and returns you to the Design 
Pad screen.

Cancel

Returns you to the Design Pad screen without making any changes to the overall 
application defaults.
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Fields

System Defaults

The following system defaults can be specified by selecting the box located next 
to the default name, picking a value from a list of acceptable values, or typing a 
value from the keyboard:

Verification/Testing Defaults

The following defaults have to do with debugging or troubleshooting each node 
in your design. You can also perform Node Verification on your entire design by 
selecting the Verify Design menu command listed in the Edit Menu of the Design 
Pad screen.

 

AutoName Select this option if you want the system to automatically 
assign names to nodes when they are added to a call flow.

Font Size Type in or click on the down arrow to choose the default 
font size to be used when displaying the call flow 
information. The available font sizes are 14, 18, and 27.

BackUp Interval Type in the amount of time (in minutes) before an active 
design is automatically saved to the backup file.

On Entering the 
Node Editor

Select this box to test for potential problems in the 
currently selected node when first entering the Node 
Editor.

On Leaving the 
Node Editor

Select this box to test for potential problems in the 
currently selected node when leaving the Node Editor.

Show Tested 
Indicator

Select this box to have check marks appear next to nodes 
that have been executed during simulation.
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Printing Defaults

The following defaults indicate what gets printed when you choose Print on the 
File Menu in the Design Pad. You can override any defaults selected here by 
selecting or deselecting the option on the Print Reports screen.

Call Flow Prints a picture of the call flow.

Node Info Prints a description of the nodes in a call flow.

Host Listing Prints the node information for all of the hosts defined for 
this application.

Host Flow Prints a listing of the Host Flow for the hosts defined for this 
application.

Host Attributes Prints a listing of the screen information defined for a host.

Custom Events Prints the buckets included in the custom event record.

Phrase List Provides a list of phrases and associated phrase numbers.

Prompt List Provides a list of the prompts used in the design.

DB Info Provides a listing of the table schema defined in the 
design.

Bucket Info Provides a list of the buckets in the design.

To Printer Sends the information you want printed to the printer rather 
than saving it to a Word RTF file.

Portrait Prints the selected information in portrait view rather than 
landscape view.

Call Flow Point 
Size

Choose the font size to be used to print out the call flows in 
the application. The available font sizes are 8, 12, 16, 20, 
22, 26, 30, 34, and 38.
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Delete Record Screen

Use this screen to delete a record or multiple records from a database table 
during application execution.

Layout

The Graphical Designer displays this screen (Figure B-14) when you edit a 
Delete Record node in a call flow.

Figure B-14. Delete Record Screen

Toolbar

Return 
Returns to the previous screen.

Bucket Editor

Displays the Bucket Editor screen.
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Table Editor 
Displays the Table Editor screen.

Buttons

Delete Multiple Records If Found

Click this button to delete all the records in the database table that match the 
search criteria you have established. 

■ If this button is checked and multiple records are found, all of the records 
retrieved are deleted. 

■ If this button is not checked and multiple records are retrieved, no records 
are deleted.

Fields

Table to Delete Records

Contains the name of the database table from which record(s) are deleted during 
application execution.

1. Click the down arrow to choose from a list of existing database tables.

2. Click a table name in the list to select it. The system displays the name you 
select in the Table to Delete Records field.

Record Selection Criteria

Lists the fields in the database table and the buckets containing the values to 
which the fields will be compared.  You can select multiple fields to build the 
selection criteria.

1. Click a line in the criteria list to select a Record Field name.

2. Do one of the following to define a relation for the selection criteria:

■ Click the down arrow to choose from a list of available relations.   
Click a relation to select it. 

NOTE:
The only relation currently supported is equals (=).

■ Type in a literal value or define a bucket to compare to the field
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■ Type in a literal value in the Bucket/Literal field, or click the 
down arrow to choose from a list of existing buckets.

■ Click a bucket name to select it, or type in the name of a new 
bucket. 

NOTE:
You must type a left bracket ([) before the bucket name.

3. Press  to create the new bucket.ENTER
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Design Pad Screen

Use this screen to create a call flow using objects from the object palette.

Layout

The Graphical Designer displays this screen (Figure B-15) when you select New 
Design from the File Menu in the Welcome Screen.

Figure B-15. Design Pad Screen

Design Pad Toolbar

Simulation Mode 

Displays the Design Simulation screen. This screen allows you to test your 
design in simulation.

Palette

Hides or shows the Object Palette.
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Print Reports 

Displays the Print Reports screen. This screen allows you to print all of the 
components of your design.

Bucket Editor 
Displays the Bucket Editor screen, where you can add or delete buckets and 
change the properties of existing buckets.

Table Editor 

Displays the Table Editor screen, where you can create or modify local database 
table schema and define them to an application.

Sound Manager 
Displays the Sound Manager screen, where you can record the prompts in an 
application.

Events Editor 

Displays the Events Editor screen, where you can define the buckets to be 
included in the Event string.

Generate Code

Displays the Code Generation screen, where you can select the components for 
which to generate code for the target platform.

Icons

Encapsulation Path

Shows the name of the current call-flow path. The name of the call flow appears 
in brackets. 

Trash Can

Drag a node from the Design Pad and drop it over this icon to delete the node 
and all nodes under it. Performs the same function as the Delete Node menu 
command in the popup menu.
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Increase/Decrease Outline Levels

Use this icon to control the number of outline format levels. The maximum 
number of levels that can be displayed is 30. Click the minus (-) and plus (+) 
buttons to decrease or increase the number of levels. You can show or hide 
branches underneath nodes in the call flow.

This icon can be used to save screen space by hiding or shrinking unimportant 
nodes in the call flow.

Creating Call Flows:

The Design Pad Screen contains the area in which you create a call flow.

To create a call flow:

1. Click an object on the Object Palette to select it. Do not release the mouse 
button, continue to hold the object.

2. Drag the object across the screen to the Design Pad area.

3. Drop the object onto an empty branch by releasing the mouse button. If 
the object is the first object in your call flow, you may drop it anywhere in 
the Design Pad.

Object Palette

Figure B-16 displays all of the objects that can be used to create call flows.

Figure B-16. Object Palette
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Object Palette Components:

Add Record Use this object to add a record to a database table during 
design execution.

Announcement Use this object to play a simple announcement to the 
caller.

Asynchronous 
Event

Use this object to define Asynchronous Event handling 
such as inbound call termination.

Autometic Menu Use this object to create a menu of choices derived from a 
list of previously retrieved database table records.

Call Answer Use this object to answer incoming calls.

Call Disconnect Use this object to disconnect the incoming call.

Delete Record Use this object to delete record(s) from a database table 
during application execution.

Encapsulation Use this object to remove the appearance of a portion of a 
call flow by “collapsing” the nodes into a subroutine.

External 
Function

Use this object to call an external function to 
transmit/receive information or perform functions outside of 
the Graphical Designer.

Halt Use this object to halt the execution of an application.

Host 
Connectivity

Use this object to check the status of the connectivity 
between a host machine and an application.

Menu Use this object to present the caller with a list of options to 
choose from.

Prompt and 
Collect

Use this object to prompt the caller for data. The data can 
then be saved for later use.

Query Table Use this object to retrieve records from a database table 
based upon the specified selection criteria.

Send Data Use this object to identify the format of screen data to be 
sent to a host machine in the network.

Send/Receive 
Data 

Use this object to identify the format of the data to be sent 
to or received from a host machine in the network.

NOTE:
This object is also known as Host I/O

Set Use this object to set buckets to expressions and to 
branch based on specific values.
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Popup Menu

The Graphical Designer displays a popup menu when you click a node in a call 
flow. This menu allows you to perform maintenance on a node and to define the 
object characteristics. 

To use the popup menu:

1. Click any node or branch to display it.

2. Choose a command from the menu by clicking it.

3. To close the menu, click anywhere outside of it.

Branch Notes

The text you enter here is displayed in the dynamic context-sensitive help area of 
the screen. 

Each time you pass the mouse over the annotated branch, the text you entered is 
displayed in the lower left corner of the Design Pad screen.

Connect Node

Connects a node to the currently selected branch. You are able to choose from a 
list of existing disconnected nodes after selecting this command.

Copy Callflow

Creates a new call flow node and places it on the selected branch. The new 
node contains a copy of the existing call flow of your choice. Later changes 
made to either call flow do not impact the other.

Delete Branch

Removes the currently selected branch from the call flow. Note that all nodes 
under the selected branch are also deleted.

Timebranch Use this object to branch based on time of day, day of the 
week, or a specific date.

Transfer Call Use this object to transfer a call to an agent.

Update Table Use this object to change the data within a specified 
database table.

Voice Capture Use this object to record a caller’s spoken response.
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Delete Node

Removes the currently selected node from the call flow. Note that all nodes under 
the selected node are also deleted.

Disconnect Node

Disconnects the currently selected node and all the nodes under it. The resulting 
tree is placed at the bottom of the call flow.

Edit Node

Displays the Editor screen where detailed information about node behavior can 
be defined for the currently selected node.

Encapsulate

Replace the selected node with a new call flow node. The selected node and all 
nodes under it are contained in the new encapsulated call flow node. 
Encapsulation turns the selected call flow into a subroutine that can then be 
reused elsewhere in your design.

Insert Branch

Inserts a branch above the selected branch. 

■ If the branch hangs off a Timebranch node, the system displays the 
Timebranch Events dialog box, where you can choose the time-based 
event for the branch. 

■ If the branch hangs off a Set node or Encapsulated node, the system 
displays a dialog box, where you can type in the name of a new branch. 

■ If the branch hangs off a Host Send/Receive node, the system displays 
the Choose a Screen dialog box, where you can select a receive screen 
branch.

Otherwise, the system displays the Touchtones dialog box where you can define 
a touchtone event.

Jump to Node

You are able to choose from a list of existing nodes after selecting this command. 
Click one of the nodes listed to select it.

When a Jump to Node is created on the currently selected branch, it also creates 
a pointer to an existing node. A jump to that node in the call flow occurs when 
this branch is executed.
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New Node

Connects a new node to the currently selected branch. The system displays the 
Node Classes dialog box, where you can choose an object type from the node 
classes listed.

You can use this menu command instead of dragging an object from the Object 
Palette to the Design Pad.

Notes

Notes can be used to provide additional comments about nodes within a call 
flow. The system displays the text you type in for this node in the dynamic 
context-sensitive help area of the screen.

Each time you pass the mouse over the annotated node, the system displays the 
text you entered in the lower left corner of the Design Pad screen.

Print Node

Use this command to print information about the currently selected node.

Rename Branch

Changes the name of an existing branch. Once you have renamed a branch, you 
can only access it by the new name. All references to the old name now point to 
the new name.

Rename Node

Changes the name of an existing node. Once you have renamed a node, you can 
only access it by the new name. All references to the old name now point to the 
new name.

Reuse Callflow

Creates a new call flow node and places it on the selected branch. 

The new node contains a copy of an existing call flow of your choice. Later 
changes made to the “reused” call flow affects the original call flow and 
vice-versa. For example, if either node is deleted, or if a node within one of the 
call flows is modified, both nodes are affected.

Set Break Point

Inserts a break point at the currently selected node. During design simulation, 
execution halts before the execution of this node. This command is useful for 
debugging call flows. Establish break points so you can verify the contents of 
buckets to make sure they contain the correct values.
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Design Simulation Screen

Use this screen to simulate the execution of your application. You can use it to 
test the behavior of your application and to demonstrate the application to others.

Layout

This screen (Figure B-17) is displayed when you do either of the following:

■ Initiate the simulation mode menu command in the Go menu of the Design 
Pad screen.

■ Click the Simulate Design Toolbar Button located in the Toolbar of the 
Design Pad screen.

Figure B-17. Design Simulation Screen
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Toolbar

Design Pad 

Click this button to exit simulation mode and return to design mode (Design Pad 
screen).

Traffic Light

Starts and stops the design simulation. The green light is highlighted if the 
design is currently running in simulation mode. The red light is highlighted if the 
design is not currently running.

Stop 
Inserts a break point at the currently selected node. During design simulation, 
execution halts before the execution of this node.

Bucket Editor

Displays the Bucket Editor screen.

Table Editor

Displays the Table Editor screen. 

Edit 
Allows you to edit the selected node.

Sound Manager

Displays the Sound Manager screen. 

Stepper

Stops the design simulation at the beginning of each node. This is useful in the 
debugging of call flows. You can check the values of buckets after the execution 
of each node.
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Icons

Encapsulation Path

Displays the current encapsulation path. The name of the currently selected call 
flow appears in brackets.

Design Pad

You can watch the progress of your simulation here. 

■ As each node is executed, it is highlighted. 

■ Caller responses can be simulated by entering a response in the Design 
Simulation Prompter window. 

■ You can double-click any node on the Design Pad to display the popup 
menu and choose a command.
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Design Simulation Prompter Window

This window is displayed whenever a prompt is played to a caller during 
simulation.  

You can leave the window at any time by clicking the Stop button. The window 
will continue to be displayed until no more tries remain.

Layout

The Graphical Designer displays this screen (Figure B-18) to simulate playing an 
announcement to a caller.

Figure B-18. Design Simulation Prompter Screen

Buttons

Stop 

Stops simulation of the application and causes the system to display the Design 
Pad screen.

Pause

Temporarily halts the simulation of the application. Use this button to review the 
text in the Prompter window. 
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Go

Continues the simulation of the application and executes the next node in the call 
flow.

Speech 

Click this button to simulate speech for selected words when Automatic Speech 
Recognition is specified. The system displays the Select a Word dialog box, 
where you can select a grammar.

Async Events

Click this button to simulate the occurrence of an Asynchronous Event. 

NOTE:
Currently, inbound call termination is the only Asynchronous Event that can 
be simulated.

Touchtone Pad

The Touchtone Pad appears so you can enter touchtone responses to the 
prompts played for the caller.

You can enter touchtones in two ways:

■ Click the keypad to select touchtones

■ Use the number keys on the keyboard to enter touchtones.

Fields

Prompt Text

Displays the text of the prompt played to the caller.

Time Remaining field

The remaining amount of time (in seconds) within which the user must enter a 
response.

Collected Digits field

Contains the touchtones that the user has entered.



Screen Reference

B-54 Issue  2.0   August 1997 

Events Editor Screen

Use this screen to build a custom event record. 

■ A custom event record is used to collect information about a call that can 
then be used to generate reports at a later time.  

■ The record is written to a special events file on the target machine.

Layout

The Graphical Designer displays this screen (Figure B-19) when you do one of 
the following:

■ Click the Events Editor in the Go Menu of the Design Pad or Design 
Simulation screens.

■ Click the Custom Events Toolbar button located in the Toolbar of the 
Design Pad screen.

Figure B-19. Events Editor Screen
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Toolbar

Return 
Returns to the previous screen.

Bucket Editor

Displays the Bucket Editor screen.

Fields

Available Buckets

Choose a bucket to be included in the event record by clicking the bucket name. 
The bucket selected in the Available Buckets field is placed below the 
currently selected bucket in the Selected Buckets field.

Selected Buckets

This field displays the list of buckets that will make up the event record. The 
buckets are written to the event record in the exact order in which they appear in 
this list. To change the sequence of the buckets listed in the event record, use 
the options available in the Events Format Menu.

Call Event Data Format Options Fields

Destination

Specifies the way in which the Event Record information will be stored.

■ standard event db: uses a called function to retrieve the Event 
Record string and stores the information in the Standard Event Database 
on the INTUITY CONVERSANT system.

■ other: uses a function developed by an application programmer to 
retrieve the Event Record string for special processing.

Output Format

Specifies the way in which the Event Record information is formatted when it is 
retrieved. The maximum length for an Event Record string is 400 bytes.

■ five 80 byte records: the data is stored in five 80-byte records.

■ all records separate: a separate record is created for each bucket 
defined in the Event Record string.

■ one 400 byte record: the data will be stored in one 400-byte record.
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Event Separator

Specifies the character that will be used to separate each field in the Event 
Record string.

■ bar

■ colon

■ comma

Pad Character

Specifies how fields are padded if there is not enough data to fill the defined 
space for the bucket.

■ zero

■ null

The field length can be padded with null or zeroes.
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Expressions Dialog Box

Use this dialog box to set a bucket to an expression from the Set screen. The 
expression can then be used by the Set node as a branch condition.

There are different formats for the Expressions dialog box depending upon the 
type or mode of expression you select. A screen is listed along with descriptions 
of the fields for each of the following:

■ Arithmetic Mode

■ Assign Mode

■ Concat Mode 

■ ItemCount Mode

■ ItemOf Mode

■ Length Mode

■ Next Record Mode

■ Parse Mode

■ Prev Record Mode

■ Substring Mode

Each field is listed along with the possible values that can be entered for that 
field. You can select a bucket by clicking on the down arrow located next to the 
field name. If you type in a bucket name, you must enter a left bracket ([) before 
the name.

The buttons available on the Expressions dialog box are the same for all of the 
different formats and are listed in this section before the screen formats.

Buttons

Return

Saves your expression and returns to the Set screen.

Bucket Editor

Displays the Bucket Editor screen.

Cancel

Returns to the Set screen without saving any changes.



Screen Reference

B-58 Issue  2.0   August 1997 

Modes

Arithmetic Mode

This mode is used to assign the result of an arithmetic expression to a bucket. 
The Destination bucket, located before the equals (=) sign, holds the result of the 
assignment.

Layout

The Graphical Designer displays this screen (Figure B-20) when you select an 
expression on the Set screen.

Figure B-20. Arithmetic Mode Screen

Destination

Selects the bucket to be populated with the result of the arithmetic operation. The 
bucket can be defined as one of the following Classes: Number, Real, Currency, 
Date, or Time. The Destination bucket must be of the same Class as the buckets 
selected as Operands 1 and 2. 

To enter a bucket name:

1. Do one of the following:

■ Click the down arrow to choose an existing bucket.

■ Enter the name of a new bucket. 

NOTE:
You must type a left bracket ([) before the bucket name. 

The system displays the Bucket Editor screen, where you can define the 
characteristics of the new bucket.
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Operand 1

Type in a literal value or define a bucket name in this field. 

To enter a bucket name:

1. Do one of the following:

■ Click the down arrow to choose an existing bucket

■ Enter the name of a new bucket. 

NOTE:
You must type a left bracket ([) before the bucket name.

The system creates a new bucket with the same characteristics as the 
Destination bucket.

Operation

Click the down arrow to choose an operation from the combo box:

■ + : addition

■ - : subtraction

■ * : multiplication

■ / : division

Operand 2

You can type a literal value or define a bucket name in this field. 

To enter a bucket name:

1. Do one of the following:

■ Click the down arrow to choose an existing bucket.

■ Enter the name of a new bucket. 

NOTE:
You must type a left bracket ([) before the bucket name.

The system creates a new bucket with the same characteristics as the 
Destination bucket.
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Assign Mode

Layout

The Graphical Designer displays this screen (Figure B-21) to assign a value to a 
bucket.

Figure B-21. Assign Mode Screen

Destination

Specify the bucket to which the data from the Value field will be assigned. 

To enter a bucket name:

1. Do one of the following:

■ Click the down arrow to choose an existing bucket. 

■ Enter the name of a new bucket. 

NOTE:
You must type a left bracket ([) before the bucket name.

Value

Enter the value to be assigned to the Destination bucket. This value can be 
entered as a literal or you can choose a bucket name. 

To enter a bucket name:

1. Do one of the following:

■ Click the down arrow to choose an existing bucket. 

■ Enter the name of a new bucket. 

NOTE:
You must type a left bracket ([) before the bucket name.
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Concat Mode

Layout

The Graphical Designer displays this screen (Figure B-22) to append one string 
to another. For example, if String 1 contains “abc” and String 2 contains “def”, 
the Destination bucket will contain “abcdef”.

Figure B-22. Concat Mode Screen

Destination

Specifies the bucket to which the concatenation of String 1 and String 2 will be 
assigned. The bucket must be defined as Class Character. 

To enter a bucket name:

1. Do one of the following:

■ Click the down arrow to choose an existing bucket. 

■ Enter the name of a new bucket. 

NOTE:
You must type a left bracket ([) before the bucket name.

The system creates a bucket of Class Character.
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String1

Specify the literal or bucket to assign a value to String 1. 

To enter a bucket name:

1. Do one of the following:

■ Click the down arrow to choose an existing bucket. 

■ Enter the name of a new bucket. 

NOTE:
You must type a left bracket ([) before the bucket name.

String2

Specify the literal or bucket to assign a value to String 2. 

To enter a bucket name:

1. Do one of the following:

■ Click the down arrow to choose an existing bucket. 

■ Enter the name of a new bucket. 

NOTE:
You must type a left bracket ([) before the bucket name.

Max Length

Enter the maximum length of the concatenated string that can be placed in the 
Destination bucket. If the concatenated string is longer than this length, the 
right-most characters are truncated.

You can type in a literal value or select a bucket defined as Class Number.
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ItemCount Mode

Layout

The Graphical Designer displays this screen (Figure B-23) to count the number 
of items in a bucket. Items are separated by commas. For example, the number 
of items in the string “a,bc,d” is three.

Figure B-23. ItemCount Mode Screen

Destination

Specifies the bucket that contains the number of items counted in the Source 
bucket. This bucket must be defined as Class Number. 

To enter a bucket name:

1. Do one of the following:

■ Click the down arrow to choose an existing bucket. 

■ Enter the name of a new bucket. 

NOTE:
You must type a left bracket ([) before the bucket name.
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Source

Specifies the bucket that will contain the items to be counted. This bucket must 
be defined as Class Character.

To enter a bucket name:

1. Do one of the following:

■ Click the down arrow to choose an existing bucket. 

■ Enter the name of a new bucket. 

NOTE:
You must type a left bracket ([) before the bucket name.
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ItemOf Mode

Layout

The Graphical Designer displays this screen (Figure B-24) to extract an item from 
a bucket. Items are separated by commas. For example, item 2 of the string 
“a,bc,d” is “bc” based on its position within the string.

Figure B-24. ItemOf Mode Screen

Destination

Specifies the bucket that will contain the item extracted from the Source bucket. 
This bucket must be defined as Class Character. 

To enter a bucket name:

1. Do one of the following:

■ Click the down arrow to choose an existing bucket. 

■ Enter the name of a new bucket. 

NOTE:
You must type a left bracket ([) before the bucket name.

Source

Specifies the bucket that contains the item(s) to be extracted and placed in the 
Destination bucket. This bucket must be defined as Class Character. 
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To enter a bucket name:

1. Do one of the following:

■ Click the down arrow to choose an existing bucket. 

■ Enter the name of a new bucket. 

NOTE:
You must type a left bracket ([) before the bucket name.

Item Number

Position of the item to be extracted in the Source bucket item list. This value can 
be entered as a literal or specified as a bucket defined as Class Number. To 
enter a bucket name:

1. Do one of the following:

■ Click the down arrow to choose an existing bucket. 

■ Enter the name of a new bucket. 

NOTE:
You must type a left bracket ([) before the bucket name.
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Length Mode

Layout

The Graphical Designer displays this screen (Figure B-25) to calculate the 
number of characters in a string. For example, if the value of the String bucket is 
“abc”, the Destination bucket is populated with “3”. 

Figure B-25. Length Mode Screen

Destination

Specifies the bucket that will contain the number of characters within the bucket 
displayed in the String field. This bucket must be defined as Class Number. 

To enter a bucket name:

1. Do one of the following:

■ Click the down arrow to choose an existing bucket. 

■ Enter the name of a new bucket. 

NOTE:
You must type a left bracket ([) before the bucket name.
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String

Specifies the literal or bucket that will contain the character string to be counted. 
This bucket can be defined as any Class. 

To enter a bucket name:

1. Do one of the following:

■ Click the down arrow to choose an existing bucket. 

■ Enter the name of a new bucket. 

NOTE:
You must type a left bracket ([) before the bucket name.
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Next Record Mode

This mode is used to step through a list of records already selected by the most 
recent query.  

■ The record after the currently selected record is selected, and its field 
values are assigned to the buckets as specified in the most recent query. 

■ If there are no more records in the list, the bucket values are set to null.

Layout

The Graphical Designer displays this screen (Figure B-26) to step through a list 
of records already selected by the most recent query. 

Figure B-26. NextRecord Mode Screen

NextRecord Number

Specifies the bucket that will contain a value indicating the position of the next 
record in the list of retrieved records. This bucket must be defined as Class 
Number. 

To enter a bucket name

1. Do one of the following:

■ Click the down arrow to choose an existing bucket. 

■ Enter the name of a new bucket. 

NOTE:
You must type a left bracket ([) before the bucket name.
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Parse Mode

This mode is used to extract a portion of a string and place it in a Destination 
bucket. 

■ The string that appears before the specified separator characters will be 
extracted. 

■ The Source string is then be stripped of the substring and the separator 
characters. 

For example, if the Source string is “ab,<c” and the separator characters are 
“,<“, the Destination bucket will contain “a”. The Source string data is updated to 
contain only the remaining character(s), which, in this case is “c”.

■ If the separator characters appear more than once, right after each other, 
all instances of the separator characters are removed in the Source string. 

For example, if the Source string is “a,<,<, c” and the separator characters are 
“,<“ the Destination bucket will contain “ab”. The Source string is stripped of the 
characters “ab” and changed to “c”.

Layout

The Graphical Designer displays this screen (Figure B-27) to extract a portion of 
a string and place it in a Destination bucket. 

Figure B-27. Parse Mode Screen
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Destination

Specifies the bucket that will contain the string extracted from the Source string. 
This bucket must be defined as Class Character.   

To enter a bucket name:

1. Do one of the following:

■ Click the down arrow to choose an existing bucket. 

■ Enter the name of a new bucket. 

NOTE:
You must type a left bracket ([) before the bucket name.

Source

Specifies the bucket containing the string from which the substring is extracted. 
After the extraction occurs, the Source string will contain only the characters that 
remain. This bucket can be defined as any Class except Class Number. 

To enter a bucket name:

1. Do one of the following:

■ Click the down arrow to choose an existing bucket. 

■ Enter the name of a new bucket. 

NOTE:
You must type a left bracket ([) before the bucket name.

Separator

Contains the value that separates the substring to be extracted from the rest of 
the string. This value can be entered as a literal or specified as a bucket defined. 

To enter a bucket name:

1. Do one of the following:

■ Click the down arrow to choose an existing bucket. 

■ Enter the name of a new bucket. 

NOTE:
You must type a left bracket ([) before the bucket name.
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PrevRecord Mode

Use this mode to step backwards through a list of records already selected by a 
previous query. 

■ The record before the currently selected record is selected, and its field 
values are assigned to the buckets as specified in the most recent query. 

■ If there are no more records in the list, the bucket values are set to null.For 
example, the last query selected three records. Originally, the record 
number was equal to 1, and all of the buckets defined in the 
Assignments From Selected Fields fields of the Query Table 
screen were populated with the values of the first selected record. If you 
add a Next Record expression, the record number is now equal to 2 and 
the buckets are populated with the values contained in the second record. 
If you add a PrevRecord expression at this point, the record number is 
equal to 1 again and the buckets are set back to their original values.

Layout

The Graphical Designer displays this screen (Figure B-28) to step backwards 
through a list of records already selected by a previous query.

Figure B-28. PrevRecord Mode

Previous Record Number

Specifies the bucket that will contain the position of the previous record in the list 
of selected records. The bucket must be defined as Class Number. 

To enter a bucket name:

1. Do one of the following:

■ Click the down arrow to choose an existing bucket. 

■ Enter the name of a new bucket. 

NOTE:
You must type a left bracket ([) before the bucket name.

If the end of the list has been reached, the value of this bucket is set to null.
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Substring Mode

Use this mode to extract a substring from another string starting at a specified 
position. The first character in the string is defined as position “0”. 

For example, if the Source string is “abcdef” and the Start value is 2, then the 
Destination bucket will be valued with “cdef”. 

Layout

The Graphical Designer displays this screen (Figure B-29) to extract a substring 
from another string starting at a specified position. 

Figure B-29. Substring Mode Screen

Destination

Specifies the bucket that will contain the string to be extracted from the Source 
string. This bucket must be defined as Class Character. 

To enter a bucket name:

1. Do one of the following:

■ Click the down arrow to choose an existing bucket. 

■ Enter the name of a new bucket. 

NOTE:
You must type a left bracket ([) before the bucket name.

Source

Specifies the bucket that will contain the string from which the substring will be 
extracted. This bucket must be defined as Class Character. 
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To enter a bucket name:

1. Do one of the following:

■ Click the down arrow to choose an existing bucket. 

■ Enter the name of a new bucket. 

NOTE:
You must type a left bracket ([) before the bucket name.

Start

The position in the Source string at which to begin the extraction of the substring. 
The starting position of the first character is assigned the value “0”.

This value can be entered as a literal or specified as a bucket. The bucket must 
be defined as Class Number. 

To enter a bucket name:

1. Do one of the following:

■ Click the down arrow to choose an existing bucket. 

■ Enter the name of a new bucket. 

NOTE:
You must type a left bracket ([) before the bucket name.

Max Length

Specifies the maximum length of the string that can be placed in the Destination 
bucket. If the extracted string is longer than this length, the right-most characters 
are truncated.

This value can be entered as a literal value or specified as a bucket. The bucket 
must be defined as Class Number. 

To enter a bucket name:

1. Do one of the following:

■ Click the down arrow to choose an existing bucket. 

■ Enter the name of a new bucket. 

NOTE:
You must type a left bracket ([) before the bucket name.
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External Function Screen

Use this screen to call an external function during application execution. 

NOTE:
External Functions are defined using the External Function Definition Editor 
screen, which can be accessed from the Go menu located in the Menu Bar 
of the Design Pad screen.

Layout

The Graphical Designer displays this screen (Figure B-30) when you edit an 
External Function node in a call flow.

Figure B-30. External Function Screen

Toolbar

Return 

Returns to the previous screen.

Bucket Editor 
Displays the Bucket Editor screen.
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Buttons

Required?

Specifies whether the argument is required when sending data to or receiving 
data from an external function.

Prior Args 

Click this button if you are on the last page of arguments and you want to review 
a previously displayed argument.

Only 10 arguments can be displayed on a page. This button will be enabled if the 
external function has more than 10 arguments.  

More Args

Click this button to review the next page of arguments for the external function. 

Only 10 arguments can be displayed on a page. This button will be enabled if the 
external function has more than 10 arguments.  

Fields

Function Name

Specifies the function that you want to call from this node. 

To select a function:

1. Click the down arrow located next to this field to reveal a combo box 
containing the existing user/systems External Functions. 

2. Click an External Function name to select it.

All of the arguments defined for this External Function will be displayed in 
the Arguments field.

You can create a new External Function on the External Function Definition 
screen. This screen is accessed by selecting the External Function Definition 
Editor menu command in the Go menu of the Design Pad screen. 

Arguments (Name)

Lists the name, value, direction, and required status of each argument defined 
for the External Function selected.
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External Function Definition Editor 
Screen

Use this screen to define or edit any External Function accessed by an 
application.

 Layout

The Graphical Designer displays this screen (Figure B-31) when you select the 
External Function Definition Editor menu command located in the Go menu of the 
Design Pad screen.

Figure B-31. External Function Definition Editor Screen

Toolbar

Return 

Returns to the previous screen.

Update 
Updates the selected argument.
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Insert 
Inserts a new argument directly before the selected argument.

Append 

Inserts a new argument at the end of the argument list.

Delete 
Deletes the currently selected argument.

Bucket Editor 

Displays the Bucket Editor screen.

Buttons

System Function

Click this button to define the current External Function as a System Function. If 
left blank, the External Function will be defined as a User Function.

Required? 

Click this button to specify whether or not the argument is required when 
interfacing with the External Function.

Fields

Function Name

Specifies the name of the External Function definition to view or edit. 

To select an existing External Function:

1. Click the down arrow to choose from a list of existing External Functions. 

2. Click an External Function name to select it.

To create a new External Function

1. Select the New Function menu command from the Functions menu 
located in the Menu Bar.

2. Enter the name of the new External Function.
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Help Message (Function)

Type in a message to appear in the dynamic context-sensitive help area in the 
bottom left portion of the screen. The message appears whenever the user 
passes the mouse over the Function Name field on the External Function screen.

Return Code Help Message 

Type in a message to appear in the dynamic context-sensitive help area in the 
bottom left portion of the screen. The message appears whenever the user 
passes the mouse over the Put return code in field on the External Function 
screen.

Name (Argument)

Enter the name of the argument in this field. You can create or add arguments in 
this field.  

To create a new argument:

1. Type in the Argument name. 

2. Define the Class, Direction, and Help Message for the argument.

3. Click the Append Argument Tool to add the record to the end of the 
Argument list.

You can also select the New menu command from the Arguments menu located 
in the Menu Bar. 

Class 

Specifies the class of data for the argument listed in the Name field.

To select a class of data:

1. Click the down arrow to choose a data class. The available data classes 
are character, currency, date, number, real, and time.

2. Click a class name to select it.

Direction

Specifies the direction of the argument data flow. 
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To select a direction:

1. Click the down arrow to choose from a list of directions for the argument.

■ Right arrow: Indicates that the argument is being sent TO the 
External Function.

■ Left arrow: Indicates that the argument is being sent FROM the 
External Function.

■ Double arrow: Indicates that the argument is being sent TO and 
received FROM the External Function.

2. Click a Class name to select it.

Help Message (Argument)

Type in a message to appear in the dynamic context-sensitive help area in the 
bottom left portion of the screen. The message appears whenever the user 
passes the mouse over the Arguments fields on the External Function screen.

Argument List

Click a line to select an argument from the list. The argument will appear in the 
change area above the list where you can modify it. 

To add arguments to an External Function:

1. Enter the argument information in the area above the argument list.

2. Click the Append Argument Toolbar button to add the argument to the list.

To change an argument on the list: 

1. Select the argument by clicking on it.

2. Make any changes in the area above the argument list.

3. Click the Change Argument Toolbar button to change the argument 
information.

To delete an argument from the list:

1. Select the argument by clicking on it.

2.  Click the Delete Argument Toolbar button to delete the argument.

To insert an argument directly above the selected argument:

1. Enter the argument information in the area above the argument list.

2. Select a line in the argument list by clicking on it.

3. Click the Insert Argument Toolbar button to insert the new argument 
directly above the selected line.
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FlexWord Editor Screen

Use this screen to define the grammars in the wordlist(s) defined for an 
application using FlexWord speech recognition. 

FlexWord speech recognition allows the application developer to create custom 
grammars for an application instead of using the standard grammars available. It 
is used so callers can speak the name of a function or menu option rather than 
having to remember a numbered option. 

Layout

The Graphical Designer displays this screen (Figure B-32) when you select the 
FlexWord Editor menu command from the Go menu located on the Design Pad 
screen.

Figure B-32. Flex Word Editor Screen

Toolbar

Return 

Returns to the previous screen.
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Fields

Wordlist Name

The wordlist name can be up to eight alphanumeric characters long and must 
begin with a character. To view or edit a wordlist:

1. Do one of the following:

■ Enter the name of the existing wordlist you want to view or edit.

■ Type in the name of a new wordlist. 

The system displays words or phrases to be associated with the wordlist 
name.

■ You may enter a maximum of 200 words per wordlist.

■ An application may contain a maximum of 100 wordlists.

■ The wordlist contents can be edited by clicking on the File menu 
displayed in the Menu Bar and selecting one of the menu commands.

■ Words that are similar sounding should not be included in the same 
wordlist because the recognizer will have difficulty distinguishing them.

■ Long words are recognized more accurately than shorter words. Avoid 
single-syllable words if possible.

■ Very long phrases (six or more words per phrase) are more likely to 
present recognition problems.

■ If the caller can be expected to speak one of the several synonyms in 
response to a prompt, the frequently expected synonyms should be 
included in the wordlist.

■ Each word or phrase in the wordlist must be entered on a separate line.
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Host Connect Screen

Use this screen to check the connection between an application and a host in the 
network.

The connection to the host should be checked before sending data to or 
receiving data from an application.

This object should be added to the call flow before a Call Answer object because 
host connectivity needs to be established before processing incoming calls. 
Otherwise, the caller may be subjected to a period of silence (up to 5 seconds) 
while the connection is being checked.

Layout

The Graphical Designer displays this screen (Figure B-33) when you edit a Host 
Connect node in the call flow.

Figure B-33. Host Connect Screen
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Toolbar

 Return

Returns to the previous screen.

Fields

Host Name

Specifies the name of the host machine for which you want to check the 
connection status. You can select the name of the host by clicking the Host 
Name field or the down arrow. A combo box appears containing the names of the 
hosts you have defined for this application.

 To enter the name of the host:

1. Do one of the following:

■ Click the Host Name field.

■ Click the down arrow located next to the Host Name field and then 
click a host name to select it.

If the host does not appear in the Host Name list, you can define a new host by 
clicking on the Go menu in the Menu Bar of the Design Pad screen.  Select the 
Host Definition Editor menu command.

Connection Time-out

Specifies the amount of time (in seconds) for the connection timeout parameter. 
If the host does not respond in the amount of time allotted in the Connection 
Timeout field, the host is not connected to the application.
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Host Definition Editor Screen

Use this screen to define the interface to host machines in the network.

The host should be defined using this series of screens before host objects are 
used in the call flow. 

Layout

The Graphical Designer displays this screen (Figure B-34) when you select the 
Host Definition Editor menu command located in the Go menu of the Design Pad 
screen.

Figure B-34. Host Definition Editor Screen

Toolbar (Main)

Return

Returns to the previous screen.
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Screen Identification Editor

Click this button to go to the Host Screen Identification Editor screen to define the 
screens associated with this host.

Field Definition Editor

Click this button to go to the Host Field Definition Editor screen to define the data 
on the screens associated with this host.

Toolbar (Secondary)

Update Current Entry

Updates the currently selected login or password.

Insert New Entry

Inserts a new entry before the currently selected login or password.

Append Entry

Adds a new login or password to the end of the list.

Delete Entry

Deletes the currently selected login or password.

Fields

Name

Specifies the name of a new or existing host. Click the down arrow to reveal a 
combo box which contains a list of existing hosts. 

If the Host does not appear in the combo box, create a new Host.

To create a new Host:

1. Click Host Definition Editor in the Menu Bar.

2. Do one of the following:

■ Select the New Host menu command and press .

■ Enter a new host name in the Name field.

The system displays a dialog box where you can enter the name of the 
new host.

ENTER
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Host Timeout

Select the time (in seconds) to wait for the first screen of data from the host. If the 
host does not respond in this time frame, a Timeout condition occurs. 

NOTE:
If this field is populated with zero (0), the application waits indefinitely for 
the first screen of data to be sent from the host.

Unrecognized Screen Timeout

Select the time (in seconds) to wait for another screen of data from the host after 
a screen is received that cannot be recognized by the application. If no other 
data is received from the host, the Failure branch is executed.

Logical Unit Timeout

Select the time (in seconds) to wait for a Logical Unit to be assigned to the 
application. If a Logical Unit is not available within the time frame specified, a 
Timeout condition occurs.

Login

The Login and Password fields are entered as a pair. The order of this 
information is important and can be updated by utilizing the components of the 
Secondary Toolbar. 

To create a new Login:

1. Type in a Login valid for this host machine.

2. Press  to enter a password.

If a password is not required, do one of the following to add the login to the list.:

■ Click the Append Entry Toolbar button.

■ Press .

To edit an existing login:

1.  Click in the Login list to select an entry to update.

The system displays the Login entry in the box above the list.

2. To update the information, click the Update Current Entry Toolbar button.

TAB

ENTER
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Password

Press  to move from the Login field to the Password field. 

To create a new Password:

1. Type in a Password to be associated with the Login selected for this host 
machine.

2. Do one of the following:

■ Click the Append Tool to add the entry to the list.

■ Select Add Entry to add the entry below the currently selected item.

To edit an existing password:

1.  Click in the Password list to select an entry to update. 

The system displays the password entry in the box above the list.

2. To update the information, click the Update Current Entry Toolbar button.

TAB
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Host Field Definition Editor Screen

Use this screen to define fields on screens sent to or received from a host.

Layout

The Graphical Designer displays this screen (Figure B-35) when you click the 
Field Definition Editor Toolbar button on the Host Definition Editor and Host 
Screen Identification Editor screens.

Figure B-35. Host Field Definition Editor Screen

Toolbar

Return

Returns to the previous screen.

Screen Identification Editor

Click this button to go to the Host Screen Identification Editor screen to define the 
screens associated with this host.
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Bucket Editor 
Displays the Bucket Editor screen.

Buttons

Blank Screen

Click this button if the Screen Definition portion of the screen will be blank. If you 
select this box, the Field Definition portion of the screen is disabled.

Screen Definition Fields

The following fields are used to define the screen layout to a host.

■ Screen Name: Type in or select the name to be assigned to the screen.

■ Base Type: Specify the screen type. The available options are Login, 
Transaction, or “None”.

Field Definitions Fields

Name

Specifies the name of the field to be defined for this screen.

ID

The ID is automatically assigned and indicates the occurrence number of the 
field. Use this number or type another ID number over it.

For example, if the field name “Found Baggage” appeared twice in the Field 
Definitions field, the first occurrence will be assigned an ID of “1” and the 
second occurrence will be assigned an ID of “2”.

Row 

Specifies the number of the row within the screen data from which the field 
originates. The maximum number of rows in a field definition is 24.

Column

Specifies the number of the column within the screen data from which the field 
originates. The maximum number of columns in a field definition is 80. The 
excess data wraps around to the next available row, as long as the row number 
is not 24.
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Length

Specifies the length of the field.

Direction

Specifies the direction of the information flow. Field information can be sent to the 
host, received from the host, or both.

■ To Host: field data is sent from the application to the host.

■ From Host: field data is received from the host.

■ Both: field data is sent to and received from the host.

Click a Direction to select it.

Class

Defines the class of the field data. The available classes are:

■ Character: alphanumeric values

■ Number: numeric values

Click a Class to select it.
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Host Flow Editor Screen

Use this screen to define the Login, Logoff, and Recovery sequence for a host 
machine.

Layout

The Graphical Designer displays this screen (Figure B-36) when you select the 
Host Flow Editor menu command located in the Go menu of the Design Pad 
screen.

Figure B-36. Host Flow Editor Screen
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Host Receive Screen Field Mapping

Use this screen to define the buckets that will be associated with the selected 
fields on the defined Receive screen.

The fields that appear on this screen represent data sent to or received from the 
Host.

The bucket defined to the field contains the data associated with the field name.

Layout

The Graphical Designer displays this screen (Figure B-37) when you click the 
Field Mapping button located on the Host Send/Receive screens. 

Figure B-37. Host Receive Screen Field Mapping

Toolbar

Return 

Returns to the previous screen.
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Bucket Editor 
Displays the Bucket Editor screen.

Map Fields to Buckets

Click this button to automatically map buckets that have the same name as the 
field names displayed.

Fields

Field Names

Fields are listed for the Receive screen named “Screen 1”. Only fields where the 
direction is defined as “From Host” or “Both” are displayed in the Mapping field.

Field ID’s

The Field ID defined for each field appears next to the Field Name. If there is 
more than one occurrence of Field Name, the Field ID is incremented by one for 
each subsequent occurrence. This is done to create a unique Field Name/Field 
ID pairing.

Bucket Names

Assign buckets to contain the data sent from the host for the corresponding Field 
Names listed in the Mapping field. A bucket must be assigned to each field that 
you expect to receive data from the host.

You can select an existing bucket or create a new bucket. You can also click the 
Map Fields to Buckets button to automatically assign a bucket to the field of the 
same name.
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Host Screen Identification Editor 
Screen

Use this screen to define the screen identification information on screens sent to 
or received from a host.

Layout

The Graphical Designer displays this screen (Figure B-38) when you click the 
Screen Definition Editor Toolbar Button on the Host Definition Editor Screen or 
Host Field Identification Screen.

Figure B-38. Host Screen Identification Editor Screen

Toolbar (Main)

Return

Returns to the previous screen.
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Field Definition Editor

Click this button to go to the Host Field Definition Editor screen to define the field 
data on the screens associated with this host.

Toolbar (Secondary)

Update Current Entry

Updates the currently selected entry

Insert New Entry

Inserts a new entry before the currently selected entry.

Append Entry

Adds a new entry to the end of the list.

Delete Entry

Deletes the currently selected entry.

Buttons

Blank Screen

Click this button if the current screen will be blank. If this box is selected, the 
Field Identification portion of this screen is blank.

Screen Definition Fields

The following fields are used to define a screen layout to a host.

Screen Name

Specifies the name to be assigned to the screen.

Base Type

Specifies the screen type. The available options are Login, Transaction, or 
“None”.
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Screen Identification Fields

These fields are used to define areas of the screen which will uniquely identify 
the screen to the host. There must be at least one Text Absent, Text Present, or 
Cursor field defined in the Screen Identification field if the Blank Screen 
box is not selected.

Row

Defines the starting row position of the Screen Identification Field.

Column

Defines the starting column position of the Screen Identification Field.

Type

Specifies wither the Screen Identification field is populated with text or a 
cursor. The available options are:

■ Text Present: type in the text that appears in the field selected. 

NOTE:
Data in Text Present fields cannot overlap. 

■ Text Absent: type in the text that should not appear in the field selected. 

NOTE:
Data in the Text Absent fields can overlap.

■ Cursor: a cursor will appear at the row and column specified. 

NOTE:
Only one cursor can be defined for a screen in the Screen 
Identification field.

Text

If Text Present or Text Absent has been selected as the field type, type in the text 
to be present in or absent from the row and column specified.
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Host Send Screen Field Mapping

Use this screen to define the buckets that will be associated with the selected 
fields on the defined Send screen. 

Layout

The Graphical Designer displays this screen (Figure B-39) when you click the 
Define Screen Field Mappings Button on the Host Send screen.

Figure B-39. Host Send Screen Field Mapping

Toolbar

Return 

Returns to the previous screen.

Bucket Editor 
Displays the Bucket Editor screen.
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Map Fields to Buckets

Click this button to automatically map buckets that have the same name as the 
fields displayed.

Fields

Field Names

Fields are listed for the Send screen named “Screen 1”. Only fields where the 
direction is defined as “To Host” or “Both” are displayed,

Field ID’s

The Field ID for each field is displayed here. If there is more than one occurrence 
of field name, the Field ID is incremented by one for each subsequent 
occurrence. This is done to create a unique Field Name/Field ID pairing.

Bucket Names

Assign a bucket to each field you expect to send data to the host.

You must specify a bucket to be associated with a field you define to send data 
to the host.

You can select an existing bucket or create a new bucket. You can click also 
click the Map Fields to Buckets Toolbar button to automatically assign a bucket 
to the field of the same name.
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Host Send Screen

Use this screen to define the names of screens sent to a host in the network.

NOTE:
You must have already defined the Host to this application on the Host 
Definition Editor Screen to populate the fields on this screen.

Layout

The Graphical Designer displays this screen (Figure B-40) when you edit a Host 
Send node in the call flow.

Figure B-40. Host Send Screen

Toolbar

Return

Returns to the previous screen.
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Buttons

Release Logical Unit

Click this button to release the Logical Unit after data is sent to the host to free 
available host Logical Unit resources.

Define Field Mappings

Click this button to map buckets to the fields defined for this screen.

Fields

Host Name

Select the name of the Host to which the screen data is to be sent. You can click 
the down arrow to reveal the list of defined hosts.

If the host does not appear on the selection list, define a new host on the Host 
Definition Editor screen. The Host Definition Editor screen is accessed by 
clicking on the Go menu located in the Menu Bar of the Design Pad screen.

Send Screen Name

Select the name of a screen to contain the data to be sent to the host. You can 
click the down arrow to reveal the list of available defined Send screens for this 
host.

If you want to define a new Send screen for this host, go to the Host Definition 
Editor screen located in the Go menu of the Design Pad screen. Once on the 
Host Definition Editor screen, click the Hosts menu and select the New Host 
menu command.

Aid Key

Select a key to specify to the host which type of data is being transmitted. The list 
of available aid keys can be viewed by clicking on the down arrow. Click an aid 
key to select it.
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Host Send/Receive Screen

Use this screen to define the screen names of the data sent to and received from 
a host in the network.

NOTE:
You must have already defined the Host to this application on the Host 
Definition Editor Screen to populate the fields on this screen.

Layout

The Graphical Designer displays this screen (Figure B-41) when you edit a Host 
Send/Receive node in the call flow.

Figure B-41. Host Send / Receive Screen

Toolbar

Return

Returns to the previous screen.
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Buttons

Release Logical Unit

Click this box to release the host connection after screen data has been sent to 
or received from the host.

Define Field Mappings

Click this button to go to map buckets to the fields defined on the selected 
screen.

Fields

Host Name

Select the Host from which to send or receive screen data. You can click the 
down arrow to reveal the list of available defined hosts.

If you need to create a new Host, access the Host Definition Editor screen by 
clicking on the Go menu located in the Menu Bar of the Design Pad screen. 
Select the New Host menu command located in the Hosts menu.

Send Screen Name

Select the name of a screen to be sent to the host. You can click the down arrow   
to reveal the list of available send screens defined for this host.

If you need to define a new Send Screen for a Host, go to the Host Definition 
Editor screen which is accessed by clicking on the Go menu located in the Menu 
Bar of the Design Pad screen. Click the Screen Definition Editor button located in 
the Toolbar of the Host Definition Editor.

Aid Key

Select a key to specify to the host which type of data is being transmitted. The list 
of available aid keys can be viewed by clicking on the down arrow. Click an aid 
key to select it.

Receive Screen Name

Each branch that was inserted into the node contains the name of a Receive 
screen. The data received from the host are contained in these screens.

You can click the up and down arrows to navigate through the list of Receive 
Screen Names.
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To add a Receive Screen Name:

1. Edit the Send/Receive object in the call flow. 

2. Click the Insert Branch menu command in the popup menu. 

The system displays a dialog box containing all of the screens where at 
least one field has the direction defined as “From Host” or “Both”. 

3. Click a Receive screen name to select it. When you go back into the Host 
Send/Receive node, the Receive screen names for the branches you 
inserted will appear in this field.

To define a new Receive screen for this Host:

1. Go to the Host Definition Editor screen by clicking on the Go menu located 
in the Menu Bar of the Design Pad screen. 

2. Once on the Host Definition Editor screen, click the Screen Definition 
Editor button located in the Toolbar.
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Menu Screen

Use this screen to define a menu of options to be played to the caller.

Layout

The Graphical Designer displays this screen (Figure B-42) when you edit a Menu 
node in a call flow.

Figure B-42. Menu Screen

Toolbar

Return

Returns to the previous screen.

Bucket Editor

Displays the Bucket Editor screen.
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Table Editor

Displays the Table Editor screen.

Buttons

ASR

Click this button to display the ASR Parameters dialog box, where you can 
specify the grammar to be used for Automatic Speech Recognition.

More

Click this button to display the Voice Response Parameters dialog box, where 
you can enter more detail about the Menu node’s behavior.

Fields

Announcement Initial Prompt

This field contains the name of the prompt to be played when the Menu node is 
executed. The default name of the prompt is the name of the Menu node being 
edited.

To enter a prompt name, you can select an existing prompt or create a new 
prompt.

To select an existing prompt:

1. Click the down arrow to display a list of existing prompts. 

2. Click a prompt name to select it. 

The system displays the text of the prompt you have selected in the box 
underneath the Initial Prompt: field.

To create a new prompt:

1. Enter the name of a new prompt in the Initial Prompt: field. 

The system displays the Announcement Editor screen. 

To enter or edit the prompt text:

1. Do one of the following:

■ Press .

■ Click the box located underneath the Initial Prompt: field. 

The system displays the Announcement Editor screen. 

2. Type the text for a new prompt or edit the text of an existing prompt. 

ENTER
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Error Prompts - Bad Input

This field holds the name of the prompt played when the caller enters an invalid 
response. 

To select an existing prompt:

1. Click the down arrow to display a list of existing prompts. 

2. Click a prompt name to select it.

The system displays the text of the prompt you have selected in the box 
underneath the Bad Input: field.

To create a new prompt:

1. Enter the name of a new prompt in the Bad Input: field. 

The system displays the Announcement Editor screen. 

To enter or edit the prompt text:

1. Do one of the following:

■ Press .

■ Click the box located underneath the Bad Input: field. 

The system displays the Announcement Editor screen. 

2. Type the text for a new prompt or edit the text of an existing prompt. 

Error Prompts - Timeout

This field holds the name of the prompt played when the caller fails to enter a 
response within the required amount of time. 

To enter a prompt name, you can select an existing prompt or create a new 
prompt.

To select an existing prompt:

1. Click the down arrow to display a list of existing prompts. 

2. Click a prompt name to select it.

The system displays the text of the prompt you have selected in the box 
underneath the Timeout: field.

To create a new prompt:

1. Enter the name of a new prompt in the Timeout: field. 

The system displays the Announcement Editor screen. 

ENTER



Screen Reference

B-108 Issue  2.0   August 1997 

To enter or edit the prompt text:

1. Do one of the following:

■ Press .

■ Click the box located underneath the Timeout: field. 

The system displays the Announcement Editor screen. 

2. Type the text for a new prompt or edit the text of an existing prompt. 

Error Prompts - Too Few Digits

This field holds the name of the prompt played when the caller fails to enter 
enough digits in his or her response. To enter a prompt name, select an existing 
prompt or create a new prompt:

To select an existing prompt:

1. Click the down arrow to display a list of existing prompts. 

2. Click a prompt name to select it.

The system displays the text of the prompt you have selected in the box 
underneath the Too Few Digits: field.

To create a new prompt:

1. Enter the name of a new prompt in the Too Few Digits: field. 

The system displays the Announcement Editor screen. 

To enter or edit the prompt text:

1. Do one of the following:

■ Press .

■ Click the box located underneath the Too Few Digits: field. 

The system displays the Announcement Editor screen. 

2. Type the text for a new prompt or edit the text of an existing prompt. 

ENTER

ENTER
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Node Classes Dialog Box

Use this dialog box to choose a node class (or object type) when creating a new 
node. 

Layout

The Graphical Designer displays this screen (Figure B-43) when you do either of 
the following:

■ Select the New Node menu command in the Edit menu of the Design Pad 
screen.

■ Click the New Node menu command in the popup menu.

Figure B-43. Node Classes Screen

Buttons

Cancel

Click here to cancel without selecting a node to add to the call flow.
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OK

Click here to add the highlighted node to the call flow at the currently selected 
branch.

To select a Node Class:

1. Do one of the following:

■ Double click an icon to select it,

■ Click the icon to select it, then click the OK button.
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Nodes Dialog Box

Use this dialog box, containing a list of the existing nodes in your call flow, to 
define a Jump To node. 

When you select one of the Nodes in the dialog box, a placeholder for that node 
connects to the call flow at the highlighted branch.

Layout

The Graphical Designer displays this screen (Figure B-44) when you select the 
Jump to Node command from the popup menu.

Figure B-44. Nodes Screen

Buttons

Cancel

Click here to cancel without selecting a Jump To node.
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OK

Click here to add the highlighted node to your call flow at the currently selected 
branch.

To select a Jump To node:

1. Do one of the following:

■ Double click a node to select it.

■ Click a node to select it and then click the OK button.

A jump to the specified node will occur when this node is executed.
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Node Verification Errors/Warning 
Window

Use this screen to identify potential problems in a call flow before simulation is 
run or code is generated. 

Select the Verify Design menu command from the Edit Menu of the Design Pad 
Screen to display a list of all of the errors and/or warnings for a particular design.

Layout

The Graphical Designer displays this screen (Figure B-45) when you do any of 
the following: 

■ Omit information that is necessary to fully define the object characteristics 
for a node.

■ Choose to audit your entire design. 

■ Enter and/or leave a Node Editor screen. 

NOTE:
You can specify when you want this window to display on the Defaults 
Editor screen.

Figure B-45. Node Verification Errors/Warning Window
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Buttons

OK

Click here to ignore the errors and/or warnings and return to the Design Pad 
screen without making any of the suggested changes to the node.

Cancel

Click here to return to the Node Editor screen to make the suggested changes to 
the node.

Suppress

Click this button to suppress the appearance of the Node Verification 
Errors/Warning window the next time you edit this node.

Errors/Warning Field

Displays a complete list of errors and warnings that identify missing attributes 
and prompts required to complete the object characteristics for the selected 
node.
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Generating Code

Use this screen to generate code for a design. Choose one of the following three 
procedures.

Using a Menu Command

1. Select the Generate Code menu command from the File menu located in 
the menu bar.

The system displays a dialog box (Figure B-46) telling you that you must 
save your design before the code can be generated.

Figure B-46. Save Design Dialog Box

2. Select Continue.

The system displays the Code Generation screen.

3. Select the files for which you want to generate code.

4. Select Generate Code.

The system displays a dialog box (Figure B-47) requesting a talkfile 
number.
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Figure B-47. Generate Code Dialog Box

5. Type the talkfile number for the application to use.

The system displays a dialog box indicating that the code generation is 
complete. The application directory has the same name as the design and 
is located under the Apps directory.

Using a Shortcut Key

1. Select the File menu located in the menu bar and type G

The system displays a dialog box telling you that you must save your 
design before the code can be generated.

2. Select Continue.

The system displays the Code Generation screen.

3. Select the INTUITY CONVERSANT files for which you want to generate 
code.

4. Select Generate Code.

The system displays a dialog box requesting a talkfile number
(Figure B-47).

5. Enter the talkfile number.

The system displays a dialog box indicating that the code generation is 
complete. The application directory has the same name as the design and 
is located under the Apps directory.

Using a Toolbar button

1. Select the Generate Code button located in the Toolbar.

The system displays a dialog box telling you that you must save your 
design before the code can be generated.

2. Select Continue.

The system displays the Code Generation screen.
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3. Select the INTUITY CONVERSANT files for which you want to generate 
code.

4. Select the Generate Code button.

The system displays a dialog box requesting a talkfile number
(Figure B-47). 

5. Enter the talkfile number for the application to use.

The system displays a dialog box indicating that the code generation is 
complete. The application directory has the same name as the design and 
is located under the Apps directory.
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C
File Organization

Overview

This appendix lists the directory structures of INTUITY™ CONVERSANT® 
Graphical Designer.

By default, the main directory for Graphical Designer is loaded on your C drive 
with the directory name GraphD.

Purpose

The purpose of this chapter is to provide reference information about the 
Graphical Designer file structure.
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Main Directory Structure

To reveal the Graphical Designer main directory structure (Table C-1), select the 
default GraphD directory, or the directory where you indicated Graphical 
Designer be installed.

Table C-1. Graphical Designer Main Directory Structure 

Directory
(File) Description

\apps Contains a directory for each application created. The 
directory has the same name as the application name.

\code Contains the core INTUITY CONVERSANT Graphical 
Designer modules. The Readme file contains release notes 
for the version of the Graphical Designer that you are 
running.

\datafile Contains the following types of files:

■ Automatic Speech Recognition (ASR) grammars — 
Grammar files have the extension .grm

■ External function — Holds definitions for all of the 
external functions defined to the application

\help Contains the files used to generate the on-line help 
information.

\hostobj Contains the module used to control objects for Host 3270 
applications.

\objects Contains the modules used to define Graphical Designer 
service creation objects.

\sound This directory will not contain any files.

\tables Contains the Dynamics directory where table values 
updated during simulation reside.

\targets Contains the module required to generate code for each 
supported target platform. 

Continued on next page
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Application Directory Structure

Table C-2 lists the Graphical Designer Application Directory Structure.

! CAUTION:
The files and directories listed below are required to run the Graphical 
Designer. Do not delete any of the directories or modify any of the files. 

Table C-2. Graphical Designer Application Directory Structure 

Directory
(File) Description

\apps Contains all of the file information for the application created in the 
INTUITY CONVERSANT Graphical Designer. Each application is stored in 
a separate directory where the design name is the name of the directory. 
An additional directory called backup also appears in the apps 
directory.

A copy of the application the user is currently working on is created in 
the backup directory each time an automatic backup is performed. You 
can specify the amount of time between automatic backups by selecting 
the Backup Interval menu command located in the Edit menu on the 
Design Pad screen.

This directory contains the following files:

■ appl — Contains application-level information.

■ buckets — Contains all information for the buckets defined in the 
application.

■ phrases — Contains all of the phrases in the application.

■ flow (n) — A flow file created for each call flow defined in the 
application, where n is an consecutively numbered integer 
beginning with 1.

\data Contains the following directories and file types:

■ Runtime directory — Contains data used when simulating the 
application.

■ Host definition files — A file for each Host defined in the application 
will be created in this directory.

Host files have the extension .txt.

\images This directory will not contain any files.

Continued on next page
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\print Contains a file for each component you have selected on the Print 
Reports screen if you select the Word RTF Printer Option.

The following files will be present in print directory if the corresponding 
print component was selected:

■ buckets.doc — Listing of the buckets defined in the application

■ callflow.doc — Listing of the callflow outline

■ custom.doc — Listing of the buckets defined in the Event Record

■ dbschema.doc — Listing of the database schema for each 
database table defined in the application

■ hcallflw.doc — Listing of the Host Flow

■ hnodes.doc — Listing of node information for each host-related 
node in the application

■ host.doc — Listing of host definition information for each host 
defined in the application

■ phrase.doc — Listing of all the phrases in each Phrase Table 
defined in the application

■ prompt.doc — Listing of all the prompts defined in the application

\sound Contains a file for each phrase that has been recorded. Sound files have 
the .wav file extension.

\tables Contains a file for each table defined in the application. The tables 
directory also contains the Dynamics directory where table updates 
during Simulation are stored. 

Table C-2. Graphical Designer Application Directory Structure  — Continued  

Directory
(File) Description

Continued on next page
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\target Contains the files required to install the application on the target 
platform. 

The following files will appear in the Target directory depending on the 
components defined to the application:

■ manifest — Lists all of the files in the Target directory to be bundled 
for the platform.

■ params — Contains INTUITY-CONVERSANT-specific files.

■ symbols — Contains INTUITY-CONVERSANT-specific files related to 
table management.

■ <application name>.ccv — Contains a number indicating the 
percentage of nodes in the application that have been tested in 
simulation.

■ <application name>.d — Contains a description of the Event 
Record.

■ <application name>.fea — Contains a listing of the components 
required on the INTUITY CONVERSANT system for the application to 
successfully run. 

■ <Wordlist name>.flx — You must copy any wordlists in this 
directory to each subsequent release of the Graphical Designer in 
order for the wordlists to be accessible in that version.

■ <application name>.h — Header file that contains the # defines and 
space definitions for the application.

■ <host name>.hs — Contains the host login script. One file will be 
generated for each host defined in the application.

■ <application name>.pl — Contains the phrase list.

■ <application name>.sql — Contains the table schema and data 
population instructions for each table defined in the application.

■ <application name>.t — Contains the application INTUITY 
CONVERSANT script.

■ <application name>.toc — Defines the files required to store the 
application in the platform repository.

\text This directory will not contain any files.

Table C-2. Graphical Designer Application Directory Structure  — Continued  

Directory
(File) Description

Continued on next page
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File Limitations for the INTUITY
CONVERSANT Graphical Designer 

In Table C-3, the file name is listed along with the Toolbook limitation for file size. 
It is important to monitor the size of each type of file during the creation of an 
application. If any of the file size limitations specified above are exceeded, the 
design may become corrupted

To check the size of files during application development:

1. Select the Application Version menu command from the File menu on the 
Design Pad screen. Each file will be listed along with its current size. 

Table C-3. Graphical Designer File Limitations

File Should Not Exceed

appl 65 Kbytes

buckets 65 Kbytes

phrases 65 Kbytes plus a limit of 32 Kbytes per Phrase Table

prompts 65 Kbytes

call flow 110 nodes

Host Definition 65 Kbytes

Database Table 65 Kbytes for a database table schema with data contents

Continued on next page
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D
Annotated Sample Call Flows

Overview

This appendix contains a printout of the call flows for each sample application 
included with the Graphical Designer.

Purpose

The purpose of this chapter is to provide call flow examples to facilitate 
application development.
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Holiday1 MCall Flow

This section includes an annotated copy of the call flow for the sample 
application Holiday1. The Holiday1 application uses a database table named 
Holidays to register any number of days as holidays. Then any given date can be 
matched against the table entries to determine if the date is a holiday. The 
Holiday1 application first checks to see if the current date is in the table. It then 
gives the caller a menu to recycle the same check date, enter a new date to 
check, or hear a list of all dates in the table and select one of those. 

■ This application uses text-to-speech (TTS) to say all announcements and 
prompts; therefore, no speech is recorded.

[Main]

,,—,AnswerPhone
ô,Î,ò,PlayGreeting
÷ô,Î,î,SetCheckDateEqualToday
÷÷ô,(default),ò,TellCheckDate
÷÷÷ô,Î,ÿ,CheckHolidaysTable
÷÷÷÷õ,Ñ,ò,Tell_NOT_Holiday
÷÷÷÷öô,Î,ï,>PlayRecycleMenu
÷÷÷÷õ,Í,ò,TellHoliday
÷÷÷÷öô,Î,ï,>PlayRecycleMenu
÷÷÷÷õ,Ì,,
÷÷÷÷ô,Ò,,

,,ï,PlayRecycleMenu
õ,Ú,ò,>TellCheckDate
õ,Û,ñ,GetNewDate
öõ,Î,î,SetCheckDateEqualNewDate
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ööô,(default),ò,>TellCheckDate
öô,Ò,,
õ,Ü,ÿ,GetAllHolidaysIn95
öõ,Ñ,,
öõ,Í,,
öõ,Ì,ý,AutoMenuHolidays
ööõ,Î,ò,TellSelectDate
öööô,Î,î,SetCheckDateEqualSelectDate
ööö÷ô,(default),ò,>TellCheckDate
ööô,Ò,,
öô,Ò,,
õ,á,ò,PlayFarewell
öô,Î,,
ô,Ê,,
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Holiday2 Call Flow

This section includes an annotated copy of the call flow for the sample 
application Holiday2. This application illustrates how to use a TimeBranch node 
to determine if the date of a call is a holiday. The TimeBranch node has an exit 
branch for each date considered a holiday. When the application goes through 
the node, it compares the current date in the bucket [DATE], to each successive 
branch date. If it matches the date on any branch, that branch is taken and a Set 
node then assigns a name for the holiday in the bucket [HOLIDAY_NAME]. The 
application then says whether or not the date is a holiday and the holiday name if 
appropriate. Finally, it gives the caller a choice to choose another option or end 
the call.

[Main]

,,—,AnswerPhone
ô,Î,ò,PlayGreeting
÷ô,Î,î,SetCheckDateEqualToday
÷÷ô,(default),ò,TellCheckDate
÷÷÷ô,Î,ð,[CheckForHoliday](1)
÷÷÷÷õ,(GotHoliday),ò,TellHoliday
÷÷÷÷öô,Î,ï,>PlayRecycleMenu
÷÷÷÷ô,(Default),ò,Tell_NOT_Holiday
÷÷÷÷÷ô,Î,ï,PlayRecycleMenu
÷÷÷÷÷÷õ,Ú,ò,>TellCheckDate
÷÷÷÷÷÷õ,á,ò,PlayFarewell
÷÷÷÷÷÷öô,Î,,
÷÷÷÷÷÷ô,Ê,,
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[CheckForHoliday]

,,î,ResetDate
ô,(default),ú,HolidayTest
÷õ,Jan_01-Jan_01,î,SetHolidayName_
NewYears
÷öô,(default),ó,(GotHoliday)
÷õ,Jan_16-Jan_16,î,SetHolidayName_
MLKingDay
÷öô,(default),ó,>(GotHoliday)
÷õ,Feb_20-Feb_20,î,SetHolidayName_
PresidentsDay
÷öô,(default),ó,>(GotHoliday)
÷õ,May_29-May_29,î,SetHolidayName_
MemorialDay
÷öô,(default),ó,>(GotHoliday)
÷õ,Jul_04-Jul_04,î,SetHolidayName_
IndependenceDay
÷öô,(default),ó,>(GotHoliday)
÷õ,Sep_04-Sep_04,î,SetHolidayName_
LaborDay
÷öô,(default),ó,>(GotHoliday)
÷õ,Oct_09-Oct_09,î,SetHolidayName_
ColumbusDay
÷öô,(default),ó,>(GotHoliday)
÷õ,Nov_23-Nov_23,î,SetHolidayName_
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ThanksgivingDay
÷öô,(default),ó,>(GotHoliday)
÷õ,Dec_25-Dec_25,î,SetHolidayName_
ChristmasDay
÷öô,(default),ó,>(GotHoliday)
÷ô,(Other),,

Hours1 Call Flow

This section includes an annotated call flow for the sample application Hours1. 
This application contains three subroutines that illustrate how to handle different 
service-hour scenarios. The three subroutines are included in a simple call flow 
that answers the telephone, plays a greeting, then plays a menu that lets the 
caller select one of the subroutines. Each subroutine simply determines if the 
current time is “in hours” or “out of hours.” The call flow then plays a 
corresponding message and returns to the menu, so the caller can try a different 
subroutine. The application uses text-to-speech (TTS) to say the messages; 
therefore, no speech is recorded for the application.

■ Call flow branches without an attached node are “terminal nodes.” If the 
call flow reaches the terminal node, the voice response unit hangs up the 
telephone and stops the application.

■ The application uses text-to-speech (TTS) to say the messages; therefore, 
no speech is recorded for any of the prompts in the application.

[Main]

,,—,AnswerPhone
ô,Î,ò,PlayGreeting
÷ô,Î,ï,PlayMenuToSelectSubroutine
÷÷õ,Ú,ò,TellRegular1
÷÷öô,Î,ð,[CheckBusinessHours_
Regular1](1)
÷÷ö÷õ,(OutOfHours),ò,PlayOutOfHoursMe
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ssage
÷÷ö÷öô,Î,ï,>PlayMenuToSelectSubroutine
÷÷ö÷ô,(Default),ò,PlayInHoursGreeting
÷÷ö÷÷ô,Î,ï,>PlayMenuToSelectSubroutine
÷÷õ,Û,ò,TellIrregular1
÷÷öô,Î,ð,[CheckBusinessHours_
Irregular1](1)
÷÷ö÷õ,(OutOfHours),ò,>PlayOutOfHoursM
essage
÷÷ö÷ô,(Default),ò,>PlayInHoursGreeting
÷÷õ,Ü,ò,TellRegular2
÷÷öô,Î,ð,[CheckBusinessHours_
Regular2](1)
÷÷ö÷õ,(Shift_1),ò,>PlayInHoursGreeting
÷÷ö÷õ,(Shift_2),ò,>PlayInHoursGreeting
÷÷ö÷ô,(Default),ò,>PlayOutOfHoursMessag
e
÷÷õ,á,ò,SayGoodbye
÷÷öô,Î,,
÷÷ô,Ê,,
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 [CheckBusinessHours_Regular1]

,,ú,CheckDayOfWeek
õ,Mon-Fri,ú,CheckHours_MonFri
öõ,08:00-17:00,,
öô,(Other),ó,>(OutOfHours)
õ,Sat-Sat,ú,CheckHours_Saturday
öõ,09:00-15:00,,
öô,(Other),ó,>(OutOfHours)
ô,(Other),ó,(OutOfHours)

 [CheckBusinessHours_Irregular1]

,,ú,CheckDayOfWeek
õ,Mon-Mon,ú,CheckHours_LongDay
öõ,08:00-22:00,,
öô,(Other),ó,>(OutOfHours)
õ,Tue-Wed,ú,CheckHours_RegularDay
öõ,08:00-17:00,,
öô,(Other),ó,>(OutOfHours)
õ,Thu-Thu,ú,>CheckHours_LongDay
õ,Fri-Fri,ú,>CheckHours_RegularDay
õ,Sat-Sat,ú,CheckHours_ShortDay
öõ,09:00-15:00,,
öô,(Other),ó,>(OutOfHours)
ô,(Other),ó,(OutOfHours)
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 [CheckBusinessHours_Regular2]

,,ú,CheckDayOfWeek
õ,Mon-Fri,ú,CheckHours_MonFri
öõ,07:00-14:59,ó,(Shift_1)
öõ,15:00-23:00,ó,(Shift_2)
öô,(Other),,
õ,Sat-Sat,ú,CheckHours_Saturday
öõ,09:00-14:59,ó,>(Shift_1)
öõ,15:00-21:00,ó,>(Shift_2)
öô,(Other),,
ô,(Other),,
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Route_b1

This section includes an annotated call flow for the sample application Route_b1. 
The Route_b1 sample application demonstrates simple call routing (or call 
direction) using “blind transfer” to transfer an incoming call to another line. The 
script answers the telephone, plays a greeting message to the caller, then plays 
a menu offering to route the call to either sales, service, or accounting. Upon 
receiving a touchtone response of “1,” “2,” or “3,” the script uses the 
corresponding Call Transfer node to play a confirmation (for example, “Please 
hold for sales”) and transfers the call to the appropriate extension. It uses “blind 
transfer,” meaning it signals the switch to begin the transfer, dials the extension, 
completes the transfer, and drops the line. The transfer may succeed or fail, but 
either way the script is off the call.

■ Call flow branches without an attached node are “terminal nodes.” If the 
call flow reaches the terminal node, the voice response unit hangs up the 
telephone and stops the application.

■ The application uses text-to-speech (TTS) to say the messages; therefore, 
no speech is recorded for any of the prompts in the application.

 [Main]

,,—,AnswerPhone
ô,Î,ò,PlayGreeting
÷ô,Î,ï,PlayMenu
÷÷õ,Ú,¯,XferToSales
÷÷öõ,Î,,
÷÷öô,Ò,,
÷÷õ,Û,¯,XferToService
÷÷öõ,Î,,
÷÷öô,Ò,,
÷÷õ,Ü,¯,XferToAccounting
÷÷öõ,Î,,
÷÷öô,Ò,,
÷÷ô,Ê,,
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Route_b2

This section includes an annotated call flow for the sample application Route_b2. 
The Route_b2 sample application demonstrates simple call routing (or call 
direction) using “blind transfer” to transfer an incoming call to another line. The 
script answers the telephone, plays a greeting message to the caller, then plays 
a menu offering to route the call to certain departments or people. In this 
application, the menu is not fixed and built into the script. It demonstrates the 
dynamic menu feature of the Graphical Designer by using a table query node to 
get active records from a table (ROUTETAB) of possible transfer extensions. 
Each table entry contains a name, primary extension, secondary extension, and 
a flag to indicate if the name is active or available for a transfer. After the query, 
an AutoMenu node builds a menu from the active record information, plays the 
menu and gets a touchtone from the caller. Upon receiving a touchtone, the 
script uses the corresponding information from the table in a Call Transfer node 
to play a confirmation (for example, “Please hold for sales”) and transfers the call 
to the primary extension. It uses “blind transfer,” meaning it signals the switch to 
begin the transfer, dials the extension, completes the transfer, and drops the line. 
The transfer may succeed or fail, but either way the script is off the call.

■ Call flow branches without an attached node are “terminal nodes.” If the 
call flow reaches the terminal node, the voice response unit hangs up the 
telephone and stops the application.

■ The application uses text-to-speech (TTS) to say the messages; therefore, 
no speech is recorded for any of the prompts in the application.

[Main]

,,—,AnswerPhone
ô,Î,ò,PlayGreeting
÷ô,Î,ÿ,GetActiveTransferList
÷÷õ,Ñ,,
÷÷õ,Í,ý,>PlayAutomenuList
÷÷õ,Ì,ý,PlayAutomenuList
÷÷öõ,Î,¯,TransferToSelection
÷÷ööõ,Î,,
÷÷ööô,Ò,,
÷÷öô,Ò,,
÷÷ô,Ò,,
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Route_i1

This section includes an annotated call flow for the sample application 
Route_i1. The Route_i1 sample application demonstrates call routing (or call 
direction) using “intelligent transfer.” The script answers the telephone, plays a 
greeting, then plays a menu offering to route the call to sales, service or 
accounting. Upon receiving a touchtone response of “1,” “2,” or “3,” the script 
takes the corresponding branch and uses a Call Transfer node to play a 
confirmation (for example, “Please hold for sales”) and transfers the call to the 
appropriate extension, which is specified in the Call Transfer node. It uses 
“intelligent transfer,” meaning it stays on the line while the switch tries to transfer 
the call and waits to hear if the transfer succeeds (in other words, the destination 
number answers) or fails (due to no answer, busy line, no lines available, or an 
other problem). If the transfer succeeds, the script completes the transfer and 
drops the line. If the transfer fails, the script tries again with a different number, 
again using intelligent transfer. If the second attempt fails, it plays a message to 
the caller suggesting that he or she call again later.

Compare this sample application to “ROUTE_B1,” which uses the same menu 
with blind transfer instead of intelligent transfer. Also, compare it to “ROUTE_I2,” 
which uses intelligent transfer, but with a dynamic menu of routing choices.

■ Call flow branches without an attached node are “terminal nodes.” If the 
call flow reaches the terminal node, the voice response unit hangs up the 
telephone and stops the application.

■ The application uses text-to-speech (TTS) to say the messages; therefore, 
no speech is recorded for any of the prompts in the application.

 [Main]

,,—,AnswerPhone
ô,Î,ò,PlayGreeting
÷ô,Î,ï,PlayMenu
÷÷õ,Ú,¯,XferToSales
÷÷öõ,Î,,
÷÷öô,Ò,¯,SecondarySales
÷÷ö÷õ,Î,,
÷÷ö÷ô,Ò,ò,TellTryAgainLater
÷÷ö÷÷ô,Î,,
÷÷õ,Û,¯,XferToService
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÷÷öõ,Î,,
÷÷öô,Ò,ò,>TellTryAgainLater
÷÷õ,Ü,¯,XferToAccounting
÷÷öõ,Î,,
÷÷öô,Ò,ò,>TellTryAgainLater÷÷
ô,Ê,,
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Route_i2

This section includes an annotated call flow for the sample application Route_i2. 
The Route_i2 sample application demonstrates call routing (or call direction) 
using “intelligent transfer.” The script answers the telephone, plays a greeting, 
then plays a menu offering to route the call to certain departments or people. In 
this application, the routing menu is not fixed and built into the script. Rather, it is 
dynamic—obtained by using a Table Query node followed by an Automenu 
node. The Table Query gets all “active” records from a table (ROUTETAB) of 
possible transfer extensions. Each table entry contains a name, primary 
extension, secondary extension, and a flag to indicate if the name is “active” (in 
other words, available for a transfer). After the query, an Auto Menu node builds a 
menu from the active records, plays the menu, and gets a touchtone from the 
caller. Upon receiving a touchtone, the script uses the corresponding information 
from the table in a Call Transfer node to play a confirmation (for example, “Please 
hold for sales”) and transfers the call to the primary extension. It uses “intelligent 
transfer,” meaning it stays on the line while the switch tries to transfer the call and 
waits to hear if the transfer succeeds (in other words, the destination number 
answers) or fails (due to no answer, busy line, no lines available or other 
problem). If the transfer succeeds, the script completes the transfer and drops 
the line. If the transfer fails, the script tries a second time, using the secondary 
extension, and again using intelligent transfer. If the second attempt fails, it plays 
a message to the caller suggesting that he or she call again later.

Compare this sample application to “ROUTE_B2,” which also uses intelligent 
transfer, but with a fixed routing menu. Also compare it to “ROUTE_I1,” which 
uses the same dynamic menu, with blind transfer.

■ Call flow branches without an attached node are “terminal nodes.” If the 
call flow reaches the terminal node, the voice response unit hangs up the 
telephone and stops the application.

■ The application uses text-to-speech (TTS) to say the messages; therefore, 
no speech is recorded for any of the prompts in the application.

[Main]

,,—,AnswerPhone
ô,Î,ò,PlayGreeting
÷ô,Î,ÿ,GetActiveTransferList
÷÷õ,Ñ,,
÷÷õ,Í,ý,>PlayAutomenuList
÷÷õ,Ì,ý,PlayAutomenuList
÷÷öõ,Î,¯,TransferToSelection
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÷÷ööõ,Î,,
÷÷ööô,Ò,¯,TryTransferAgain
÷÷öö÷õ,Î,,
÷÷öö÷ô,Ò,,
÷÷öô,Ò,,
÷÷ô,Ò,,
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Welcome1

This section includes an annotated copy of the call flow for the sample 
application “Welcome1.”

The Welcome1 sample application demonstrates the use of seasonal greetings, 
a table of holidays, and business hours. The application is designed for a 
business that is open Monday through Friday, 8 a.m. to 5 p.m., and Saturday, 
9 a.m. to 2 p.m., except for certain holidays. It is closed during all other hours, on 
Sundays, and on the holidays, whose dates are contained in a table named 
HOLIDAYZ.

The application answers the telephone, plays a general greeting message, then 
executes a subroutine (“HandleOpening”) to check for seasonal greetings, 
holidays, and business hours. That subroutine, in turn, contains three other 
subroutines, one for each check. Ultimately, it returns to the main call flow at one 
branch (Closed) if the business is closed, or another branch (Default) if open.

Upon return at the (Closed) branch, the application plays a closing message. In 
a normal application, this would be the end, and the application would quit. 
However, the sample application continues by going to the “Main Service Menu,” 
described below.

Upon return at the (Default) branch, meaning the business is open, a normal 
application would play some kind of service menu. Here, the “Main Service 
Menu” lets the caller choose to run through the application again, hear a detailed 
description of the application, or end the call.

■ Call flow branches without an attached node are “terminal nodes.” If the 
call flow reaches the terminal node, the voice response unit hangs up the 
telephone and stops the application.

■ The application uses text-to-speech (TTS) to say the messages; therefore, 
no speech is recorded for any of the prompts in the application.

[Main]

,,—,AnswerPhone
ô,Î,ò,PlayGeneralGreeting
÷ô,Î,ð,[HandleOpening](1)
÷÷õ,(Closed),ò,PlayGoodbye
÷÷öô,Î,ï,>PlayMainServiceMenu
÷÷ô,(Default),ï,PlayMainServiceMenu
÷÷÷õ,Ú,ò,>PlayGeneralGreeting



Welcome1

Issue  2.0   August 1997 D-17

÷÷÷õ,Û,ò,PlayApplDescription
÷÷÷öô,Î,ï,>PlayMainServiceMenu
÷÷÷õ,á,ò,PlayFarewell
÷÷÷öô,Î,,
÷÷÷ô,Ê,,

CheckBusinessHours Subroutine

The “CheckBusinessHours” subroutine uses Time Branch nodes to compare the 
current day and time to preset hours of operation for each day of the week. For 
Monday through Friday, it uses the hours 8 a.m. to 5 p.m. 

[CheckBusinessHours]

,,ú,CheckDay
õ,Mon-Fri,ú,CheckHours_MonFri
öõ,08:00-17:00,,
öô,(Other),ó,>(OutOfHours)
õ,Sat-Sat,ú,CheckHours_Saturday
öõ,09:00-14:00,,
öô,(Other),ó,>(OutOfHours)
ô,(Other),ó,(OutOfHours)
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CheckHolidaysTable Subroutine

The “CheckHolidaysTable” subroutine uses a table query object to see if today's 
date matches any date in the table HOLIDAYZ. If the date matches, and the 
“Holiday_Status” field of the record is “Y”, the current date is considered a 
holiday and the subroutine returns at the (GotAHoliday) exit branch. Otherwise, it 
returns at the (Default) exit branch, indicating that this is not a holiday.

 [CheckHolidaysTable]

,,ÿ,CheckTodayInHolidaysTable
õ,Ñ,,
õ,Í,ó,(GotAHoliday)
õ,Ì,,
ô,Ò,,
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HandleOpening Subroutine

The “HandleOpening” subroutine contains three separate subroutines, one for 
each of the checks described for the application. It first uses the 
“DoSeasonalGreetings” subroutine to play the appropriate seasonal greeting.     
Next, it uses the “CheckHolidaysTable” subroutine to see if today's date is in the 
table and is marked as an observed holiday. If so, it plays a message saying the 
business is closed for the holiday, followed by a message to call back during 
regular business hours. It then returns to the main callflow at the (Closed) exit.     
Finally, if not a holiday, the “CheckBusinessHours” subroutine is used to 
determine if the current time is within the business hours for the current day. If 
not, the script plays an “Out of Hours” message, then plays the “call back” 
message, and returns at the (Closed) exit. If the call arrived during regular 
business hours, the subroutine returns to the main callflow at the (Default) exit.

[HandleOpening]

,,ð,[DoSeasonalGreetings](1)
ô,(Default),ð,[CheckHolidaysTable](1)
÷õ,(GotAHoliday),ò,PlayHolidayMessage
÷öô,Î,ò,PlayCallBackMessage
÷ö÷ô,Î,ó,(Closed)
÷ô,(Default),ð,[CheckBusinessHours](1)
÷÷õ,(OutOfHours),ò,PlayOutOfHoursMessa
ge
÷÷öô,Î,ò,>PlayCallBackMessage
÷÷ô,(Default),,
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DoSeasonalGreeting Subroutine

The “DoSeasonalGreetings” subroutine uses a Time Branch node to determine if 
the current date is within a season; if so, it plays an appropriate seasonal 
greeting. Each branch sets the start date and end date of a “season.” For 
demonstration purposes, the branches are set up so every day of the year falls 
into some season.

 [DoSeasonalGreetings]

,,ú,CheckSeasonalDates
õ,Jan_01-Mar_20,ò,WinterGreeting
öô,Î,,
õ,Mar_21-Jun_20,ò,SpringGreeting
öô,Î,,
õ,Jul_02-Jul_06,ò,4thOfJulyGreeting
öô,Î,,
õ,Jun_21-Sep_20,ò,SummerGreeting
öô,Î,,
õ,Sep_21-Dec_20,ò,AutumnGreeting
öô,Î,,
õ,Dec_21-Dec_30,ò,ChristmasGreeting
öô,Î,,
ô,(Other)
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E
Troubleshooting

Overview

This appendix includes a list of troubleshooting items for the Graphical Designer 
(Table E-1).

Purpose

This appendix provides reference material to help troubleshoot problems with the 
Graphical Designer.
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Table E-1. Troubleshooting Items for the Graphical Designer 

Symptom Possible Solution

Icons are distorted or missing. This is caused by large fonts loaded for the video 
driver. Reload the video driver using small fonts.

Memory allocation error during 
installation of the software.

This could be caused by a corrupted file on the 
floppy. Try reloading the package. If this does not 
work, you must obtain a new set of floppies.

This network book cannot be 
opened. Either another user is using 
it, or you do not have proper 
privileges for network location. Try 
making the book read-only.

These types of messages are usually caused by 
lack of memory below the 1-MByte limit. Close 
other applications and try again.

Cannot record or play speech. Confirm the card is working properly by using the 
sound card software. If recording, check that the 
microphone is turned on both in the sound card 
software and on the microphone. If the sound 
card is working properly the problem could be 
with memory. Close other applications and try 
again.

General Protection Faults (GPF) Approximately 90% of the GPFs that you cannot 
reliably reproduce are related to video drivers. 
GPFs appear to be centered around the act of 
going to new pages, which causes screens to be 
drawn in memory prior to being displayed. 
Recommendations for preventing GPFs are:

■ Change back to the standard VGA driver 
supplied with Windows (this means 640x480 
and 16 colors).

■ Get the latest version of video driver from the 
different vendors.

■ If using a MACH64 video board, add this line 
in your SYSTEM.INI:

after [Macx]
DeviceBitmap=off

Continued on next page
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When starting the Graphical 
Designer, the user receives a 
message similar to the following:

The path <PathName> 
\HOME.TBK is invalid.

Check the files association for files with 
extensions of TBK. This should be set to

\<Windows Directory>\ASYM\RUNTIME\ 
TB30RUN.EXE

After installation of the application, 
you cannot run the Graphical 
Designer by clicking the program 
icon.

MS DOS 6.0 provides the anti-virus program 
VSAFE. VSAFE has various levels of protection 
that can be enabled. One of the VSAFE protection 
levels prevents any newly copied EXE from 
running until the anti-virus checker has been run 
over the EXE to validate it. Based on the type of 
options you are using with VSAFE, you may have 
to run the virus checker over the newly installed 
application before you can run the application.

Table E-1. Troubleshooting Items for the Graphical Designer  — Continued  

Symptom Possible Solution

Continued on next page
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GLGlossary

.wav file
A speech file that is created for each recorded phrase.

A

ANI
Automatic Number Identification. A method of identifying the caller by automatically receiving a 
string of digits that identifies the calling station of a particular customer.

application
The computer program that defines and controls the voice response transaction between the VIS 
(Voice Interactive System) and the caller.

argument
Component used to create expressions.

ASR
Automatic Speech Recognition.

B

blind transfer
The call is completed as soon as the extension is dialed. The service does not wait to make sure 
the call is answered.

branch
A defined event extending from a node.

bucket
A variable containing a typed value. Buckets are global data items and can be referenced any-
where in the application.

C

call flow
A tree made up of nodes and branches that defines the course of an application.

channel
Associated with an interface to the telephone network (TIPL Ring, TI or PRI).

concatenation
Process of joining two strings together.
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D

data input field
A field in which values may be entered.

database table
A collection of records that have been group together logically.

design pad
Area of the Design Pad screen in which you can create a call flow by dragging and dropping 
objects from the Object Palette. 

DIP
Data Interface Processor. Performs operations not easily executed using standard instructions, 
such as extensive calculations or interfacing to an asynchronous host.

DNIS
Dial Number Identification Service. A service that allows an incoming call to contain information 
about the phone number for which it is destined.

E

encapsulation
Method of creating units of code that can be reused throughout the application.

event record
Specifies the list of variables to be appended to a call data record at the end of each call.

expression
A statement composed of one or more operands that can be manipulated using various functions 
and stored in a specific destination.

external function
Specific tasks or interfaces that allow an application to involve processes and interact with other 
products or services.

F

field mapping
Process of assigning a variable to each field that is sent to or received from a host.

formatted response
Process of taking the data collected from the caller and converting it to a class other than Class 
Character.
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G

global variable
A variable that appears the same at all levels of an application. When a global variable is 
changed, all references to it are updated.

grammar
The set of rules through which an entire spoken word is recognized. For example, using the 
US-1-3 grammar, the words “one,” “two,” and “three,” in U.S. English, are recognized as valid 
input.

H

host
A computer linked to a network providing a range of services such as database access and com-
putation.

Host definition file
A file created from the information defined for a host on the Host Definition Editor screen.

I

inbound call termination
The event in which a caller hangs up before he/she has successfully completed the call. 

interface
Software that provides access to a system.

IVR
Interactive Voice Response.

J

jump
Causes the execution of the call flow to shift from the current branch and move to a specified 
node located elsewhere in the design.   

L

local log
A batch file containing alarms generated by CVIS. This log is used to track and correct potential 
problems.
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Logical Unit
A type of SNA (System Network Address) unit.

login
Sequence executed when the host flow session is initiated or when the recovery sequence ends 
at the Login Base screen.

logoff
Sequence executed when the host flow session is terminated.

M

military time
Time represented in 24 hour format. For example, 2:15 p.m. is represented as 14:15 in military 
time.

N

NPANXX
The area code (NPA) and exchange (NXX) portion of a phone number.

O

object
A unit that is used to build call flows in INTUITY CONVERSANT Graphical Designer.

Object Palette
Contains the set of units used to build call flows in INTUITY CONVERSANT Graphical Designer.

orphan node
A node that is disconnected from the call flow.

P

pass branch
This branch is executed when the object criteria for a particular node have successfully been 
met. Pass branches are labeled with an arrow. Also called the “Success” branch. 

password
Used in conjunction with a login to define a Logical Unit.

phrase
A unit of speech that is used to build prompts.

phrase break
A mark used to indicate the end of one phrase and the beginning of another.
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Phrase list file
A file containing all of the phrases contained in an application.

phrase number
A number that uniquely identifies a phrase within an application.

phrase table
A collection of phrases that are grouped together logically.

PRI
Primary Rate Interface. An optional feature package that provides a digital interface capable of 
both receiving and originating telephone calls directly to/from an INTUITY CONVERSANT 4ESS 
switch.

production environment
State in which the application is running.

prompt
A unit of speech made up of one or more phrases.

Q

query
Find information within a database table to be used for further processing.

R

recovery
Sequence initiated when a transaction ends, a login sequence ends, or a recovery sequence 
ends and the current screen is not the Transaction Base screen.

rotary phone
A telephone that uses pulse tones instead of touchtones.

S

set
A range or list of values separated by commas against which caller input can be validated.

simulation
State in which the application can be tested. Also known as run time.

sound file
A file created when you record a phrase in INTUITY CONVERSANT Graphical Designer. Recorded 
phrases have a .wav extension.

speech file
A file containing an encodes speech phrase.
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standard speech
A speech package containing simple words and phrases. This package includes digits, numbers, 
days of the week, and months.

string
A contiguous sequence of characters treated as a unit.

sub-palette
A grouping of secondary objects that can be accessed by clicking on certain primary objects in 
the main object palette.

subroutine
Unit of code that can be reused within an application. Also known as an encapsulated node or 
subtree.

system bucket
A predefined global variable provided in INTUITY CONVERSANT Graphical Designer.

system function
A predefined external function provided in INTUITY CONVERSANT Graphical Designer.

T

tag
A phrase appended to a voice recording to describe the transaction.

talkfile
An ASCII file that contains the speech phrase tags and phrase tag numbers for all the phrases in 
an application.

telephony
Transmission of sound between stations using the telephone.

terminate touchtone
A touchtone to be pressed by the caller when he/she has finished entering data in a Prompt and 
Collect node.

tested indicator
A check mark that appears next to each node executed during simulation.

Text-To-Speech
A VIS software package that converts printed text into spoken, computer generated prompts and 
announcements.

touchtone
The signal sent when a caller presses any of the twelve keys on a push-button telephone, which 
sends DTMF (Dual Tone Multi Frequency) tones rather than rotary pulses.

TPL
Transaction Phrase List.
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U

unreferenced bucket
A global variable that was created in INTUITY CONVERSANT Graphical Designer but is not used 
within the application.

unreferenced table 
A database table that was created in INTUITY CONVERSANT Graphical Designer but is not used 
within the application.

user function
A custom external function defined by the user.

W

Wordlist
A custom grammar for ASR (Automatic Speech Recognition) that is created using the FlexWord 
Editor screen and mounted on the platform.
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INIndex

A

Annotating within the online help, xxxii
Announcement

creating, 3-31
application

transferring from Graphical Designer, 6-3
ASAI, B-1

B

Bucket value
including in an announcement, 3-32

C

Call flow
editing a node, 3-31

Call flow samples
Holiday1 application, D-2
Holiday2 application, D-4
Hours2 application, D-6

Course available, xxxii

E

Editing a node, 3-31

F

FlexWord speech recognition, 6-12

G

Graphical Designer, 6-8

H

hard disk drives
requirements for Graphical Designer, 1-3

hardware requirements
for Graphical Designer, 1-3

Help
Annotate option, xxxii

I

Include a bucketing value in an announcement, 3-32
installation

Application Design package, 2-2
INTUITY CONVERSANT VIS versions supported, xxxii

M

microphone requirements, 1-4

N

network
method for transferring an application, 6-5
transfers, optional equipment needed, 1-4

R

recording speech
optional equipment needed, 1-3

requirements
for Graphical Designer

microphone, 1-4
monitor, 1-3
mouse, 1-3
RAM, 1-3
software, 1-4
sound card, 1-3

S

software
requirements

for Graphical Designer, 1-4
sound card requirements, 1-3
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